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READ ME FIRST 

Welcome to Take Control of .Mac, version 1.3. 

Membership in .Mac gives you access to a suite of online services 

that both complements and integrates tightly with Mac OS X 
and iLife. Although .Mac was designed for ease of use, it also has 

tremendous power—and a few hidden pitfalls. Learn how to make 

the most of your .Mac membership by reading this book, which 

goes far beyond Apple’s online help to give you detailed instructions, 

tips, and strategies. 

This book was written by Joe Kissell, edited by Dan Frakes, and 

published by TidBITS Publishing Inc. 

Copyright © 2007 Joe Kissell. All rights reserved. 

The price of this ebook is $15. If you want to share it with a friend, 

please do so as you would a physical book. Click here to give your 

friend a discount coupon. Discounted classroom copies are also 

available. 

You may not have the latest version of this PDF. To find out if there’s 

a new version, click the Check for Updates link on the cover. Once you 

click the link, you’ll be taken to a Web page where you can learn about 

any available or planned updates and sign up to be notified about 
updates to the PDF via email. You may also find minor update 

information directly on that Web page. 

Basics 
In reading this book, you may get stuck if you don’t know certain 

basic facts about .Mac or Mac OS X, or if you don’t understand Take 
Control syntax for things like working with menus or finding items 

in the Finder. Please note the following: 

• Path syntax: I occasionally use a path to show the location of a 

file or folder in your file system. Path text is formatted in bold type. 
For example, Mac OS X stores most utilities, such as Terminal, in 

the Utilities folder. The path to Terminal is: /Applications/ 
Utilities/Terminal. 

 

http://emperor.tidbits.com/webx?checkReferral@@.3c4415d4/!bt=0030
http://www.takecontrolbooks.com/class-copies.html
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The slash at the start of the path tells you to start from the root 

level of the disk. You will also encounter paths that begin with 

 ~ (tilde), which is a shortcut for any user’s home directory. For 

example, if a person with the user name joe wants to install 
fonts that only he can access, he would install them in his 

~/Library/Fonts folder, which is just another way of writing 

/Users/joe/Library/Fonts. 

• Finding preference panes: I sometimes refer to system-wide 
Mac OS X preferences that you may want to adjust. To change 

these settings, open System Preferences by clicking its icon in 

the Dock or choosing System Preferences from the Apple menu. 

Settings are categorized in topic-specific preference panes. You 

access a particular preference pane by way of its icon or the View 

menu. For example, to see “the .Mac preference pane,” you would 
launch System Preferences and then click the .Mac icon or choose 

View > .Mac.  

• Menus: When I describe choosing a command from a menu in 

the menu bar, I use an abbreviated description. For example, the 
abbreviated description for the menu command that creates a new 

folder in the Finder is “File > New Folder.” 

What’s New in Version 1.3 

Version 1.3 of Take Control of .Mac contains numerous changes 

from the previous version, 1.2, mostly to cover the new features in 
.Mac that Apple announced in early August 2007. Among the most 

important changes in this version are the following: 

• New graphics to reflect the current appearance of the .Mac Web 

site and to improve overall image quality. 

• Information on using your own domain name with .Mac. See 

Manage Your Account (p. 16) and the sidebar Master of Your 

Domain (p. 142). 

• Instructions for the new Junk Mail filter in .Mac Mail. See Work 

with incoming messages (p. 25) and General Preferences (p. 28). 

• New details on iDisk storage capacity and data transfer limits. See 
Store and Share Files with iDisk (p. 81). 
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• Removed information specific to iLife ’05. 

• Suggestions for alternative providers of online backup services. See 
Online Backups (p. 186). 

  
iLife ’08 ABOUT THESE SPECIAL NOTES 

In August 2007, Apple released iLife ’08, which includes many 

new features relating to .Mac. A future version of this book will 

update all mentions of iLife applications to reflect what’s true in 

iLife ’08. However, since only a fraction of .Mac subscribers will 

have upgraded to iLife ’08 by the time this book ships, I have 

not included full coverage of those new features here. Instead, 

I’ve inserted blue notes like this one wherever the behavior of 

iLife ’08 differs significantly from that of iLife ’06 and earlier, 

described in the main text. 

  

What Was New in Version 1.2 

Version 1.2 of Take Control of .Mac was updated to cover the changes 

Apple made beginning in October 2006 to .Mac Mail and the online 

Address Book interface. It contained the following changes from the 

1.1 release: 

• A completely rewritten section on webmail, including new screen 

shots. See Access .Mac Mail over the Web (p. 22). 

• An updated discussion of using .Mac email aliases. See Use Email 
Aliases (p. 41). 

• A revised Address Book section (p. 68). 

• New information about a newer, easier way for others to access 

files in your iDisk’s Public folder. See Make public files available 

on the Web (p. 88). 

• In the section Publish a blog on .Mac, updated information about 
features added in iWeb version 1.1 (p. 143) and the shipping 

version of Sandvox (p. 145). 
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INTRODUCTION 

On January 6, 2000—more than a year before the first official 

release of Mac OS X—Apple announced a suite of Internet services 

called iTools. At that moment, as Steve Jobs delivered his Macworld 

Expo keynote address at Moscone Center in San Francisco, I was in 

the building’s basement, manning a booth for a company that was 
exhibiting at the expo and watching the presentation via QuickTime 

streaming video. I was excited to learn about iDisk, HomePage, 

Mac.com Mail, and all the other aspects of iTools. I was delighted that 

they were Mac-only, and even more thrilled that they were free! 

Steve said that as soon as his speech was done, the world’s Mac users 

could immediately go to the Apple Web site and choose their iTools 

member names—which were also permanent email addresses in the 

Mac.com domain. I did just that. I had hoped to snag joe@mac.com, 

but it was already taken (perhaps by an Apple employee). However, 

I managed to get another three-character member name—my initials, 
jwk@mac.com. Like every other red-blooded Mac geek, I’ve since 

treasured my little corner of the Mac.com world. 

Over time, Apple has made some dramatic changes to iTools. For 

starters, they renamed the service .Mac, a trendy yet often frustrating 
moniker—just try using “.Mac” as the beginning of a file or folder 

name in Mac OS X (or, worse, creating a text clipping of text that 

begins with “.Mac”—the clipping disappears). They’ve added numer-

ous capabilities and expanded storage space, while removing a few 

features that few people used. (Do you remember KidSafe? iReview? 

I didn’t think so.) They’ve also made the service available to Windows 
users (shocking!)…and eventually, of course, they began charging 

for it, too. (For a while it was only $50 per year; now it’s $100.) 

More recently, with the introduction of Tiger, iLife ’06, and iLife ’08, 

Apple has extended the tentacles of .Mac into many more parts of the 
operating system and its applications, giving users and developers 

new and useful ways to exploit the service. The arrival of Mac OS X 

10.5 Leopard will extend .Mac’s reach even further. 

This is all good, but strangely enough, I still frequently find Mac 
users who don’t know why they might want a .Mac membership. On 

many occasions, friends and relatives have asked me if they should 

purchase a .Mac subscription with their new Mac, pay for an upgrade 
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from the trial version, or renew an existing subscription. “Yes,” I say, 

“you definitely should.” Then, invariably, they reply, “But it’s $100 a 

year! Do I really need that? What do I actually get for that money?” 

Maybe Apple hasn’t tried hard enough to explain the benefits of .Mac. 

Maybe they’ve integrated its features so thoroughly into Mac OS X 

that they effectively become invisible. Maybe certain users (not to 

implicate my wife or my mother in particular) haven’t noticed that 

features they use every day are part of .Mac. Or could it be—as some 
critics claim—that a .Mac subscription isn’t worth that much after all? 

I’d be the first person to tell you that .Mac is not perfect, and that 

in some cases you can get more features for less money from other 

sources. For me, the convenience and value I get from .Mac far exceeds 
my annual $100 membership fee. And given the recent changes to 

.Mac—plus the new .Mac-related capabilities in iLife ’08—I think I can 

safely say that the case for the benefits of .Mac is stronger than ever. 

But I’d like to humbly submit that perhaps the biggest problem 
with .Mac—the biggest reason more Mac users don’t automatically 

sign up each year—is its instruction manual. Which is to say, its lack 

of an instruction manual. Oh, sure, you can download a basic little 

“Getting Started” PDF guide, and Apple provides reasonably accurate 

online help on the .Mac Web site and in the Mac OS X Help program. 

But where are the real details? The unbiased strategies, tips, and 
warnings? The direct, task-oriented instructions that don’t require 

endlessly clicking links and squinting at a tiny window? These are 

the very things I’ve included in the book you’re now reading. 

My goal in writing this book is to help you take control of every 
aspect of your .Mac membership—to get as much value out of it 

as you possibly can. And as Apple continues to modify the .Mac 

services—which they surely will—I’ll update this book, as well, so 

that you always have the latest information. 

  
NOTE .MAC OR MAC.COM? 

Because the .Mac Web site is located at http://www.mac.com/, the 

terms “.Mac” and “Mac.com” are to some extent interchangeable. 

In general, though, I use “Mac.com” when referring to the domain 

name itself, and “.Mac” elsewhere. 

   

http://www.mac.com/
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SIDEBAR .MAC AND MAC OS X VERSIONS 

This book mainly covers the use of .Mac with Mac OS X 10.4 Tiger 

(with occasional references to Windows and earlier versions of Mac 

OS X). If you’re running Panther (Mac OS X 10.3), you will find 
that some .Mac features are unavailable and that others require 

different procedures from what I describe here. 

Specifically, Panther users should be aware of the following major 

differences: 

• The Panther version of Mail does not automatically recognize 

.Mac email aliases. In addition, the procedure for adding new 

.Mac or POP accounts is somewhat different in the Panther 

version; choose Mail > Help for assistance. (See Access .Mac 
Email Using Apple Mail.) 

• In Panther, you must use the separate iSync application (in 

/Applications) to synchronize data on your Mac with .Mac’s 

servers; the .Mac pane of System Preferences has no Sync tab 
under Panther. Again, consult the Help menu for instructions. 

(See Keep Your Information in Sync.) 

• iSync under Panther cannot sync Keychains; Mail accounts; and 

Mail rules, signatures, and smart mailboxes. In addition, third-
party software that includes .Mac sync capabilities generally 

requires Tiger. (See Keep Your Information in Sync.) 

• Backup 3 requires Mac OS X 10.3.9 or 10.4.2 or later. If you are 

running a version of 10.3 prior to 10.3.9, you can use Backup 2, 
but it lacks most of the important features of Backup 3. (See Back 

Up Your Files.) 

If you’re running a version of Mac OS X older than Panther, a great 

deal of this book does not apply; I strongly recommend upgrading if 
you can. 
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.MAC QUICK START 

Use this section to get a quick overview of the process to follow in 

order to Take Control of .Mac. You can read the entire book in the 

order presented here, or click a blue link to immediately jump to 

any particular topic. If you are completely new to .Mac, however, 

I strongly recommend reading Get to Know .Mac first. 

Get your bearings: 

• Learn about the features of .Mac. See Get to Know .Mac, especially 

the What Is .Mac? and Major.Mac Features sections. 

• Set up your Mac to work with .Mac. Read Set Up .Mac System 

Preferences. 

• Discover how to access your information via the Web in Learn to 

Navigate the .Mac Web Site. 

Send and receive email: 

• Use your Mac.com email address on the Web or with a desktop 

email application. Find out how in Access .Mac Mail over the Web 
and Access .Mac Email Using Apple Mail. 

• Expand your email capabilities with aliases or email-only accounts. 

See Use Email Aliases and Add Email-Only Accounts. 

Put your data online: 

• Use .Mac to copy important data to the .Mac servers—for viewing 
on the Web or for syncing with another computer. Read Keep Your 

Information in Sync. 

• Access your data from any Web browser. See Address Book, .Mac 

Bookmarks, and iCal Calendars. 

• Back Up Your Files—to an iDisk or another destination.  

Share your files, photos, and other information online: 

• Use iDisk to make important files available online. See Store and 

Share Files with iDisk. 

• Share your stuff on the Web—with or without iLife. Read Create 

and Publish a Web Site. 
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• Create a private Web site for sharing messages, schedules, files, 

and other information with a group of people. See Collaborate 

Using .Mac Groups. 

Manage and extend your .Mac membership: 

• Save Money on Your .Mac Membership, by purchasing it for less 
than retail price. 

• Learn how to extend—or even replace—.Mac with other services. 

See Appendix A: Beyond .Mac. 

• .Mac accounts come in a variety of flavors, from the standard 

account to Family Pack primary and sub-accounts, email-only 

accounts, trial accounts, and even expired accounts, which still 

provide a usable .Mac ID for iChat and other services. Understand 

the options for converting your .Mac account from one type to 
another, if the need ever arises. See Appendix B: Account 

Conversion Methods. 
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GET TO KNOW .MAC 

At the risk of preaching to the converted, I thought it would be worth-

while to review exactly what .Mac is and what your .Mac membership 

includes. After a quick overview, I show you how to configure a few 

essential .Mac preferences, find your way around the .Mac Web site, 

and convert your account from one type to another, if necessary. 

What Is .Mac? 
Although you can go to an Apple Store and walk out with a box 

labeled “.Mac,” it isn’t truly a product in the sense of being hardware 

you hook up to your computer or software you install on it. In fact, 

the main thing in the box is an activation code that you enter via 
a Web page to turn on your .Mac features; you can just as easily pur-

chase your membership online and save a tree branch or two. Rather, 

.Mac is a collection of online services—some of which you can use on 

their own, and some of which add capabilities to Mac OS X or to 

applications such as iPhoto, Mail, and Address Book. 

You can use Mac OS X without a .Mac membership, but several useful 

features will be unavailable to you. As more third-party applications 

add .Mac-specific features, the value of a .Mac membership increases. 

Major .Mac Features 
Although Apple is constantly tweaking the capabilities of .Mac, here 

are the major features as of September 2007: 

• .Mac Mail: Your .Mac membership includes an email address 

in the Mac.com domain (member-name@mac.com); you can 
check and send email via the .Mac Web site or use a program such 

as Apple Mail. You can also use your Mac.com address for instant 

messaging with iChat or AOL Instant Messenger (AIM). For 

details, see Access .Mac Email Using Apple Mail. 

• iDisk: Using this online storage space, you can access selected 

files from nearly any computer (Mac, Linux, or Windows) with 

an Internet connection. You can also publish Web sites and share 

files with other people. Learn more in Store and Share Files with 

iDisk. 
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• HomePage: Anyone can create professional-looking Web sites 

quickly with this easy-to-use, template-based feature on the 

Mac.com Web site. Your Web site can include photos, movies, 

or other files from your iDisk. I cover this in Create a Site Using 
HomePage. 

• Synchronization: If you have more than one Mac, you can keep 

key information—your contacts, calendar, bookmarks, keychains, 

and more—on all of them in sync automatically (read Keep Your 
Information in Sync). Some third-party applications can also 

synchronize their data between Macs using your .Mac account. 

• Online Data Access: The information you’ve synchronized from 

several desktop applications—including Address Book, iCal, and 
Safari—is also available via the Web from any computer on the 

Internet. See Work with Contacts, Calendars, and Bookmarks. 

• Groups: A new feature added in September 2005, .Mac Groups, 

gives you a private Web site where members you invite can 
exchange messages, share files, view a group calendar, and more. 

Find out more in Collaborate Using .Mac Groups. 

• Backup: .Mac members can download an application called 

Backup that copies selected files or folders to an iDisk, a hard 
drive, or even a CD or DVD. See Back Up Your Files for steps 

and info. 

• iLife Integration: Although .Mac and iLife have always had 

a friendly relationship, iLife ’06 (and later) provides a much richer 
integration between all its applications and your .Mac account. 

Of particular interest, iWeb gives you the means to quickly publish 

high-quality Web sites and blogs that feature media from iPhoto, 

iMovie, GarageBand, and iTunes. 

Needless to say, a .Mac subscription is not the only way to obtain 

most of these features. (See Appendix A: Beyond .Mac for more 

details.) So why .Mac? For one thing, ease of use. Everything about 

.Mac—especially the way its features tie in so tightly with your Mac 

OS X software—makes it accessible to anyone (even technophobes). 

And then there’s convenience: The combination of all these useful 
features in one package, available with a single sign-up and payment,  
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is worth a great deal. Finally, .Mac subscriptions include an assort-

ment of other benefits (see the sidebar “Other .Mac Benefits,” just 

ahead) that Apple considers “icing on the cake,” but whose combined 

value may exceed the cost of your subscription.  

  
SIDEBAR OTHER .MAC BENEFITS 

Beyond the big, flashy features, such as iDisk and Mac.com email, 

your .Mac subscription includes a number of less visible—but no 

less valuable—extras. Some examples: 

• The .Mac Learning Center: This portion of the .Mac 

Web site includes heavily illustrated, step-by-step tutorials, 

videos, and PDF documents that walk you through the features 

of .Mac, Mac OS X, iPod, the iLife and iWork applications, and 
Apple’s Pro applications (such as Final Cut Pro and Logic Pro). 

• Expert Tips: Mac experts, including our own Tonya Engst, 

periodically provide tips on getting more out of Mac OS X. 

• Free and discounted software: In the past, Apple has 

sometimes offered .Mac members free or discounted software, 

though they haven’t provided any third-party products in some 

time. As of mid-2007, the only free offering was a large selection 

of GarageBand loops. 

• iCards: Send anyone a virtual electronic postcard for a holiday 

or special occasion, a thank-you note, a party invitation, or just 

to say hello. Although you needn’t be a .Mac member to send 

an iCard, members have additional capabilities—you can supply 
your own photo from the Pictures folder of your iDisk and use 

addresses from your Address Book. Because iCards are simple 

and self-explanatory, I do not cover them. 

• Support: Apple has a special support Web site devoted to .Mac 
members, at http://www.apple.com/support/dotmac/. This site 

includes how-to articles; a discussion board where members can 

post questions and help each other with problems; a download-

able Getting Started PDF guide (no match for this book, of 

course!); extended details on the .Mac system status; and forms 

to contact Apple directly for assistance or to provide feedback. 

   

http://www.apple.com/support/dotmac/
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SIDEBAR .MAC FOR SMALL BUSINESS 

Apple created .Mac for individuals, but many small businesses also 

find the service to be a good value for Web hosting, email, and online 

backups. The .Mac Family Pack, in particular, is appealing for organ-
izations with just a few employees, as it includes a primary account 

and four sub-accounts for less than the price of two full subscrip-

tions. (Despite Apple’s use of the term “family,” nothing prevents 

you from offering the sub-accounts to friends or co-workers.) 

Whether or not .Mac is appropriate for your business depends on 

the nature of the business and on what you need to do online. For 

example, if you own a bakery and need only email access and a sim-

ple informational Web page or two—along with, perhaps, some photo 

albums with samples of your work—a .Mac account should be more 

than adequate. Similarly, if your main business need is for an online 
location to store a small number of files so that you can retrieve them 

easily from anywhere, .Mac’s iDisk could be just the thing for you. 

On the other hand, if your business’s online needs are more exten-

sive, .Mac is not the right choice. You’ll quickly run into limits of one 
sort or another—data-transfer limits, functionality, or policy. Apple 

restricts the uses of .Mac accounts, and breaking the rules could end 

up in the cancellation of your membership. Examples of things you 

must not do: 

• Offer commercial software downloads. (Shareware is a gray area, 

but I’d err on the side of caution.) 

• Exceed your bandwidth limitations. 

• Solicit for advertisers or sponsors. 

• Post third-party ads of any kind. 

You can find a complete description of permissible and prohibited 

activities in the .Mac Membership Agreement and Acceptable Use 

Policy, located at http://www.mac.com/1/membership_terms.html. 

Pay special attention to the discussion of personal versus business 

uses near the end of the section titled “Violations of System and 
Network Security.” 

  

http://www.mac.com/1/membership_terms.html
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Set Up .Mac System Preferences 

If you’re using a Mac running Mac OS X (as, I assume, most readers 

are), make sure your computer is set up to use your .Mac account. For 
now, only one small item requires your attention. Follow these steps: 

1. Go to the Account tab of .Mac System Preferences (Figure 1). 

2. If your .Mac member name and password are not already filled in, 

enter them now. Then close the window. 

Your Mac is now configured to use .Mac, and your iDisk should 

appear in the sidebar of Finder windows (if it was not there already). 
If it does not appear, see Troubleshoot connection problems, later. 

FIGURE 1 

 

 

 The first step in using .Mac is to enter your member name and 
password in the Account pane of .Mac System Preferences. The 
Tiger version of the .Mac preference pane is shown here; under 
Panther, some options are different—but the .Mac Member Name 
and Password fields are the same. 
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Learn to Navigate the .Mac Web Site 

As a .Mac member, you’ll probably visit the .Mac Web site at 

http://www.mac.com/ frequently. Although the site is mostly self-
explanatory, I’d like to call your attention to a few items that may 

be less than obvious. 

You’ll notice that I haven’t included any screen shots of the .Mac 

home page. That’s because it changes often. Apple adds, removes, 
and rearranges page elements often. In addition, the page appearance 

can change depending on whether or not you’re logged in. 

When you visit the .Mac Web site for the first time (in a given Web 

browser, on a given computer), you see its public face—a view appro-
priate for nonmembers. The main purpose of this version of the page 

is to describe .Mac in a way that makes people want to join.  

After you log in by clicking the Log In link near the top-right of the 

home page, the page design changes to be more appropriate for mem-
bers. Part of the page (a left-hand sidebar as of September 2007) has 

links to various parts of the site as well as a few bits of personal data, 

such as how many unread email messages you have, or the number of 

people who have visited any Web sites where you’ve set up counters. 

You can also search your .Mac Address Book directly from this page. 

Once you log in, you see this “logged-in” version of the site even if 

you quit your browser and reopen it another day, because .Mac uses 

a cookie stored on your computer to remember that you were logged 

in the last time you visited the site. 

The navigation bar at the top of the page is always present—and this 

goes for the entire .Mac Web site (Figure 2). 

FIGURE 2 

 
 

 

 The navigation bar (as it appears before and after logging in) 
contains links for all the major sections of the .Mac Web site (top). 
After you log in, your member name appears on the right side; click 
your member name to go to your Account Settings page (bottom). 

  

http://www.mac.com/
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Regardless of where you are or what else appears on the page, you 

can always use the links on this bar to go to the major areas of the 

.Mac site—the .Mac home page, Mail, Address Book, Bookmarks, 

HomePage (Apple’s online tool for creating Web sites), iCards, 
Groups, and Help. And, you can log in and out. (To see your Account 

Settings, click your member name on the bar after you log in.) 

To end your session, click Log Out on the navigation bar. If you’re 

using the site from your own computer, you needn’t ever log out. 
But if you’re using a public computer, you should log out to ensure 

that no one else can access your private data. (Not that you have 

much to worry about—the .Mac site requires users to log in again 

almost every time they move from one part of the site to another. 

So the fact that your member name and “Log Out” appear on the 

navigation bar doesn’t necessarily mean you’re fully logged in.) 

  
BUG Why does the .Mac Web site ask you to enter your member name 

and password so often? Even if I’ve just logged in, if I go to another 

area of the site, I’m frequently asked to “confirm” my login. I can 

understand logging me out due to a period of inactivity (which the 

site also does), but I’ve been asked to log in twice within the space 

of 5 seconds—something even my bank’s high-security Web site 
does not require. In my judgment, this is a serious design flaw— 

one that’s been around since the very beginning. 

Although I know of no solution other than for Apple to fix the 

problem, you can partially work around it by configuring Safari 
(or whichever browser you use) to store user names and passwords. 

That way, you have only one button to click when the login page 

appears. To set this up in Safari, choose Safari > Preferences and 

click the AutoFill button in the toolbar. Make sure the User Names 

and Passwords checkbox is selected. The next time you log in to 

.Mac, Safari will ask if you want it to save your name and password. 
Click Yes, and the next time the login page appears, your member 

name and password will already be filled in. 

  

Manage Your Account 

Later in this book, I describe specific preferences you can set for 

each of the .Mac Web site’s sections. For now, though, I’d like to 

call your attention to one important area: the Account Settings page 
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(Figure 3). To go to this page, log in and then click your member 

name in the navigation bar; reenter your login information if 

prompted to do so. 

FIGURE 3 

 

 

 Manage your account settings on this page. To get here, log in, and 
then click your member name on the navigation bar. 

to   Here’s what’s on the Account Settings page (but note that options 

vary somewhat according to your account type): 

• Buy More: Click this button to add email-only accounts (see Add 

Email-Only Accounts), buy more storage space (see Buy more 

space), or upgrade to a Family Pack. If you have an email-only 

account, this button may not appear; instead, click the button 
labeled Manage Accounts that appears above the divider line on 

the right. 

• Personal Info: Click this button to change your first or last 

name, alternate email address, or preferred language, and to 
subscribe to or unsubscribe from the .Mac Newsletter. 
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• Credit Card Info: Update the credit card information on file 

for your membership, and choose whether you want the account 

to  renew automatically (using that credit card). 

• Password Settings: Here, you can change your password or 

enter a new password question and answer (which enables you 

to reset your password if you forget it). 

• Personal Domain: As of August 2007, .Mac now lets you use 

your own domain name with .Mac Web sites published from iWeb. 

Click here and follow the instructions to set up this feature. For 

more information, see the sidebar Master of Your Domain. 

• Storage Settings: Choose how your .Mac storage space is 

allocated among your iDisk, email, and .Mac groups (see Divide 

space between files and email). 

• Mail Preferences: Change settings for .Mac Mail (see Configure 
.Mac Mail preferences). 

• Secure iChat: This button appears only if you’ve installed Mac 

OS X 10.4.3 or higher and enabled encryption in iChat. It lets 

you view the status and expiration date of your security certificate, 
as well as revoke it, if desired. (To enable iChat encryption, open 

iChat, choose iChat > Preferences, and click the Accounts icon in 

the toolbar. With your .Mac account selected, go to the Security 

pane, click the Encrypt button at the bottom, and follow the 

instructions.) 

  
NOTE If your .Mac membership expires, you won’t be able to encrypt 

iChat conversations (though you can still have unencrypted iChats). 

  
• Group Preferences: If you are the owner or member of a 

.Mac group, this button takes you to a page where you can enter 

personal information (such as your address and Web site) that 

other group members can see. 
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TIP NEED HELP? 

Even though I intended this book to be a fairly complete guide to 

.Mac, you may occasionally run into questions I don’t address here. 

Don’t forget about other ways you can get help: 

• Use the Help menu in Mac OS X. 

• Click the Help link in the navigation bar on the Apple Web site. 

• Use the tutorials in the Learning Center on the .Mac Web site. 

• Visit Apple’s .Mac Discussion Boards at 
http://discussions.info.apple.com/dotmac/. 

  

Upgrade or Convert an Account 
Once you set up a .Mac member name—even if it’s for a trial account 

or an email-only account—that name is yours forever. Well, sort of. 

You can use it only as long as you pay for it, but even if you let your 

subscription lapse, no one else can claim that member name; you can 

reactivate your account at a later date if you so desire. (You can con-
tinue using your .Mac member name for iChat, even after your sub-

scription has expired.) 

  
NOTE Email aliases (see Use Email Aliases) behave a bit differently from 

member names. If you create an email alias and later delete it (as 

opposed to merely turning it off), that email address is reserved per-

manently, but you can’t reactivate it—and neither can anyone else. 

  
However, you may want to convert your membership from one 

type to another. For instance, you may have an expired or trial .Mac 

membership or a Family Pack sub-account that you want to convert 
to an email-only account; conversely, you may want to convert an 

email-only account or Family Pack sub-account to a stand-alone 

.Mac membership. Most (but not all) conversions are possible, but 

the procedure varies. See Table 1 in Appendix B: Account Conversion 

Methods for an outline of the possible conversions. 

http://discussions.info.apple.com/dotmac/
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SIDEBAR .MAC AND WINDOWS 

Even though Apple designed .Mac primarily for Mac users, you can 

use most of its features from a Windows computer as well. In fact, 

you can purchase and use a .Mac subscription even if you’ve never 
touched a Mac. Because nearly everyone can use a reliable, spam-

filtered, Web-accessible email account, not to mention online 

storage space, and Web publishing, plenty of people join .Mac who 

don’t ordinarily use Macs. But because .Mac takes advantage of 

features built into Mac OS X (and third-party Mac applications), 

some features are unavailable when using Windows: 

• HomePage integration with iPhoto and iMovie 

• Synchronization (for things such as contacts, calendars, and 
bookmarks) between computers 

• Uploading calendars, contacts, and other personal data (though 

you can access information uploaded from a Mac) 

• Apple’s Backup application 

• iLife applications 

• Free software provided via .Mac, such as games and GarageBand 

loops 

(At one time, Apple also prevented Windows users from signing up 
for a .Mac trial account, but that limitation has been lifted.) 
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COMMUNICATE USING .MAC MAIL 

Each .Mac account includes an email address in the Mac.com domain 

(such as jwk@mac.com). You may already have an email account 

from your ISP or an online service such as Hotmail or Google Gmail, 

but .Mac Mail offers a number of useful features that make it ideal as 

a primary or supplemental email account. 

  
NOTE I use the term “.Mac Mail” when referring either to the email 

accounts included with .Mac accounts or to the Web-based 

interface for sending and receiving email in those accounts. I refer 

to the email client Apple includes with Mac OS X as “Mail” or “the 

Mail application.” 

  
Here are a few things that make .Mac Mail great: 

• You can check your email using the Mac.com Web site (read 

Access .Mac Mail over the Web) or your favorite email software, 

on nearly any platform, using either IMAP or POP (I cover this 

in Access .Mac Email Using Apple Mail; make sure to read the 

sidebar IMAP vs. POP). 

• Using the Mac.com Web site, you can set up autoreplies (for 

example, for “out-of-the-office” and vacation notices), forward 

your Mac.com email to another account, check POP email on 

another server, add your photo to outgoing messages, and more. 

• Apple’s mail servers provide excellent spam and virus filtering. 

(In a quick check of more than 18,000 spam messages I have 

received over the past several months, I found more than 12,000 

received at a certain email address in my own domain, but only 

37 received via my Mac.com address. That’s pretty impressive!) 

• You can add up to five aliases—extra email addresses that are auto-

matically forwarded to your main Mac.com account. See Use Email 

Aliases. 

• You can purchase up to ten additional email-only accounts (at $10 

each) for family members, business associates, or friends. Unlike 

aliases, these are distinct email accounts, with their own separate, 

password-protected email storage and access. See Add Email-Only 

Accounts. 
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SIDEBAR WEBMAIL VS. EMAIL CLIENTS 

I know many people who always read and compose their email 

(.Mac or otherwise) using a Web browser—even at home, on their 

own computers. This behavior baffles me, because email clients 
(including Mail, Eudora, Entourage, Thunderbird, PowerMail, 

and many others) are so much more powerful and easier to use— 

and several of them are available for free.  

That said, Web-based access to .Mac Mail (“webmail”) has improved 
considerably over the years, and can be quite useful. And a few 

features of .Mac Mail are available only through the Web interface. 

Here are some cases where you might prefer one over the other: 

Use the Web interface: 

• When you’re away from your own computer—at a library, café, 
or friend’s home, for instance 

• To add, change, or remove your photo (which appears when the 

recipient uses Mail or the .Mac Web site to read your message; 

see Configure .Mac Mail prererences) 

• To change email forwarding or autoreply settings 

• To add, edit, or delete email aliases 

Use an email client:  

• If you want multiple windows (for example, one containing your 
message list and another containing a message you’re composing) 

• To run rules (also known as filters) for sorting your messages and 

performing other tasks automatically 

• To search the content of messages 

• To modify fonts, sizes, styles, and colors in outgoing messages 

• To redirect messages to another address, keeping the original 

sender’s address in the From field 

  

Access .Mac Mail over the Web 
To access your .Mac Mail using your favorite Web browser, go to 

http://www.mac.com/, click the Mail link on the navigation bar, 

and—if you aren’t already logged in—enter your member name and 

password. The .Mac Mail page (Figure 4) appears, showing your 

Inbox. 

http://www.mac.com/
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FIGURE 4 

 

 

 You can view messages sent to your Mac.com address (and any email 
aliases, shown here in color) on this page of the .Mac Web site. 

  Use the main .Mac Mail page 

The main .Mac Mail page, which displays your message list and folder 
list, mimics the interface of Apple Mail and is largely self-explanatory. 

Here’s a quick overview of what you can do in this view: 

• Check for new messages: .Mac Mail does this automatically 

when you first log in, and periodically thereafter, but to check 
manually at any time, click Get Mail. 

• View a message: Click any message in the list; its contents 

appear in the pane below. 

• See more pages of messages: When a folder’s message list is 

long, click the  or  button in the toolbar to move forward 

and backward one page at a time. 

• Resize the preview pane and message list: Drag the bar that 

divides the two panes. 

• Sort your messages: Click any column header. To reverse the 

sort order, click the column header a second time. The column 
with the  header shows an indicator ( ) for unread messages. 
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NOTE If you prefer not to work in the default three-pane window, you 

can switch to a two-pane setup, in which double-clicking a message 

replaces the message list with the contents of the selected message. 

See Configure .Mac Mail Preferences for instructions. 

  
• Search for a message in the current folder: Enter search 

text in the Search field and press Return. Note that only the 

Subject, From, To, and Cc fields are searched, not the body of 

messages. You can quickly repeat recent searches by choosing 
a search term from the  pop-up menu. 

• Select all visible messages: Choose Actions > Select All or 

press the A key. You may wish to do this, for example, if you intend 

to delete or move all the messages in your Inbox at the same time. 

• Deselect all messages: Choose Actions > Select None. 

• View messages in another .Mac Mail folder: Click the folder 
in the list on the left. 

• Move a message (or messages) to another .Mac Mail 

folder: Drag the message(s) to the desired location in the folder 

list. Alternatively, select the messages, choose Actions > Move to 
Folder (or press the M key), select a folder, and click Move. 

• Create, modify, or delete folders: Click the Manage link next 

to the Mail Folders item in the list on the left. 

• Modify preferences: click the Preferences link above the toolbar 

(see Configure .Mac Mail Preferences, ahead). 

  
NOTE Some email programs—including Apple Mail—let you specify High, 

Normal, or Low priority for outgoing messages. In Mail, priority (if 

other than Normal) is indicated by an icon in the  column. (You 
may have to choose View > Columns > Flags to display the  

column.) In .Mac Mail, however, message priority is not shown. 
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Work with incoming messages 

When viewing a message, the toolbar buttons for Delete, Reply, 

Reply All, and Forward perform their expected functions. You can 

also access these commands using the Actions pop-up menu on the 
toolbar. If you’ve enabled keyboard shortcuts (see Configure .Mac 

Mail Preferences), the Actions menu also lists the shortcuts for these 

commands and several others. Unlike keyboard shortcuts in most 

programs, those used in .Mac Mail require no modifier keys (such as 

Command or Control); however, they are case-sensitive—for example, 

the shortcut for Reply is r (the R key), while Reply All is R (Shift-R). 

You can perform several other tasks with incoming messages: 

• Mark a message as Read or Unread: Choose Actions > Read 
or Actions > Unread, respectively, or press the U key to toggle its 

Read status. 

• Mark a message as Junk Mail or Not Junk Mail: Choose 

Actions > Junk Mail or Actions > Not Junk, respectively, or press 
the J key to toggle its Junk status. Depending on your preferences, 

marking a message as Junk Mail may also move it to your Junk 

mailbox; see Configure .Mac Mail Preferences, ahead. 

• Mark a message as Flagged: Choose Actions > Flagged or 
press the L key; repeat the action to un-flag the message. 

• Add a message’s sender to your online .Mac Address 

Book: Click the sender’s email address in the message view. Make 

any desired changes to the first and last name and then click Add. 

• Display a “printer-friendly” version of the message in a 

new window: Choose Actions > Print or press the P key. 

Compose a new message 

To compose a new message, click the New button in the toolbar. A 
new window appears, as shown in Figure 5. Fill in (at least) the To, 

Subject, and message fields. Click Send to send the message. 
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FIGURE 5 

 

 

 Use this window to compose new email messages. 

  Other features you may use when composing a message are: 

• Cc and Bcc: Addressees in the Cc (carbon copy) field get a 

copy of the message, with their addresses visible to all recipients. 

Addressees in the Bcc (blind carbon copy) field get a copy of the 

message, but their addresses are hidden from all recipients. You 

can show or hide the Bcc field in the Composing view of .Mac Mail’s 
preferences. 

  
NOTE To include more than one addressee in the To, Cc, or Bcc fields, 

separate the email addresses with commas. 

  
• Account: If you have set up one or more email aliases (see Use 

Email Aliases), use this pop-up menu to specify which address will 

appear as the From address in the message you’re sending. 

• Attach a File: To attach a file to your message, click Attach a File, 
navigate to the file on your disk, and click Choose. Repeat for any 

additional files you want to attach—up to a maximum of 20 MB 

worth of files. To remove a file you’ve chosen, click its  button. 

• Save as Draft: If you’re not ready to send a message yet but want 
to save what you’ve written so far, click Save as Draft. The message 

is saved in your Drafts folder. 
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• Address: To address this message to someone in your .Mac 

Address Book, click Address. This displays a special view of your 

Address Book in which each entry has To, Cc, and (optionally) 

Bcc checkboxes. First, locate your addressee(s) in the list (use the 
Search field at the top to find contacts quickly if the list is long). 

Check the To, Cc, or Bcc box for one or more contacts, and then 

click OK. Then .Mac Mail returns you to your message in progress, 

with the selected addresses entered in the fields you chose. 

• Check Spelling: When you click Check Spelling, .Mac Mail 

displays an alert with the number of misspelled words; when 

you click OK, a (noneditable) copy of your message appears with a 

dotted red line under each unrecognized word. When your pointer 

hovers over one of these words, a pop-up menu appears. Suggested 

spellings (if any) appear at the top of the menu, followed by Ignore 
(to ignore the word for this message only), Learn (to add the word to 

your .Mac Mail dictionary), and Edit (to correct the word by hand).  

To change the spelling dictionary’s language, use the Dictionary 

pop-up menu at the bottom of the window. When you finish your 
spell check, click Check Spelling to recheck the spelling or Return 

to Message to continue composing the message. 

  
TIP INLINE SPELL CHECKING 

Some Web browsers, such as Safari and OmniWeb, support real-
time inline spell-checking in Web-based forms. If you’re using 

one of these browsers, Control-click (or right-click) in any text field 

on the .Mac site and choose Check Spelling As You Type from the 

Spelling submenu of the contextual menu. Using this spell checker 

is quicker than using .Mac’s; you may also find it more accurate, 

as it uses the same spelling dictionary as most Mac OS X programs. 

  
Configure .Mac Mail preferences 

When you click the Preferences link, .Mac Mail presents five sets of 
preferences: General, Viewing, Composing, Aliases, and Other. Click 

one of those labels to display a view containing that category. When 

you’re finished modifying preferences (in one or more views), click 

the Save button at the bottom, which returns you to your Inbox; to 

discard changes and return to the Inbox, click Cancel. 
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General Preferences 

Let’s first look at the Preferences shown in the General view (Figure 6). 

Appearance: 

• Use .Mac Mail With: Select 3 Panes (the default) to display 

the selected message’s contents in a separate pane of the main 
window; select 2 Panes to display only the message list. In a two-

pane view, double-click a message to display its contents. 

• Use Small Mailbox Icons: Check this box if you have many 

mailboxes (folders) and wish to reduce their size in the folder list. 

• Show All Folders at Login: When this box is checked, your list 

of user-created mailboxes (folders) is expanded in the folder list 

when you log in; when unchecked, the list is collapsed at login. 

• Use Keyboard Shortcuts: When this box is checked, you can 

use keyboard shortcuts (displayed in the Actions pop-up menu) for 

common activities; when unchecked, shortcuts are disabled. 

FIGURE 6 

 

 
 

Set appearance and mailbox options in the General preferences view. 

  



Page 29 

Mailbox Behavior: 

• Save Sent Messages To: When this box is checked, .Mac Mail 

saves copies of all outgoing messages into the folder you choose 

from the pop-up menu—typically Sent Messages or Sent. 

• Move Deleted Messages To: When this box is checked, mes-

sages you delete are moved to the folder you choose from the pop-

up menu (typically Trash). When unchecked, deleted messages are 

removed from the server immediately and permanently. 

Junk Mail: 

These options were added in August 2007. Contrary to appearances, 
.Mac Mail has always included server-side spam filtering. But previ-

ously, this filtering was invisible, and it zapped only the most obvious 

and egregious spam. It was not configurable in any way, instead, it 

relied on Mail (or whichever email client you use) on your Mac to do 

another, more intensive level of spam filtering. Now, .Mac Mail can 

directly deal with messages that appear to be spam but aren’t auto-

matically rejected by the server-side filters: 

• Enable Junk Mail Filtering: When this box is checked, .Mac 
Mail marks suspected spam by coloring its sender, subject, and 

date brown and putting a  flag in the  (Priority) column. If 

a legitimate message is incorrectly marked as junk, select it and 

choose Actions > Not Junk. 

• Automatically Move Messages Marked As Junk to the 

Junk Folder: With Junk Mail Filtering enabled and this box 

checked, messages automatically marked as junk will also be 

moved out of your Inbox and into the Junk folder. If a message 
is in this folder and you choose Actions > Not Junk, .Mac Mail 

removes the  flag and brown coloring but does not move the 

message back to your Inbox; you must do that manually. 

If you use the Mail application on your Mac to check your .Mac email 
account, make sure that your Mail preferences match those of the 

.Mac Web site—in particular, if you have .Mac Mail configured to 

automatically move spam to your Junk folder, Mail should too. Apple 

has a Web page providing complete details about these settings; see 

http://docs.info.apple.com/article.html?artnum=306215-en. 

Time Zone: To ensure that incoming messages are shown with 

times corresponding to your locale, choose a city in your time zone. 

http://docs.info.apple.com/article.html?artnum=306215-en
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Viewing Preferences 

You can modify many aspects of the way messages appear (Figure 7): 

Show: 

• Messages Per Page: Choose the maximum number of messages 

(from 10 to 50) to display at one time in message lists. 

• Message Previews: .Mac Mail can display the beginning of each 

message’s text after the subject in the message list. If you choose 

Long, the preview text can be up to three lines long. With Short 

(the default), it’s a single line. Or choose None for no preview. 

FIGURE 7 

 

 

 The Viewing preferences affect the appearance of message lists and 
incoming messages. 

  
HTML Messages: 

• Automatically Load Images in HTML Messages: By default 
this box is unchecked, so images in HTML messages don’t appear 

unless you click the Load Images button at the top of the message. 

This setting may prevent spammers from detecting that their junk 

mail reached you. To display images automatically, check the box. 

• Enable “Show Long Headers”: With this option checked, a 

Show Long Headers link appears in the top-right of incoming or 

saved messages. Click this link to show headers that are normally 

hidden, such as the message’s path from its originator to you, Reply-

To, and Content-Type. (If you have to ask what these things mean, 

you probably don’t need to see them, but they can be useful—for 
instance, when reporting spam to the sender’s ISP.) If the headers 

are visible, the link name changes to Hide Long Headers.  



Page 31 

Composing Preferences 

Next up is the Composing view (Figure 8), with its preferences 

relating to what appears in your outgoing messages. 

Composing: 

• Quote Original When Replying: With this box checked, every 
time you reply to a message, the original message is quoted (with 

an attribution line, such as “On Saturday, September 1, 2007, at 

02:11PM, Joe Kissell <jwk@mac.com> wrote:” and with > symbols 

at the beginning of each line of quoted text). You can always edit 

out all or part of the quoted text before sending the message. 

• Show Bcc Field: When selected, a Bcc (blind carbon copy) field 

appears in the message composition window. 

• Encode Outgoing Messages Using Unicode (UTF-8): If you 
mix multiple languages in your email messages or use characters 

that don’t appear in English, Japanese, French, or German, check-

ing this box can help to ensure that your recipients can read your 

message (as long as they’re using a modern email client). 

• Check Spelling Before Message Is Sent: When selected, .Mac 

performs a spell check every time you click the Send button, just as 

if you had clicked the Spell Check icon. 

• Default Dictionary: Choose a spelling dictionary language. 

Identity: 

• Send Mail As: If this field is blank, only your Mac.com email 

address (as in “jwk@mac.com”) appears in the From field of 

messages you send to other people. If you fill in your name here, 

recipients see your name and your email address (as in “Joe Kissell 

<jwk@mac.com>”). I recommend including your name here; it’s 

much easier to identify a message’s sender by name than by email 
address alone. Be aware that when you send email from an alias 

(see Use Email Aliases), each alias can have its own From name. 

• Type Your Signature Here: Your signature is a block of text 

that appears automatically—assuming you enable this option—at 
the end of every message you compose on the Mac.com Web site. 

This text can include your name, phone number, favorite quote, or 

anything you want all your recipients to know. Don’t include your 

life story here; a few lines should be more than adequate. 
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FIGURE 8 

 

 

 Set options for outgoing email in the Composing preferences view. 

  
 

  
NOTE Signatures you set up in the Mail application don’t transfer to .Mac 

Mail or vice-versa, regardless of your sync settings. 

  
• Use a Custom Photo: This option (sometimes called a “photo 

signature”) is both cool and a bit misleading. If you include a photo 

here, that photo appears in all messages sent from your Mac.com 

address—whether you send them from the Web site, from the Mail 

application, or from another email client. The catch is that the photo 

appears only if the recipient views your message on the Mac.com 

Web site or in the Mail application (Figure 9).  

This feature works because the Mac.com Web site and Mail check 

each incoming message to see if the sender is a .Mac member; if 

so, they check the .Mac database for that member’s photo and, if 

they find it, display it. Other email clients and Web sites don’t have 
access to this data. 

  
NOTE If you have an email-only Mac.com account, you can’t add a photo. 
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FIGURE 9 

 

After you add 
your photo in 
the Composing 
preferences 
view, your 
recipients see 
it at the top of 
messages you 
send to them. 

   To add a photo: 

1. Check the Use a Custom Photo box. 

2. Click the Add Photo link (Change Photo if you previously had a 

photo). Then click the Choose File button, navigate to a photo 
(in JPEG or GIF format) on your hard disk, and click Choose. 

  
TIP Photos are scaled to a maximum of 64x64 pixels. For best quality, 

consider using an image-editing program such as Photoshop 

Elements or Graphic Converter to crop your photo so that only your 

face shows and reduce it to 64x64 pixels before uploading it. 

  
3. Click Upload. When the upload has finished, click Save. 

To temporarily prevent .Mac from showing your photo, uncheck 
the Photo box. This setting works in real time; as long as it remains 

unchecked, recipients won’t see your picture, regardless of the 

setting’s status when you actually sent particular messages. To 

remove your photo altogether, click Clear Photo. 

Alias Preferences 

Use the Aliases view (Figure 10) to add, change, or delete aliases. 

Along with your main .Mac email address (member-name@mac.com), 

you can have up to five other addresses, called aliases, that use the 

same account. I discuss aliases a few pages ahead, in Use Email Aliases. 
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FIGURE 10 

 

 

 Manage your .Mac aliases in the Aliases view. 

  Other Preferences 

The Other view (Figure 11) contains preferences that help you check 

mail from other POP accounts, forward your .Mac email elsewhere, 

and set up an autoreply. 

FIGURE 11 

 

 
 

Set up POP accounts, forwarding, and automatic replies in Other. 

  
External Account: 

• Check Mail from an External POP Account: .Mac Mail can 
check POP email accounts from other providers and add those mes-

sages to the Mac.com mailbox of your choice; the messages appear 

both in the .Mac Web interface and in your Desktop email client.  

To set up this feature, check the Check Mail from an External POP 
Account box, fill in the fields that appear (Email address, Incoming 

Mail Server, User Name, and Password), and choose a mailbox, 

from the Destination Folder pop-up menu, into which the imported 
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messages should be delivered. If you select Leave Messages on 

Server, .Mac does not delete the messages from the POP server 

after importing them. After filling in the fields, click Save. 

Mail doesn’t check your POP account immediately, on a schedule, 

or when you click the Get Mail button; checking that account is a 

manual procedure. After configuring a POP account, you’ll see a 

new link at the bottom of the folder list that reads “Check account 

name.” Click this link to retrieve messages from the account. 

Forwarding: 

• Forward My Email To: .Mac can forward all your incoming 

email to another (non-Mac.com) address, if you wish. This can be 

useful, for example, if you want to maintain multiple email address 

but check only one account, or if you want someone else to get 

copies of all your email.  

To turn on forwarding, check this box and fill in an email address. 

(You cannot forward your email to another Mac.com address.) If 

Keep a Copy of Forwarded Messages is checked, incoming messages 

remain in your Mac.com Inbox (and count toward your storage 

quota) even when forwarded; if it is unchecked, messages are 
deleted immediately after being forwarded. 

  
NOTE Forwarding and autoreplies apply to both your main Mac.com 

address and any aliases you’ve set up (see Use Email Aliases, ahead). 

  
• Automatically Reply to Email When It Is Received: To send 

an automatic reply to each person who sends email to your Mac.com 

address, check this box and enter the text of the reply. Each email 

address receives only one auto-reply—so if one person (or mailing 

list) emails you a dozen times while Auto Reply is enabled, only the 
first one of those messages generates a reply.  

Auto Reply is meant primarily for “out-of-the-office” or vacation 

notices, and unlike rules you might set up in your email client, 

it works even if your computer is off (since it runs on Apple’s 
Mac.com mail server). However, you can use it for other purposes—

for example, to let senders know that you’ve received (and will 

read) their messages but that you’re busy and may not be able 

to respond immediately. 
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TIP You can, if you wish, forward all your .Mac email to another 

account and also send an auto-reply. Using both (particularly when 

Leave Forwarded Messages on Server is selected) can be useful for 

sending out automated replies while also forwarding a colleague 

or family member copies of all messages in case something urgent 

comes up. 

  
Work with folders on the server 

Because .Mac Mail is based on IMAP (read the sidebar IMAP vs. POP, 
a few pages ahead), it can store email messages on the server in any 

number of user-configured mailboxes (called “folders” in the .Mac 

Web interface). The folder list appears on the left side of the main 

window. To modify this list, click the Manage link by the Mail Folders 

item. A new view (Figure 12) appears. 

FIGURE 12 

 

 

 Add, delete, or rename folders (mailboxes) in this view. 

  In this Manage Folders view, you can do any of the following: 

• Add a folder: Select the folder in which the new folder should 

appear (Mail Folders or a subfolder you’ve created), type a name 

in the Folder Name field, and then click New Folder. 

• Rename a folder: Select the folder, click the  icon, and type 

in a new name. (Changes to folder names may not appear immed-

iately in Mail or other email programs; you generally must quit 

and restart the application to resynchronize folder lists.) 
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• Delete all the messages in a folder: Select a folder and click 

Empty Folder. Except for Trash, you probably do not want to 

do this. (You can also empty the Trash folder, if it contains any 

messages, by clicking the Empty link next to its name.) 

• Delete a folder completely: Select it and click the  icon. 

When you’re finished making changes in this view, click Done. 

  
NOTE You can’t drag folders in .Mac Mail to rearrange them, but since 

they’re sorted alphabetically, renaming them changes their order. 

  

Access .Mac Email Using Apple Mail 

Apple’s Mail application, included with every copy of Mac OS X, is 

a full-featured email client that works with virtually any mail server. 

Conversely, although you can use almost any email client (not to men-

tion the .Mac Web site) to fetch your .Mac email, Mail includes a few 
special features that make it the best way to send and receive email 

using your .Mac account. 

For starters, Mail offers .Mac users semiautomatic account setup. 

It also provides an easy way to create rules that filter or sort incoming 
messages. Unlike the .Mac Web interface, Mail enables you to apply 

formatting such as fonts, colors, and styles to your messages. And 

under Mac OS X 10.4 or higher, Mail automatically recognizes your 

email aliases; provides a mechanism to sync your account settings, 

rules, signatures, and smart mailboxes between Macs; and gives you 

ultra-fast Spotlight searching. 

If you entered your .Mac member name and password when installing 

(or upgrading) Mac OS X, Mail should already be configured to check 

your Mac.com email account. If not (or if you purchased a .Mac mem-

bership later), you can add your .Mac account to Mail as follows: 

1. Choose Mail > Preferences and click the Accounts button in the 

toolbar. 

2. Click the  button at the bottom of the Accounts view to add a 

new email account. 

3. In the General Information dialog, choose .Mac from the Account 

Type pop-up menu (if it is not already chosen). 
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4. Enter something descriptive (such as your Mac.com email address) 

as the Account Description. 

5. Enter your full name in the Full Name field, your .Mac member 

name (the part before the @ sign) in the User Name field, and your 

password in the Password field. Click Continue. 

6. After Mail verifies your account settings and displays your Account 
Summary, click Continue again. Then click Done. 

Mail is now configured to check your .Mac account. 

By default, Mail uses the IMAP protocol to retrieve your email, stor-

ing messages you save in folders on the server. If you prefer to access 

your .Mac email with Mail using POP (read the sidebar two pages 

ahead, IMAP vs. POP), set up a POP account instead: 

1. Choose Mail > Preferences and click Accounts in the toolbar. 

2. Click the  button at the bottom of the Accounts pane to add a 

new email account. 

3. In the General Information dialog, choose POP from the Account 

Type pop-up menu. 

4. Enter something descriptive (such as your Mac.com email address) 
as the Account Description. 

5. Enter your full name in the Full Name field, and your full Mac.com 

email address (membername@mac.com) in the Email Address 

field. Click Continue. 

6. In the Incoming Mail Server field, type mail.mac.com. In the 

User Name field, enter your .Mac member name (the part before 

the @ sign). Enter your password, and then click Continue. 

7. On the next screen, in the Outgoing Mail Server field, type 

smtp.mac.com if it is not already displayed. Make sure the Use 

Authentication checkbox is selected. The User Name field and 

Password field should contain the same information as in Step 5 

(and may already be filled in for you). Click Continue. 

8. Check the Use Secure Sockets Layer (SSL) box for outgoing email, 

and choose the Password authentication method. Click Continue. 
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9. After Mail verifies your account settings and displays your Account 

Summary, click Continue again. Then click Done. 

Mail now checks your .Mac email using POP. 

  
TIP To learn much more about Apple Mail, check out my two 

books on the subject: Take Control of Apple Mail in Tiger 

(http://www.takecontrolbooks.com/tiger-apple-mail.html) and  

Take Control of Spam with Apple Mail 

(http://www.takecontrolbooks.com/spam-apple-mail.html). 

   

  
TIP ACCESS .MAC EMAIL USING OTHER EMAIL CLIENTS 

Any email client can retrieve and send email using your .Mac 
account, even if it lacks all the special features of Mail. Just set up 

a new account using IMAP (generally a better choice) or POP, with 

the following settings: 

• Incoming mail (POP or IMAP) server: mail.mac.com 

• User name: Your .Mac member name 

• Password: Your .Mac password 

• IMAP or POP Authentication: Use “password” if your email 

client provides multiple options. 

• SSL for incoming mail: Yes, if the client offers the option 

• Outgoing (or SMTP) mail server: smtp.mac.com 

• SMTP Authentication: Yes; use “password” if your email 

client provides multiple options 

• SMTP port: 25 or 587 (Choose 587 if you get errors when 

trying to send mail; some ISPs block port 25 to prevent their 
servers from being used to send spam.) 

• SSL for outgoing mail: Yes, if the client offers the option 

   

http://www.takecontrolbooks.com/spam-apple-mail.html?14@@!pt=0030-INTERNAL
http://www.takecontrolbooks.com/tiger-apple-mail.html?14@@!pt=0030-INTERNAL
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SIDEBAR IMAP VS. POP 

IMAP (Internet Message Access Protocol) and POP (Post Office 

Protocol) are the two most common email delivery protocols—

methods for retrieving email from a server. When you configure 
Mail to use a .Mac account type, it uses the IMAP protocol. (The 

main reason for treating .Mac accounts as a separate type is that 

Mail can automatically fill in several settings for you; .Mac accounts 

also support email aliases.) However, you can also retrieve your 

.Mac email using the POP protocol. What’s the difference, and 

why might you choose one over the other? 

Generally speaking, when you retrieve email using POP, your 

email program downloads each message to your computer and 

then deletes it from the server—although you can configure most 

email programs, including Mail, to leave previously downloaded 
messages on the server for a set period of time, or even indefinitely. 

The server stores your messages in a single mailbox (your Inbox), 

and your email program is responsible for keeping track of which 

messages you’ve read. If you leave messages on the server and then 

check your email using another POP client, all the messages are 

marked as unread. 

When you retrieve email using IMAP, messages normally remain 

on the server after being downloaded to your email program, and 

the server (not your email program) tracks which messages you’ve 

read. You can create multiple mailboxes on the server (including 
one to hold email you’ve sent), so you can organize your saved 

messages on the server. If you later check your email with another 

program (or even on another computer), all your incoming, saved, 

and sent messages appear, with exactly the same status. 

In almost every situation, I strongly prefer IMAP, but I can think 

of a few specific situations in which POP might be a better option. 

Consider using POP for your .Mac email if: 

• You have a slow (as in dial-up) Internet connection. 

• You frequently exceed your .Mac mailbox quota (and can’t 

allocate more storage space to email). 

• You must access your .Mac email using an email program or 

Web-based service that does not support IMAP. 
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Use Email Aliases 

Your .Mac account comes with a Mac.com email address, but you can 

also configure up to five aliases—extra Mac.com email addresses that 
deliver their messages to the same account. For example, since my 

.Mac member name is jwk, my primary .Mac address is jwk@mac.com. 

But if I wanted a second address I could pass out to people who may 

want to contact me for questions related to my business, alt concepts, 

I could (well, did) set up the alias altconcepts@mac.com. Any mail sent 

to altconcepts@mac.com is actually delivered to jwk@mac.com. 

You can disable these aliases at any time. So if you begin receiving 

unwanted email at an alias addresses, you can stop it completely with 

just a few clicks. 

Why might you want to set up aliases? Here are some common 

reasons: 

• Privacy: An alias can hide your .Mac member name, giving you a 
measure of anonymity (or pseudonymity) if you share your address 

with strangers or post it in a public place (think Craigslist or “lost 

pet” posters, for instance). 

• Spam reduction: If you provide an email address when 
purchasing a product, entering a contest, or joining a mailing list, 

you run the risk that your address could be sold to (or even stolen 

by) spammers. Worse, you may never know how they got your 

address. If you enter an alias, however (such as purchases-my-
member-name@mac.com)—and later get email from another 

party—you’ll have a general idea of where they got it. You’ll also 
be able to stop future spam by disabling that alias. 

• Business: If you use your .Mac account for both personal and 

business purposes, you may wish to have a more professional-

looking address that is specific to your business. 

• Convenience: Using Apple Mail (or another email client), you 

can set up rules that sort, highlight, reply to, or otherwise act on 

incoming messages based on the address to which those messages 

were sent. In other words, email sent to aliases can be treated 
differently from other email. 
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Create an alias 

To create an email alias, follow these steps: 

1. Go to http://www.mac.com/, click the Mail link on the navigation 

bar, and—if you are not already logged in—enter your member 
name and password. 

2. Click the Preferences link above the toolbar, and then go to the 

Aliases screen. 

3. Click the Add Alias link. 

4. In the fields provided, enter the address you want to use and 

the name that will appear in From, and, optionally, choose a color 
(Figure 13). (When using the Mac.com Web site to retrieve your 

email, messages sent to the alias appear with this color back-

ground so that you can easily distinguish them.) 

FIGURE 13 

 

 

 Manage email aliases, and select colors for them, in this view. 

  5. Click Create. (In the event that your chosen address is already in 

use by another .Mac member, the site suggests alternatives with 

similar spellings.) 

6. Click the Save button at the bottom of the screen. 

You can repeat this procedure as necessary to add up to five aliases. 

To change an alias’s color, select the radio button corresponding to 
the color you want and click Save. 

http://www.mac.com/
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Deactivate or delete an alias 

When you wish to stop receiving email sent to an alias, you can either 

deactivate it or delete it. In both cases, any email sent to the alias 

bounces back to its sender. The difference is that if you merely deacti-

vate an alias, you can reactivate it later (if you want to use it for, say, 

tracking another online purchase or putting up another “lost pet” 
poster). If you delete an alias, it’s gone forever—neither you nor any-

one else can ever choose that email address again. Your limit of five 

aliases applies to both active and inactive aliases. If you reach your 

limit and want to create a new alias, you first must delete an existing 

alias (or, if you’re really stuck, buy a new email-only account). 

  
WARNING! If you already have five aliases and delete one, .Mac imposes a one-

week waiting period before you can create a new one. (You can’t get 

around this by deleting more than one of your aliases either.) This 

is a security measure to prevent unscrupulous users from hoarding 

aliases—or using an endless string of aliases to send out spam. 

  
To deactivate (or reactivate) an alias: 

1. Go to http://www.mac.com/, click the Mail link on the navigation 
bar, and—if you are not already logged in—enter your member 

name and password. 

2. Click the Preferences link above the toolbar, and then go to the 

Aliases screen. 

3. Uncheck the box in the Active column for the alias you wish to 

deactivate. (To reactivate it, check the box.) 

4. Click the Save button at the bottom of the screen. 

To delete an alias permanently: 

1. Follow Steps 1 and 2 above. 

2. Click the  icon at the right end of that alias’s row. 

3. Click the Save button at the bottom of the screen. 

http://www.mac.com/
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Work with aliases on the Web 

As soon as you’ve set up an alias, any incoming email sent to that 

address goes directly into your .Mac Inbox, and, if you check your 

email using the Mac.com Web site, you’ll see the message sender, 

subject, and date in the color you selected. 

When sending outgoing messages, though, you may also want to 

use an alias as the From address, so that your main address remains 

private and replies go to the alias address. To use an alias when 

sending outgoing email, choose it from the From Address pop-up 

menu in the Compose window (Figure 14). 

FIGURE 14 

 

 

 Choose an alias from this pop-up menu to use it as the From address 
for this particular outgoing message. 

  Work with aliases in Apple Mail 

If you’re using Mac OS X 10.4 Tiger, you’ll find that Apple’s Mail 

application works seamlessly with aliases you’ve defined on the .Mac 

Web site. When sending a message with Mail, you can (as in the Web 

interface) choose one of your aliases as the From address. To do this, 

choose the alias from the Accounts pop-up menu just below the 

Subject field of the New Message window. 
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NOTE Users of email-only accounts (read Add Email-Only Accounts, next 

page) cannot add aliases. 

  
Rumor has it that the Tiger version of Mail was supposed to automat-

ically apply to your incoming email the highlight colors you selected 

for your aliases on the .Mac Web site, but that isn’t the case. However, 

you can create the same effect with a rule. To set up Mail to apply 

colors to messages based on the address to which they were sent: 

1. Choose Mail > Preferences, click the Rules icon in the toolbar, and 

click Add Rule. 

2. In the Rules dialog, type a name (your choice) into the Description 
field. 

3. In the “following conditions” section, choose To from the first pop-

up menu and Contains from the second one. (These are the default 

settings, so you really don’t need to change anything.) In the field 
after the second pop-up menu, enter one of your aliases. 

4. In the “Perform the following actions” section: 

a. Choose Set Color of Message from the first pop-up menu.  

b. From the second pop-up menu, choose Of Text to replicate 

the effect on the .Mac Web site, or Of Background to keep 

the text of the sender, subject, and date in black and color the 
background.  

c. Choose a color from the last pop-up menu (ideally, choose the 

same color you used for this alias on the .Mac Web site).  

d. Click OK. 

Incoming messages sent to that alias will now appear in the chosen 

color in your Inbox. (Repeat this procedure, if you wish, for each of 
your aliases.) 

  
TIP Although space does not permit a detailed discussion of Mail rules 

here, you can follow the steps just above and choose other actions 

in Step 4 if you want to move, flag, reply to, or otherwise process 

incoming messages sent to any of your aliases. 
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Add Email-Only Accounts 

If you have friends, family members, or co-workers who want a 

Mac.com email address but don’t need a full .Mac membership, 
you can purchase email-only accounts, for $10 each per year, that 

essentially piggyback on your full .Mac membership. Each of these 

accounts comes with 512 MB of storage space for email. 

  
NOTE If you have a .Mac Family Pack, only the primary member (not sub-

account holders) can add email-only accounts. 

  
To add one or more email-only accounts, follow these steps: 

1. Go to http://www.mac.com/ and log in. 

2. Click your member name on the navigation bar or the Account link 

on the left side of the window and (if prompted to do so) enter 

your member name and password again. 

3. Click the Buy More button. 

4. Choose the number of accounts you want to add from the Email-
Only Account(s) pop-up menu (Figure 15). Then click Continue, 

enter your billing information, and click Continue again.  

5. When you’re ready to check out, click Buy Now. Click Continue one 

last time. 

Now that you’ve added an account, you must configure it with a 

member name and password. To do this, follow these steps (for each 

new account): 

1. Log in (twice), following Steps 1 and 2 above. 

2. Click the Manage Accounts button. 

3. Click the Set Up Account button and follow the instructions for 

configuring the account. 

Give the member name and password you just entered to the 
person using the account. She can then log in herself and, if 

desired, modify the password and other preferences. 

http://www.mac.com/
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FIGURE 15 

 

 

 To add one or more email-only accounts, choose how many you want 
from this pop-up menu on the Buy More page. 
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NOTE EMAIL ALIASES VS. EMAIL-ONLY ACCOUNTS 

So many email addresses! You have your main Mac.com email 

address, up to five aliases, and you can also add up to ten com-

pletely separate email-only accounts. In some situations, a (free) 
email alias can serve the same purpose as a (paid) email-only 

account. When should you choose which? 

The distinction to keep in mind is that email aliases deliver 

email to the same Inbox as your main Mac.com address, whereas 
email-only accounts have entirely separate mailboxes—each with 

its own user name and password. So although you can use a rule to 

sort messages addressed to various aliases into different mailboxes, 

nothing prevents you from seeing and working with all those mes-

sages. With email-only accounts, only someone who knows that 

specific user name and password can access the messages—in fact, 
each email-only account must be set up as a separate account in 

your email client. 

Thus, as a general rule, one person may have several aliases, but 

each person should have a separate email account (if not a separate 
full .Mac membership)—even if all users share the same computer. 

Because each user can set up a separate system-level user account 

with its own preferences for every application (including Mail), 

having a separate account reduces clutter and enables each user 

to maintain privacy. 
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KEEP YOUR INFORMATION IN SYNC 

Your .Mac account provides several different ways of synchronizing 

information. These include: 

• Synchronizing data from applications on your Mac (Address Book, 
Safari, and iCal) with the .Mac Web site. 

• Synchronizing data of various kinds between two (or more) Macs 

(discussed later in this section) 

• Synchronizing files and folders on your iDisk with a local copy 

stored on your Mac. 

Depending on the third-party software you have installed, you may 
be able to synchronize other sorts of data too. 

Because synchronization is such a large part of the .Mac experience 

(especially under Tiger), you should understand why you should (or 

shouldn’t) sync your data, how syncing works, how to set it up, and 
how to deal with some of the complexities it presents. 

  
NOTE OTHER KINDS OF SYNCING 

Mac OS X can synchronize data in other ways, too, such as: 

• Between your Mac and a mobile phone 

• Between your Mac and a PDA 

• Between your Mac and an iPod 

In addition, many programs exist to facilitate the syncing files 

and folders (perhaps even entire volumes) between two computers. 
Because these kinds of syncing do not require .Mac (and because 

they can be quite involved), I don’t cover them here. However, 

you can learn about them in Take Control of Syncing in Tiger 

(http://www.takecontrolbooks.com/tiger-syncing.html). 

  

Why Sync? 
You can use your Mac, and your .Mac account for that matter, without 

ever synchronizing anything. And yet, I think this set of capabilities 

is so useful that to ignore it is to pass up a great opportunity to make  

http://www.takecontrolbooks.com/tiger-syncing.html?14@@!pt=0030-INTERNAL
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your life easier with almost no effort. Here are a few reasons you 

might want to use some or all of .Mac’s sync capabilities: 

• Make your key information (such as contacts and bookmarks) 

available from any computer, at any time, via the Web. 

• Get a “backup,” of sorts, free. I put backup in scare quotes because 

I wouldn’t pretend that these few synchronized items in any way 
constitute a complete or proper backup, but an extra offsite copy 

of your data surely never hurts. 

• If you have more than one Mac, make sure some of your most 

important information is the same on each of them, without lots 
of tedious, error-prone manual copying. 

• Give multiple users (on different computers, or even on the same 

computer) access to the same information. 

Although not every type of synching provides all these benefits, every 

little bit counts. If you ever use more than one computer—whether 

that means two Macs on the same desk in your home or a Mac at 

school and a PC at your local library—.Mac’s synchronization features 

will soon become indispensable. 

Syncing Basics 
The fundamental idea of synchronization is very simple: You have 

copies of some piece of information in two different places, and you 

want them to be the same—preferably with the latest information 

from each. So synchronization consists of looking for the most recent 
piece of data in each place and copying it to the other place, replacing 

the older piece of data already there. 

To take a real-life example, let’s say the two places that store your 

data are your desktop Mac and the .Mac servers. And let’s say, further, 
that the information you’re trying to synchronize is your Address 

Book, and that both your local and online copies are, at the moment, 

identical. Now you change a contact on your Mac, and you change 

a different contact on the .Mac Web site. Then you synchronize your 

data. What should happen (and usually does) is that .Mac figures out 

that contact A is newer on your computer, and contact B is newer on 
the .Mac Web site, and it updates each copy of your data with the 

newer information. 
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That sounds easy enough, but any number of factors can make it 

more complicated and error-prone. Consider these, for instance: 

• You may be syncing not just one Mac, but two or even five Macs, 

with the .Mac servers—perhaps all on different schedules. A given 

piece of information could change in several different places 

between syncs. 

• In addition to syncing your Mac(s) with .Mac and with each other, 

you may sync them with a mobile phone or PDA, so changes can 

happen in even more places. 

• Although Mac OS X and the .Mac servers can look for changes 
in specific parts of some files (say, a given field in the record of a 

given contact), the same is not true for documents you manually 

put on your iDisk. If you revise the first page of your novel in one 

place and the last page in another, you end up with two versions of 

a file, neither of which is completely up-to-date. 

• Synchronization might not always occur when you think it should, 

due to a temporary loss of Internet connectivity, problems with the 

.Mac servers, or any number of other issues. 

• Your computer could experience disk errors or other problems that 

lead to corrupted data files. 

For all these reasons and more, syncing is often not as transparent 

and foolproof as we’d like. In the next few pages I tell you how to set 
up syncing and how to deal with some common kinds of conflicts. But 

first, permit me to offer a friendly word of advice: 

  
TIP Always back up your hard disk—and do not rely on the copy of 

your data that you sync to .Mac as your sole backup! I know from 

personal experience that unexpected things can and do go wrong. 

A thorough backup strategy can protect you against many prob-
lems, both human and technical in nature. For details about 

backing up, read my book Take Control of Mac OS X Backups 

(http://www.takecontrolbooks.com/backup-macosx.html). 

  

http://www.takecontrolbooks.com/backup-macosx.html?14@@!pt=0030-INTERNAL
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Set Up Syncing 

In versions of Mac OS X prior to 10.4, .Mac syncing required separate 

software, called iSync, and a series of often-confusing steps. In Tiger, 
however, you can set up basic synchronization with just a few clicks. 

  
NOTE iSync is still used for syncing certain kinds of devices, such as 

mobile phones. Although you no longer need it to sync with .Mac, 

you still need it to Adjust the Data Change Alert. 

  
To turn on synchronization, follow these steps: 

1. In the .Mac System Preferences, in the Accounts pane, verify that 
your .Mac member name and password are filled in. 

2. On the Sync pane (Figure 16), check the Synchronize with .Mac 

checkbox. 

FIGURE 16 

 
 

Turn on syncing on the Sync pane in the .Mac System Preferences. 
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4. Choose an update frequency from the pop-up menu. Here are your 

choices and what they mean: 

• Manually: With this setting, which is the default, you must 

initiate every sync manually—either by clicking the Sync Now 

button at the bottom of this pane, or by using the .Mac status 

menu (see Use the Sync Menu). 

• Every Hour, Every Day, Every Week: Synchronization 

occurs automatically at these fixed intervals, as long as your 

Mac is connected to the Internet. 

• Automatically: According to Apple’s documentation, this 
option means that synchronization occurs at least once per 

hour; if another of your registered computers (see Synchronize 

Multiple Macs) performs a synchronization before then that 

changes the data stored on .Mac, the sync occurs immediately. 

In practice, I’ve never seen a case where changing data on one 

computer and performing a sync triggered another registered 
computer to synchronize early, but synchronization does take 

place at least hourly. 

  
TIP In general, I recommend choosing Every Day if you use only one 

Mac, and Automatically if you use more than one. If your Mac isn’t 

ordinarily connected to the Internet, particularly if your Internet 

connection requires dial-in access, choose Manually. 

  
5. Check the checkbox for each type of data you want to sync. (In 

most cases, you’ll probably want to select them all.) I discuss the 
details of each data type just ahead, in “Understand Sync Options.” 

That’s it—your Mac will now synchronize the designated data with 

.Mac at the frequency you set. (If you chose Manually, click Sync Now 

to perform your first sync.) What exactly does it mean that your Mac 
and .Mac are in sync? Read on for the nitty-gritty details. 

Understand Sync Options 
The Sync tab of .Mac System Preferences lists at least six categories 

of data you can synchronize (and perhaps more, depending on which 

third-party applications are installed on your Mac). But it provides  
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no specific information about what each of these data types actually 

includes, or what exactly it means when you sync them. Here’s the 

scoop on what enabling each option does: 

• Bookmarks: Your Safari bookmarks are copied to your iDisk in 

Your-iDisk/Library/Application Support/Bookmarks/ 
Bookmark.xml. You can view, use, and modify these bookmarks 

online using the .Mac Bookmarks feature (discussed in .Mac 

Bookmarks).  

If you set up another Mac to sync its bookmarks, your Safari 

bookmarks will stay in sync between the two computers, as well. 

This option does not synchronize bookmarks from any other Web 

browser—only Safari. 

• Calendars: Your iCal calendars are copied to the .Mac servers. 

This includes all your local calendars as well as other (public or 

private) calendars to which you’ve subscribed. The calendar data 

is stored…somewhere. (You can look all through your iDisk—even 
using Terminal to see invisible files—but you won’t find your iCal 

data there anywhere. I suspect Apple stores the data in a private 

location that is not part of your iDisk, but I can’t prove, disprove, 

or explain this.)  

When you sync your calendars, they become available to other 

Macs you synchronize with .Mac, but you cannot view your 

calendar information on the Web unless you go through a separate 

procedure to publish the calendars (read Publish and view 

calendars). Even then, you cannot modify them on the Web. 

  
TIP If you sync your iCal calendars across multiple Macs, alarms will 

pop up on all of them—and if you’ve set up email alarms, you’ll get 

multiple copies of each email too. This may be what you want, but 

if you’re using several Macs at the same time, this can become an 

annoyance. You can, of course, simply choose not to sync your cal-

endars, instead publishing your calendars from one of your Macs 

and subscribing to them from the others—omitting the alarms. One 
caveat: you’ll only be able to modify the calendars from the Mac 

that does the publishing. 
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• Contacts: All your Address Book contacts—including groups 

and LDAP server settings—are copied to your iDisk. The data is 

stored in Your-iDisk/Library/Application Support/ 
AddressBook/Contacts. You can view and modify these 
contacts online using the .Mac Address Book. You can also use 

them when sending email using .Mac Mail. If you set up another 

Mac to sync its contacts, your Address Book applications on each 

computer will display the same information. 

  
BUGS Apart from the fact that the .Mac Address Book displays less data 

than the Address Book application, some Address Book data is 
simply not synchronized at all. Specifically: 

• If you create more than one address or phone number with the 

same label (say, “home”), only the first one of each syncs. 

• Although a contact may have numerous email addresses and 

instant messaging user names, only the first six email addresses 

and the first three IM user names are synchronized. 

Whether these are bugs in the Address Book application, Tiger (at 

version 10.4.10 when this was written), or the .Mac Web site, I can’t 

be sure. Apple is aware of these problems, however, and I hope very 

much to see them fixed in the future. 

  
• Keychains: Mac OS X stores user names, passwords, security 

certificates, and other sensitive data in files called keychains. (If 

you have your Safari preferences set to remember user names and 

passwords used on Web forms, for instance, those passwords go 
into your keychain.) Every user has at least one keychain, but you 

may have several. By enabling the Keychains option, you can copy 

your keychains to your iDisk. Those copies (stored in Your-

iDisk/Library/Application Support/SyncServices/ 
Schemas/com.apple.Keychain) can serve as a backup; sync-

ing also makes the keychains available to other Macs you sync. You 
cannot, however, view or modify the contents of your keychain(s) 

on the Web. 

• Mail Accounts: The account settings from Mail are copied to 

your iDisk (in Your-iDisk/Library/Application Support/ 
SyncServices/Schemas/com.apple.MailAccounts). 

Whether you have one email account or dozens set up in Mail, all 

these settings (such as the server address, user name, password, 
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and other account options—though not your email messages 

themselves) are synchronized. This applies not only to your 

.Mac email account, but also to other POP, IMAP, and Exchange 

accounts, as well. By synchronizing your Mail accounts, you can 
avoid the tedium of configuring the same accounts on multiple 

Macs. However, regardless of this setting, your .Mac email account 

is the only one you can access via the .Mac Web site. 

• Mail Rules, Signatures, and Smart Mailboxes: You guessed 
it—all the rules, signatures, and smart mailboxes from Mail are 

copied to your iDisk, to Your-iDisk/Library/Application 
Support/SyncServices/Schemas/com.apple.MailConfig
uration. Syncing these files makes them available to other Macs, 

but, as with Keychains, you cannot access this data directly over 

the Web—nor does it have any effect on .Mac Mail. 

• Other data types: Other third-party applications may add 

checkboxes to the list, as well. For example, Transmit, an FTP 

client, can synchronize its data automatically via .Mac if you have 

Transmit installed and check its checkbox here. 

  
NOTE I can’t overemphasize this point: syncing your Mail accounts does 

not copy email to your iDisk (or to another Mac). It copies only 

account settings. The good thing about this is that even if you have 

many gigabytes of saved email, you needn’t worry about running 

out of space on your iDisk. But if you were expecting this feature 

to sync email between multiple computers, you’re out of luck. 

The easiest and best way to sync email across multiple computers 

is to sign up for (or switch to) an IMAP account. (As mentioned 

earlier, .Mac email accounts use IMAP by default.) With IMAP, 

you can have local copies of all your incoming, sent, and saved 
messages—but because there’s also a copy of all your email on the 

server, any changes will synchronize automatically whenever you 

connect to your IMAP email account from another client. 

If you can’t use IMAP, the only way to keep email in sync between 
computers is to copy (manually or using a synchronization utility) 

the contents of ~/Library/Mail/account-name and 

~/Library/Mail/Mailboxes from one computer to the other. 

But I should caution you that this is an error-prone process. 
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NOTE Rules and smart mailboxes may be tied to mailboxes stored on 

your Mac, or in specific IMAP accounts. If your mailbox structure 

is different from one Mac to another, some rules may not work 

correctly and some smart mailboxes may not show the contents 

you expect—even if your accounts have also been synchronized. 

  

Use the Sync Menu 

One last item on the Sync tab of .Mac System Preferences is note-
worthy: the checkbox labeled Show Status in Menu Bar. When this 

box is checked, a new icon ( ) appears in your menu bar; click it to 

display the Sync menu (Figure 17). The Sync menu gives you a one-

click method to check the date and time of your last synchronization, 

to initiate a sync immediately (handy if you’ve chosen manual synch-

ronization), or to open the Sync pane of .Mac System Preferences. 

FIGURE 17 

 

The Sync Menu shows 
when your last sync 
occurred and gives you an 
easy way to initiate syncs. 

   I should also mention a third-party menu that enhances your .Mac 

capabilities: dotMac Menu from Infinite Nexus, a free ($5 donation 

requested) utility found at http://www.infinitenexus.com/dmm/. 

Using this menu, shown in Figure 18, you can jump to a specific 

section of the .Mac Web site with a single click, check your iDisk 
usage, and more. Oddly, the dotMac Menu lacks a Sync Now 

command, so it does not entirely replace the Sync menu. 

http://www.infinitenexus.com/dmm/
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FIGURE 18 

 

The third-party dotMac Menu adds an 
even greater range of .Mac-related 
options to your menu bar.  

   

Synchronize Multiple Macs 
If you have more than one Mac—perhaps a home machine and a 

work machine or a desktop Mac and a laptop—you can use .Mac to 

synchronize information between them. 

  
TIP You can follow exactly the same procedure to synchronize data 

between users on the same Mac. I sometimes do this, for example, 

when setting up a secondary user account on one of my computers 
for testing or troubleshooting. 

  
The short version of the instructions is to turn on synchronization 

for each of the computers following the steps in Set Up Syncing, 
earlier. Apple suggests (as do I) that if you’re syncing multiple Macs, 

you should give each of them the same settings (that is, the same sync 

frequency and the same selections of data types). One exception: you 

might want to synchronize iCal calendars on just a single Mac to avoid 

multiple alarms (see the tip, later, in Understand Sync Options). 
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NOTE Keep in mind that syncing multiple Macs has nothing to do with 

iDisk syncing (see the sidebar To Sync or Not to Sync), even though 

the data that is synchronized is stored on your iDisk! 

  
When you sync a new computer (or a new user account) for the first 

time, an alert appears, similar to the one shown in Figure 19. (The 

alert may list more than one data type—or you may see multiple 

instances of this alert, depending on a number of variables.) 

FIGURE 19 

 

 

 The first time you synchronize a computer with .Mac, you must 
choose how to copy or merge the information. 

  When this alert appears, choose one of the following options from the 

pop-up menu: 

• Merge data on this computer and .Mac: This is the default 

choice; it combines any existing data of the specified type(s) 

already on this computer with the data of that type on .Mac. (Both 

this computer and .Mac will contain the merged information.) 

• Replace data on .Mac: This option erases all the information 

of the type shown on .Mac and replaces it with the information 

on this computer. Assuming you’ve already synchronized another 

computer to .Mac, this is never the choice you want for the first 
sync of an additional computer. 

• Replace data on this computer: If you have not yet entered 

any data on this computer, this choice should have exactly the 
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same effect as choosing Merge; it’s also, generally speaking, the 

safest and cleanest option when syncing a new computer with data 

already on .Mac. 

After you make your choice, click Sync to perform your first sync, or, 

to stop the entire sync, click Cancel. 

  
SIDEBAR UNREGISTER A COMPUTER 

As soon as you enter your .Mac member name and password in  

the Accounts pane of .Mac System Preferences, Apple’s servers 

register that computer as one that you can synchronize with .Mac. 

Registration enables Apple to keep track of (and report to you, on 
the Advanced pane of .Mac System Preferences) the time and date 

each of your machines last synchronized. (Registration 

undoubtedly serves other functions too, but Apple doesn’t reveal 

what those are.) 

If you decide at some point that you will no longer be synchronizing 

a computer with .Mac, you can remove it from this list. To do so, 

select its name in the list and click Unregister. After you unregister 

a computer, it will no longer synchronize with .Mac. If you later 

decide you want to synchronize that computer again, go to the 

Advanced pane of .Mac System Preferences on that machine and 
click the Register this Computer button. 

  

Adjust the Data Change Alert 
The point of syncing your computer with .Mac is to make sure that any 

information that has changed in one location changes in the other as 

well. But sometimes—due to human error or machine error, perhaps—

one side of the sync might have changed too much, so that overwriting 

the other side will result in both copies being incorrect. As a safeguard 
against such an outcome, .Mac sync includes a Data Change Alert, 

which is a window that pops up whenever the amount of information 

to be changed on your Mac is greater than a percentage you can 

specify (5% by default). That way, if you see, for example, that .Mac 

sync is about to overwrite 50% of your contacts, but you recall chang-

ing only a few, you can stop the process before any damage occurs. 

The Data Change Alert, when it appears, looks something like the 

dialog shown in Figure 20. It lists what type of data has changed 
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beyond the amount you specified, and what sorts of changes have 

occurred—that is, how many records of the type shown that will be 

added, deleted, or modified if you permit the sync to complete. 

FIGURE 20 

 

 

 This alert appears when a type of data has changed to a greater 
extent than the threshold you specified. If many unexpected changes 
are about to occur, use caution: you could inadvertently overwrite 
important data. 

  When you see this alert, click Allow to permit the changes (for this 

data type only) or Cancel Sync to cancel the entire sync. (Unfortun-

ately, .Mac sync gives you no way to cancel synching of just this one 

data type while allowing syncing of the rest; to do this, you must go 

into the Sync tab of .Mac System Preferences and deselect any data 
types you wish to exclude from a sync.) If more than one type of data 

(say, Bookmarks, Address Book contacts, and Calendars) exceeds 

your threshold, you will see more than once instance of this dialog. 

Although most of the .Mac sync settings moved into the .Mac pane 
of System Preferences in Tiger, this one little detail—changing the 

alert threshold—still requires a trip to iSync to adjust. To configure 

the Data Change Alert, follow these steps: 

1. Open iSync (in /Applications) and choose iSync > Preferences. 

2. To enable the Data Change Alert, check the Show Date Change 

Alert checkbox; to disable it completely, uncheck the box. 
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3. If you have enabled the alert, choose a threshold from the pop-up 

menu; remember that this threshold applies individually to 

records in each data type. Your choices are: 

• More than 5%, More than 25%, More than 50%: If the 

number of records that will change exceeds this percentage of 

the total records for a given data type, an alert will appear. 

• Any: An alert will appear if even a single record will change. 

4. Close iSync Preferences, and quit iSync. 

Your new settings will be used the next time you sync. 

Resolve Synchronization Conflicts 
From time to time, you may change a specific piece of information on 

both your Mac and the .Mac Web site (or another Mac you’re syncing) 

between syncs. If this happens, and the information is not exactly the 
same in both places, .Mac sync won’t know which version is correct. 

This is known as a synchronization conflict. For example, say your 

friend Chris just moved, and you updated your Address Book applica-

tion with the new address 123 N. Main Street. But you also updated 

your .Mac Address Book on the Web, and you entered the address as 

123 S. Main Street. Now, .Mac can’t figure out which one is correct. 

When such a conflict occurs, a Conflict Resolver alert appears, which 

looks something like Figure 21. You can either resolve the conflict 

immediately (by clicking Review Now) or leave the data just as it is in 

both places (by clicking Review Later). 

FIGURE 21 

 

 

 When a conflict occurs, click Review Now (preferably) or Review 
Later to resolve it. 
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If you click Review Now, the dialog expands to show you the details of 

the conflict(s), as in Figure 22. 

FIGURE 22 

 

 

 Choose which version of the data to use to resolve the conflict. 

  Select the version of the information you want to keep. If you’re sure 

that you’ll want to use the version of the information found on the 

same source—either an application on your Mac or on the .Mac Web 

site—for all the conflicts, check the Resolve All Similar Conflicts 

Using Data-Source checkbox. Click Continue; repeat, if necessary, 

for additional conflicts. 

After you’ve addressed the last conflict, another dialog appears with 

the title Save Conflict Choices. In this dialog, click Sync Now to re-

synchronize your computer with .Mac using the new information 

you’ve just provided, Sync Later to update the data during your next 
sync, or Cancel to throw out the changes and leave the information 

as it was, in both places, before the sync. 
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Reset Sync Data 
Suppose you discover one day that a great deal of your synchronized 

information has changed in one of its locations—and you didn’t want 
it to. For example, perhaps a family member unwittingly deleted 100 

important contacts from your Address Book, or you experienced some 

sort of computer problem that led to corruption in your data. You 

could go through another sync and laboriously answer all the Conflict 

Resolver inquiries, or you could simply start over again and replace 

all the data in one location with all the data in the other location. 
The latter approach is called resetting your sync data. 

When you reset your sync data, you pick a location (either your 

Mac or .Mac) to serve as the master. The next time you sync, all 

the synchronized data from the other location is deleted and then 
overwritten with the information from the chosen source location. 

Because this is such a drastic measure, you should not undertake 

it lightly (and you should always back up your data first—in both 

locations—just in case). But resetting your sync data can be a great 

time-saving tool when you really need it. 

  
WARNING! Did I mention that resetting your sync data deletes all the synch-

ronized data from the other location? I believe I did, but it never 

hurts to have another reminder. Think before you sync! 

  
To reset your data, follow these steps: 

1. Go to the Advanced pane of .Mac System Preferences. 

2. Click the Reset Sync Data button. A dialog (Figure 23) appears. 

3. From the Replace pop-up menu, choose which data you want to 

reset: All Sync Info, or just one type (say, Contacts). If you want to 

replace more than one type of data, but not everything, you’ll have 
to repeat this entire procedure multiple times, once for each type 

of data. 
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FIGURE 23 

 

 

 In this dialog, choose whether information on your Mac should 
replace the information on .Mac (as shown here), or vice-versa. 

  4. Choose which location .Mac sync should consider primary: 

• If you click the left arrow, you’ll see the animated arrow going 

from the .Mac icon on the right to the computer icon on the left. 
The text reads: Replace data-type(s) on this computer with sync 

info from .Mac. So .Mac is the master for the next sync, and all 

the data of the selected type(s) on your computer will be 

overwritten by the data from .Mac. 

• If you click the right arrow, you’ll see the animated arrow going 

from the computer icon on the left to the .Mac icon on the right. 

The text reads: Replace data-type(s) on .Mac with sync info 

from this computer. So your computer is the master for the next 

sync, and all the data of the selected type(s) on .Mac will be 

overwritten by the data from your computer. 

5. Stop for a moment, reread the text, and be sure you have chosen 

the right direction for resetting your sync data. 

6. Click Replace. An alert asks you if you’re sure this is what you 

really want to do, reminding you that it is not undoable. Spend 

a moment pondering the sense of security you have from the back-

ups you performed earlier. (You did back up your data, right? In 

both places?) Click OK. 
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A synchronization occurs immediately. When the sync is complete, 

your data will have been replaced as you specified. 

If you are syncing multiple computers to .Mac and you’ve just reset 

your .Mac sync data with the information on one of the Macs, the next 

time you synchronize one of the other computers, it will display an 

alert such as the one in Figure 24. (The exact text will depend on 

which data type(s) you’ve reset; if you reset more than one type of 

data, you’ll see multiple instances of this alert.) 

FIGURE 24 

 

 

 After resetting sync data on one computer (or on the .Mac Web 
site), this alert appears on other computers when they try to sync. 

  When this alert appears, click Replace to completely erase the data 

type specified on your Mac and replace it with the data from .Mac 

(which, in turn, should just recently have been replaced by data from 

your other Mac). Click Merge to combine the data on .Mac with the 

data on this computer—but be aware that doing so may pollute the 

data on .Mac with extra bits of stuff that had already been deleted 
on your other Mac. To stop the entire sync, click Cancel Sync. 

In addition to warnings on other computers after you reset your 

sync data, you’ll also see warnings on the .Mac Web site for each 

type of data you reset with your computer selected as the source 
(Figure 25). In other words, even though you’ve reset your sync 

data to reflect what’s currently on your Mac (and even though 

you may have successfully synchronized that data with another 

computer), you don’t necessarily see that information on the .Mac 

Web site—not until you’ve responded to these alerts.  
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For each such alert (which you’ll see the first time you access a 

particular data type over the Web), click Reset to overwrite the online 

data with the information from your Mac (equivalent to “Replace”), 

Sync to merge the two sources (equivalent to “Merge”), or Turn Off 
Syncing to leave both copies of the data separate and intact. 

FIGURE 25 

 

 

 When you reset your sync data, choosing your Mac as the authori-
tative source, you’ll see alerts like this when you next try to access 
that data on the .Mac Web site. 
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WORK WITH CONTACTS,  
CALENDARS, AND BOOKMARKS 

In addition to email, .Mac provides members with Web-based 
access to three other kinds of information: contacts from Address 

Book, bookmarks from Safari, and (to a more limited degree) calen-

dar information from iCal. This means that by synchronizing your 

information to .Mac, you can access it not only from other Macs 

you own, but also from nearly any computer in the world with an 

Internet connection and a Web browser. 

  
NOTE As much as I’d like to provide details about using Address Book, 

Safari, and iCal, that’s way beyond the scope of this book. If you 

need help learning these applications, please use the Help menu 

or go to http://www.apple.com/support/. In this section I assume 

that you have a basic understanding of how to use these programs. 

  

Address Book 

Once you’ve followed the steps in Set Up Syncing to synchronize 
your Address Book contacts with .Mac, you can not only sync those 

contacts easily to another Mac, but also view (and edit) them from 

any computer on the Internet using the .Mac Web site. Naturally, 

these contacts are also available when using the site to send email. 

Apple uses the term “Address Book” to refer to both a Mac OS X 

application and a part of the .Mac Web site, so I refer to the former 

as “the Address Book application” and the latter as “the .Mac Address 

Book” to keep them straight. 

  
NOTE You can use the .Mac Address Book to keep track of your contacts 

even if you do not use the Address Book application. 

  
To access your contacts online, follow these steps: 

1. Go to http://www.mac.com/. 

2. Click the Address Book link on the navigation bar, and log in when 

prompted to do so. 

You should see something resembling Figure 26. 

http://www.apple.com/support/
http://www.mac.com/
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FIGURE 26 

 

 

 Using the .Mac Address Book, you can view and edit your contacts on 
the Web. 

  On this page, the following options are available: 

• Display the complete record for a contact: Double-click the 
contact’s name. 

• Modify a contact’s information: Select the contact and click 

the Edit button in the toolbar. (You can also click this button when 

viewing a contact’s address record.) After making changes, click 
Save. (Note that the Edit button is not available if multiple 

contacts are selected.) 

• Display the contacts in business card format: Click the  

icon by to the word View, just below the toolbar. To revert to list 
view, click the  icon. 

• Select all the contacts currently listed: Click the All link. To 

deselect all contacts, click the None link. 

• Find contacts: Enter the text you wish to search for in the Search 

field and then press Enter or Return. 

• Delete a contact: Select the contact and click the Delete button 
in the toolbar; confirm deletion by clicking OK. 

• Add a new contact: Click the New icon in the toolbar. After 

entering the information for the new contact, click Save. 

• Send an email message to one or more contacts: Select the 

contact name(s) and then click the Email Contact button in the 

toolbar; or click any contact’s email address. The page switches to 
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.Mac Mail, with the name(s) you selected pre-entered in the To 

field of a new email message. 

• Move to the previous or next page of contacts: Click the 

 or  button, respectively. 

  
TIP If you have a large number of contacts, you may want to adjust your 

preferences to display as many as possible (up to 50) per page—see 

the next item. 

  
• Set your .Mac Address Book preferences: Click the 

Preferences link above the toolbar. (The few available preferences 

should be self-explanatory.) 

• Return to the main .Mac Address Book list after viewing a 

contact record: Click the Back to Address Book link just beneath 

the toolbar. 

Not all the info you can enter in the Address Book application 

appears in the .Mac Address Book. For example, the Notes field 

does not appear on the Web, nor do most of the optional fields you 

can enter by using the Card > Add Field submenu. (Nickname and 

Job Title are notable exceptions.) In addition, no matter how many 
addresses you’ve entered for a contact in Address Book, the .Mac 

Address Book shows only the first work and home addresses. 

Similarly, for other fields that can have many entries (such as Email, 

AIM, and Phone), the .Mac Address Book may not display all the 

entries that appear in the Address Book application. 
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SIDEBAR ADDRESS BOOK SHARING 

In addition to syncing Address Book data with your other Macs 

via .Mac and editing that data on the .Mac Web site, you can share 

your Address Book with other .Mac members—as long as they’re 
using Address Book in Mac OS X 10.4 Tiger or higher. This method 

of sharing is relatively secure, in that only those people whose 

email addresses you explicitly add can view your data. (It doesn’t, 

however, stop someone else with physical access to the other 

person’s computer from seeing the contents of your Address Book.) 

To share your Address Book with someone, follow these steps: 

1. Make sure the person is in your Address Book, and that the 

person’s contact info includes his or her Mac.com address. 

2. In the Address Book application, choose Address Book > 

Preferences and click the Sharing icon in the toolbar. 

3. Check the Share Your Address Book checkbox. 

4. Click the  button to show the contents of your Address Book. 

5. Select a name. (Shift-click to select a range of names, or 

Command-click to select noncontiguous names.) Click OK. 

6. If you want another person to be able to edit your contacts, too, 

check that person’s Allow Editing checkbox. 

The selected contact(s) can now subscribe to your Address Book. 

To make this process easier for them, click Send Invite; the contacts 

can then subscribe to your Address Book by clicking a link in the 

message they receive. Alternatively, the other member can open 
Address Book, choose File > Subscribe to Address Book, and enter 

your .Mac member name to subscribe. 

  

.Mac Bookmarks 

Another type of information that you can sync from your Mac to .Mac 

and then access (and edit) online is Safari bookmarks. As with con-

tacts in Address Book, syncing your bookmarks makes them available 

to your other computers (and to yourself) while browsing the Web—
regardless of which browser you use, and even when you are not 

using a Mac. Assuming you’ve followed the steps in Set Up Syncing 

for syncing bookmarks, no additional configuration is required. 
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TIP Even if you use only a single Mac all the time, .Mac bookmarks can 

be very helpful if you use a variety of browsers. Instead of storing 

bookmarks separately in Firefox, OmniWeb, Opera, and iCab 

(or whatever browsers you use), you can simply open your .Mac 

bookmarks in each of those browsers. You’ll get access to your 

Safari bookmarks, and any new bookmarks you add using the .Mac 
Bookmarks window will also appear in Safari (after they’ve been 

synchronized, of course). 

  
To access your bookmarks online, follow these steps: 

1. Go to http://www.mac.com/. 

2. Click the Bookmarks link on the navigation bar, and log in if 

prompted to do so. 

3. If this is your first sync of bookmarks, a message appears stating 

that your Safari bookmarks will be synchronized with your .Mac 
bookmarks. Click the Sync Now button. 

4. A welcome page appears, giving you a quick overview of how .Mac 

bookmarks behave. 

5. Click Open Bookmarks. A new window appears, similar to the one 

in Figure 27. Leave this window open while you browse the Web. 

The bookmarks window provides the following options: 

• Visit an existing bookmark: Click the bookmark (once). The 

linked page will open in a new window. 

• View the contents of a folder at the top level of your 

Bookmarks menu: Click the folder name or choose the folder 

name from the pop-up menu (officially called the Collections 

menu) at the top of the window. (Choose the All Collections item 

from this menu at any time to return to the top level.) 

• View the contents of a folder within another folder in 

your Bookmarks menu: Click the triangle ( ) by its name. 

• Add a new bookmark: Click the  button at the bottom of the 
window. Enter the name and URL for the bookmark in the fields 

that appear, choose a folder (if you wish) from the Add Bookmark 

To pop-up menu, and click Add. 

http://www.mac.com/
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FIGURE 27 

 

Use the .Mac Bookmarks 
window in any browser, on 
any platform, to keep your 
.Mac bookmarks in sync with 
Safari—regardless of which 
browser you’re using. This 
view shows a particular folder 
(or “Collection”) as viewed 
in Firefox. 

   
 

  
TIP When adding a bookmark, you can use copy-and-paste to avoid 

typing long URLs. 

  
• Delete one of the currently visible bookmarks: Click the  

button. Then click the  icon next to the bookmark or folder you 

want to remove, and confirm by clicking Delete. 

• Add a new bookmark folder: Click the  button. Type in a 

name for the new folder, choose a location from the Add Folder To 

pop-up menu, and click Add. 

• Set your .Mac bookmark preferences: Click the  button. 
(The few available preferences should be self-explanatory.) 
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• Jump to other .Mac areas (Home, Mail, Address Book) or 

to log out of .Mac: Click the appropriate icon in the toolbar at 

the top of the window. 

  
TIP BOOKMARK YOUR BOOKMARKS 

You can also jump to your .Mac bookmarks directly by going to 

http://bookmarks.mac.com/ (and logging in, if necessary). If you 

plan to use .Mac Bookmarks regularly in another browser, 

bookmark this URL in the other browser for one-click access. 

  

iCal Calendars 
On the left-hand side of the .Mac home page you see if you have 

already logged in to .Mac is a small calendar with a tiny calendar icon 

in the upper right (Figure 28). This might lead you to suspect that a 

.Mac subscription includes online access to your iCal calendars. Your 

suspicion might be reinforced when you notice that iCal offers the 

option of publishing your calendars to .Mac, and that the .Mac pane 
of System Preferences lists Calendars, along with Contacts, as items 

you can sync to .Mac. Since you can view and modify your address 

book and bookmarks online, no one would fault you for supposing 

that you could do the same with your calendars. 

FIGURE 28 

 

Think this will give you online 
access to your iCal calendars, 
which you’ve dutifully synced to 
.Mac? Think again! Clicking this 
icon takes you to a Web page that 
describes sharing iCal calendars 
using .Mac—but doesn’t actually 
show you any calendars. 

   Curiously, though, you can’t. If you look at the features Apple lists as 

being part of .Mac, you will not find online calendar access anywhere. 

You can synchronize your iCal calendars to your iDisk, and you can 

publish individual calendars to .Mac. But in neither case do you get 

http://bookmarks.mac.com/
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what Address Book gives you: a private, editable view of your data 

via the Web. For reasons only Apple knows, the interactions between 

your calendar and the .Mac Web site are oddly limited. 

I confess that I find this both puzzling and annoying. That’s not to 

say the available capabilities aren’t useful, but they’re much different 

from what you get with Address Book contacts and Safari bookmarks. 

You can do basically these two things: 

• Publish any individual calendar to .Mac, so that anyone who 

knows (or can guess) the calendar’s URL can view—but not 

modify—its contents on the Web. 

• Synchronize the contents of all your calendars with .Mac, for the 

sole purpose of keeping calendar information on multiple Macs in 

sync (covered previously in Keep Your Information in Sync). 

Publish and view calendars 

By default, any meetings, tasks, or other schedule items you enter 

in an iCal calendar are for your eyes only. However, if you have a 
particular calendar you want to share with others, you can publish 

that calendar to .Mac—or to another Web server of your choice. After 

you’ve done this, you (or anyone who knows the calendar’s address) 

can view the calendar on the Web, download it as a static .ics file 

(for import into iCal or another calendar application), or subscribe 

to it with a calendar program so that any changes you make to the 
calendar appear in the subscribing program automatically. 

Publish iCal calendars on .Mac 

When you publish a calendar, iCal stores your calendar data in an 

industry-standard iCalendar file (with the extension .ics) and copies 
that file to Apple’s iCal servers. Other users can then use iCal to read 

the contents of that file. 

To publish an iCal calendar on .Mac, follow these steps: 

1. In iCal, select a calendar or calendar group in the Calendars list. 

2. Choose Calendar > Publish. A dialog appears (Figure 29). 

3. Type in a new name for the published calendar if you wish. 
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FIGURE 29 

 

 

 Enter a name for your calendar and choose other options in this 
dialog. Click Publish to make it available to other users. 

  4. Select any, all, or none of the following options: 

• Publish Changes Automatically: If selected, iCal immedi-

ately updates the published .ics file whenever you make changes 

to the calendar on your Mac. This makes the calendar dynamic, 

and is usually desirable. 

• Publish Titles and Notes: When this box is checked (it is 

by default), each event’s title appears in the published calendar; 

any notes you’ve added appear in the window that pops up when 

you click the event title on the Web page. When unchecked, the 

calendar shows only that the time is blocked off. You cannot 

show titles but hide notes, or vice-versa. 

• Publish Alarms: To include your alarm settings for events 

in the calendar, check this box. This means that if someone 

else subscribes to this calendar in iCal, the alarms you set will 

appear on her computer too. (Usually this is not what you want, 
so the option is unchecked by default.) 

• Publish To Do Items: If selected, your published file will 

contain any To-Do items in this calendar. However, to-do items 

never appear when viewing your calendar on the Web, regard-
less of this setting; they are only visible if someone subscribes to 

your calendar using a calendar application on their computer. 

5. Click Publish. 
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A dialog appears displaying the URLs for the calendar—one for 

subscribing to the calendar from an application such as iCal, one 

for viewing the calendar using a Web browser—and offering you 

the option of viewing the page immediately or sending an email 
announcement containing the URLs. In addition, an icon ( ) appears 

next to the name of published calendars in your Calendars list. 

  
NOTE When you publish a calendar directly from iCal to .Mac, that 

calendar is not (as far as I can tell) stored on your personal iDisk. It 

is apparently stored in a public portion of Apple’s .Mac server. 

  
View .Mac-published iCal calendars on the Web 

Your published calendar’s address will be http://ical.mac.com/ 

member-name/calendar-name.ics; any spaces in the calendar name 
are replaced with “%20”. To view your calendar on the Web, enter 

that URL (the same one shown in the confirmation dialog) in any 

Web browser. Your calendar will look like the one in Figure 30. 

The following options are available: 

• Click the Day, Week, or Month button (at the top of the page) to 

change the overall calendar view to that time range. 

• Click Previous ( ) or Next ( ) to move backward or forward by 

one day, week, or month (depending on the current view). 

• Click the Today button to jump to the time period (as appropriate 

for the current view) that includes today. 

• Click an event’s title in the calendar to display its details (including 

any notes, if published) in a pop-up window. 

• Click a date on one of the mini-month calendars on the left to 
display that dates’ events in Day view; click the arrow ( ) next to 

a week to display that week in Week view; click a month name to 

display that month in Month view. 

• Click the up ( ) or down ( ) arrows above the mini-

months to move the mini-month display forward or backward one 

month; click the diamond ( ) to return to the default view 

(the previous month, the current month, and the next two months). 

• To subscribe to this calendar in iCal (or another application you’ve 
configured to open webcal URLs—Now Up-to-Date, for example), 

click Subscribe. 
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• To download a static .ics file of the calendar, click Download. 

• To configure default calendar options for the Web interface, click 

Preferences. (The options here are self-explanatory.) 

FIGURE 30 

 

 

 When you view your published iCal calendar on the Web, it looks 
something like this. (Month view shown here.) 

  
 



Page 79 

  
NOTE Not to beat a dead horse, but remember: you can only view, not 

modify, your iCal calendars on the Web. 

   

  
WARNING! Unlike email, address book, backups, and other files, calendar files 

published on .Mac aren’t protected with a password. Anyone who 
knows, or can guess, the name of a calendar file can see its contents. 

The info is protected only by obscurity. Obviously, if you’re publish-

ing a calendar that you want the public to see, this is no problem, 

but if you have confidential items in a personal calendar, you might 

want to think twice before publishing it on .Mac. 

You can publish iCal calendars securely to a password-protected 

folder on your iDisk (your Documents folder or your Public folder, 

for instance) by using the Private Server option (described below 

in “Publish iCal calendars using WebDAV”) and entering 

http://idisk.mac.com/member-name/some-folder-name 
as the Base URL. A problem with this approach is that although 

you can download or subscribe to such calendars in iCal or other 

calendar software, you can’t view their contents on the Web. 

Unfortunately, I know of no way around this; Apple provides no 
secure means of viewing calendar contents via the Web. 

  
Publish iCal calendars using WebDAV 

You can also publish an iCal calendar to a Web server other than 

.Mac—if, and only if: 

• The server supports WebDAV. 

• You have a valid user name and password for the server. 

• You have write access to the WebDAV directory in which you want 

to place the file. 

If this is the case, follow Steps 1–4 previously under Publish iCal 

calendars on .Mac, but from the Publish On pop-up menu, choose A 

Private Server. Three new fields appear, which you must now fill in: 

• Base URL: The URL for the folder on the WebDAV server you 

want to use. It must begin with either “http:” or “https:”. 

• Login: Your user name for the WebDAV server. 

• Password: Your password for the WebDAV server. 
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After filling in this info, click Publish. iCal uploads the .ics file 

representing your calendar information to your selected location, 

from which it can then be downloaded. 

Subscribe to a published calendar using iCal 

To subscribe to a published calendar (someone else’s, or your own 

published from another computer) using iCal, follow these steps: 

1. Choose Calendar > Subscribe. 

2. Enter the calendar’s URL (it normally begins with “webcal://”).  

3. Click Subscribe. If the calendar is located in a password-protected 

folder, another dialog appears, prompting you to enter a user 
name and password. Enter this information and click OK. 

After the calendar has been added to iCal, its name appears in your 

Calendars list. If you wish to change the color used for the calendar’s 

events, select the calendar and choose a new color from the pop-up 
menu by its name in iCal’s Info drawer. To update a calendar to which 

you’ve subscribed so that it displays the latest information, select it 

and choose Calendar > Refresh (Command-R). 

Update a published calendar 

When you change your local copy of an iCal calendar, you may want 

to update the published copies of the calendar as well. If you enabled 
the Publish Changes Automatically option when you published the 

calendar, iCal uploads the changes soon after they’re made—but not 

necessarily immediately thereafter. And if you did not select that 

option, you must update the online copy manually. Either way, to 

update the published copy immediately, select the calendar name in 

the Calendars list and choose Calendar > Refresh (Command-R). To 
update all your published calendars—as well as those to which you’ve 

subscribed—choose Calendar > Refresh All (Command-Shift-R). 

Unpublish a calendar 

To unpublish a published calendar file (regardless of whether you 

published it to .Mac or to another server), select the calendar in the 

Calendars list and choose Calendar > Unpublish. This will make the 
calendar data unavailable to new subscribers and prevent existing 

subscribers from updating their copies—but it does not automatically 

remove subscribers’ existing local copies of the calendar. 
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STORE AND SHARE FILES WITH iDISK 

iDisk is without a doubt one of the most useful—and most visible— 

features of .Mac. An iDisk is like an extra hard drive that provides 

10 GB1 of storage for your files (2.5 GB for Family Pack sub-account 

holders), but this virtual drive is actually located on Apple’s servers. 

You can use it to store anything you want, and you can access it from 
nearly any computer on the Internet. By putting items in your iDisk’s 

Public folder, you can also make those items available to others (with 

optional password protection). 

That said, depending on how you look at it, you have much more or 
much less than 10 GB of space on your iDisk. Apple makes numerous 

software updates and third-party downloads available via iDisk, and 

these packages do not count toward your 10 GB limit. On the other 

hand, all of the following things, if you use them, do count toward 

that limit: 

• Files you store using Apple’s Backup utility 

• Data you sync using .Mac Sync, such as contacts, bookmarks, your 

keychain, and data from third-party applications 

• Mail rules, signatures, smart mailboxes, and accounts you 

synchronize using .Mac Sync 

• Web sites, photos, movies, podcasts, and other media you publish 

using iWeb or HomePage 

• Space allocated to .Mac Groups (at least 30 MB per group you 

own) 

• Manually uploaded files 

In addition, because you share that 10 GB between your .Mac email 
account and your iDisk, whatever amount of space you’ve designated 

for email storage (see Divide space between files and email) is sub-

tracted from the total available for other files. (You cannot allocate 

less than 30 MB to email or less than 10 MB to iDisk.) 

                                            

1 Actually, you get 10,240 MB, which is technically 10 gibibytes. A gigabyte is a 

billion bytes; a gibibyte is approximately 1.07 billion bytes. 
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All this means you can quickly fill up your iDisk. Even if you purchase 

extra space (see Buy more space), you may find that it’s too little; all 

those files—especially digital media—can take up a huge amount of 

space. In addition, iDisk access is often slow (even as network servers 
go), making it less than ideal for transferring large amounts of data. 

These can be serious limitations, but if you understand iDisk’s 

capabilities and quirks, you’ll be able to make the most of this 

valuable feature. 

The key to effective iDisk use is to concentrate on its strengths. In a 

nutshell, its optimal uses are: 

• Providing remote access to important files; use your iDisk instead 

of a USB flash drive or burning a CD to make files available to 

yourself when you move from one location to another. 

• Synchronizing information between two or more Macs (or making 
that information available via the Web). 

• Publishing simple Web sites, such as photo albums for family 

members. 

• Transferring large files (larger than what .Mac’s mail servers, or 

your recipient’s email servers, support but less than your iDisk’s 

space limit) to other people. 

• Providing a secondary offsite backup for key files. 

These are my opinions, of course; your mileage may vary. But keep 

these ideas in mind as you read more about iDisk’s features. 

Explore Your iDisk 
In Mac OS X, your iDisk appears by default in the sidebar of any 

Finder window (Figure 31) and, optionally, on your Desktop as well; 

you can see its contents simply by clicking (in the sidebar) or double-

clicking (in the Finder) the iDisk icon. (For other ways to access your 

iDisk, read Access an iDisk, ahead.) 
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FIGURE 31 

 

 

 Click the iDisk icon in a Finder window sidebar to see its contents. 

  Your iDisk looks like any other volume, but its contents act a bit 
differently. Inside your iDisk, you’ll find Read-only folders (which 

I describe next, along with their contents) and a few special Read-

write folders. 

  
NOTE When an iDisk icon appears in the sidebar, it has the label “iDisk” 

(unless it’s another user’s iDisk or Public folder). When an iDisk 

icon appears on the Desktop, its label is the .Mac member name 
of the iDisk’s owner. 

  
Read-only folders 

Two of the folders are read-only; you can see, open, and copy items 
from them, but cannot change the folders or their contents manually: 

• Library: Files used when synchronizing data from applications 

such as Address Book, Safari, and Mail. 

• Software: Apple and third-party software that you can download 

to your hard disk simply by dragging and dropping. Software in 

this folder does not count toward your iDisk quota. (For more 

details, read the sidebar, “The Software Folder,” just ahead.) 
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SIDEBAR THE SOFTWARE FOLDER 

A few years ago, the iDisk Software folder was chock full of free 

software, including games, utilities, Apple updaters, media files, 

and much more. These days, since most people get their software 
over the Web (and their Apple software updates via Software 

Update), this distribution method has become much less popular, 

and the selection of software available has decreased accordingly. 

All these items are also, I should mention, available on Apple’s Web 

site. However, although you need not ever look inside this folder, 

you might find it interesting to check every so often to see if any-
thing new and useful has appeared. 

The following list represents the software available in the Software 

folder at the time this was written: 

• Backup 

• GarageBand JamPacks (free samples taken from the full 

commercial versions) 

• iDisk Utility for both Mac OS X and Windows (not applicable to 

Tiger, which includes this function) 

• Mac Slides Publisher 

At one time, Apple provided many third-party software updates via 
the iDisk’s Software folder, but getting updates on iDisk was a bit 

of a hassle for developers, and users overwhelmingly preferred to 

get updates via the Web or applications’ built-in software update 

features. So third-party updates no longer appear on iDisk. 

  
Read-write folders 

You can write to, read from, or delete items from the other folders 

(though, in general, you shouldn’t delete items you didn’t place there 

yourself): 

• Backup: Files copied to your iDisk by Apple’s Backup utility. 

(If you haven’t used Backup, this folder may be empty.) Prior to 

the release of Backup 3, this folder could only modified only by 

Backup.  
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WARNING! Even though you can delete your Backup folder or its contents, 

don’t. If you need to free up space in this folder, open Backup and 

choose Backup > Remove iDisk Backups. Then, for safety, 

immediately run a new backup. 

  
• Documents: Any files you copy manually to this folder. No other 

user can read these files (without your password, that is). 

• Groups: This folder contains a subfolder for each group of which 

you are a member or owner. Within each group folder is another 

set of folders (Documents, Library, Movies, Pictures, Public, Sites), 

each of which mirrors the function of the folders at the top level 

of your iDisk. The Public folder in each group folder contains files 

accessible by any group member. 

• Movies: Can contain any file type, but intended mainly for 

QuickTime movies, which can then be published on your Web site 

using HomePage. 

• Music: Like the Movies folder, this folder can contain any file, 

but is (apparently) designed mainly to hold music and playlist 

files. However, its specific purpose is a bit of a mystery, since 

iTunes does not use it—and since music files can just as easily 

be copied to other folders (including Documents and Sites). 

• Pictures: Once again, this folder can contain anything, but it 

is intended to hold graphics (in JPEG or GIF format), which then 

become available to both HomePage and iCard. When you publish 

photos from iPhoto, the images go here. 

  
WARNING! Apple’s tools (including HomePage and iPhoto) sometimes create 

subfolders within these folders to help organize your content. If you 

rename, move, or delete these subfolders (or the files within them), 

your Web site could break. 

  
• Public: Files and folders you want to share with other people. 

Others can access these files using the Mac OS X Finder, Windows, 

or a WebDAV client; you can also make these files available via the 

Web using HomePage. In addition, you can protect this folder with 

a password; see Protect your Public folder with a password. 
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• Sites: Web pages created with HomePage and related files, or 

Web pages you’ve created in another application and copied here 

in order to publish them on the Web. By default, items you put 

in this folder become available at http://homepage.mac.com/ 
member-name/, but you can protect individual folders with a 

password; you can find out how in Protect a site with a password. 

• Shared: This folder appears only if you have a Family Pack 

account. Files in this folder can be shared among all the accounts 
within the Family Pack—it’s basically a Public folder with access 

limited to Family Pack members. Files in this folder count only 

toward the storage quota of the master account. 

• Web: Web pages created with iWeb (including pages with photo 
or movie content from iPhoto or iMovie) and related files. Sites you 

create with iWeb are available by default at http://web.mac.com/ 

member-name/, but you can protect the site with a password; see 

Protect an iWeb site with a password. 

  
NOTE You cannot delete or rename any of the standard folders at the top 

level of your iDisk, even though you may be able to modify the files 
within them. 

  

Share Files 
Although many people use their iDisk for backups or for remote 

access to their own files, you can also use your iDisk to share files 

with friends, family, or the general public. Apart from files shown 

on Web pages (including pictures and movies), the ideal way to 

accomplish this is to use your iDisk’s Public folder. Simply copy 
a file to this folder to share it with others. Once you’ve done so, 

you have a number of options for how people access those files. 

 

 

 
NOTE If you keep a local copy of your iDisk (refer to the sidebar To Sync 

or Not to Sync), files you copy to your iDisk may not be available to 

other users immediately; they’ll be uploaded during the next sched-

uled sync. To force your iDisk to sync immediately, select the iDisk 
icon in the sidebar and either click the Sync icon ( ) next to it or 

choose Sync Now from the Action menu ( ) in the toolbar. 
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Protect your Public folder with a password 

By default, any file you place in your Public folder is freely available 

to anyone who knows your .Mac member name (see Access an iDisk, 

ahead). However, you can restrict access to this folder to people who 

know a password (separate from your own .Mac password) you 

specify. To protect your Public folder with a password: 

1. Go to the iDisk tab of .Mac System Preferences, and check the 

Password Protect Your Public Folder box (Figure 32). 

FIGURE 32 

 

 

 Check the box at the bottom of this pane to protect your Public 
folder with a password. 

  A dialog appears where you can enter (and confirm) a password. 

2. In Tiger, you can click the key-shaped icon to open the Password 

Assistant, which helps you to select a secure yet memorable 
password. 
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3. To change the password, click the Set Password button, and enter 

the new password. (Disabling and then re-enabling the password 

protection option will also prompt you for a new password.) 

You can remove password protection from your Public folder at any 

time by returning here and unchecking the Password Protect Your 

Public Folder checkbox. 

Enable or disable write access 

Although other users can see and download files in your Public folder, 
by default, they cannot add or remove files. In other words, your 

Public folder is normally read-only. You can optionally change it to 

have read-write access, meaning that someone else can give you a file 

by putting it in your Public folder (and can delete files already there). 

To toggle between read-only and read-write access, select the Read 

Only or Read & Write radio button, respectively, on the iDisk tab of 

.Mac System Preferences. This change takes place immediately. 

If you do enable write access, remember that files other people copy 
to your iDisk count against your quota. I therefore suggest checking 

your Public folder periodically and removing files you no longer need. 

Make public files available on the Web 

To make it even easier for others to access files in your Public folder, 

tell them to visit http://idisk.mac.com/membername-Public. That 

URL displays a Web page that provides download links for each item 
in your Public folder. 
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SIDEBAR STORING IMAGES FOR EBAY 

People who frequently sell merchandise on eBay need a convenient 

online location for storing product images that can be displayed in 

eBay listings. (eBay will host images, but places limits on the number 
and size of photos and charges additional fees for more than one 

photo. These limits and charges do not apply when the photos are 

hosted on another site and you supply HTML-formatted image tags.) 

This is a perfect job for your iDisk. Just place the images you want 

to use in your iDisk’s Sites folder (or in a subfolder stored there); 

the URL for an image then becomes: 

http://homepage.mac.com/member-name/image-name  

or  

http://homepage.mac.com/member-name/folder/image-name 

To make the process easier—and automate much more of the eBay 
listing procedure—try iSale ($40) or GarageSale ($25), two Desk-

top programs that integrate seamlessly with both iPhoto and your 

iDisk. With these programs, you can take product photos using 

your iSight camera and include Tiger-specific enhancements such 

as Spotlight searches, Dashboard widgets, and Automator actions. 

http://www.equinux.com/us/products/isale/ 

http://www.iwascoding.com/GarageSale/ 

   

http://www.iwascoding.com/GarageSale/
http://www.equinux.com/us/products/isale/
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SIDEBAR TO SYNC OR NOT TO SYNC? 

You configure iDisk syncing in .Mac System Preferences, on the 

iDisk tab. It’s off by default; to turn it on, click the Start button. 

If iDisk syncing is off, then your iDisk is always live; when you view 

its contents, you see exactly what’s on Apple’s servers. This means 

that if you edit a file from your iDisk, changes are saved to the server 

immediately. But it also means you may have to wait longer than 

usual for the file to open or save—and if you aren’t connected to the 
Internet, that file will be unavailable (unless you have a local copy). 

If iDisk syncing is on, Mac OS X creates a hidden disk image on 

your Mac that’s the same size as your iDisk and fills it with whatever 

files are currently on your iDisk. So what you see when you look in 
your iDisk is the contents of this disk image—not necessarily what’s 

on the server. (This applies only to your personal files; Apple and 

third-party software is never copied to the local disk, and is avail-

able only if you’re connected to the Internet.) Mac OS X then syncs 

the contents of this local iDisk image with the contents of the actual 

iDisk on the .Mac servers. Syncing is useful for accessing files on 
your iDisk if your Mac is often without Internet access. You can 

decide if this syncing occurs automatically (the default) or manually. 

If you select Automatically (Apple’s suggestion), Mac OS X copies 

new or changed files to (or from) the server whenever the system 
deems it necessary, assuming your Internet connection is active 

and your Mac isn’t busy doing other things. But how often, or 

under what circumstances, syncing occurs is a mystery—Apple 

doesn’t say, and significant time may pass without an update. 

(When you select the iDisk icon in the sidebar, the time of the last 

sync appears at the bottom of the window.) However, you can sync 
the files manually at any time using the procedure described in the 

next paragraph. 

If you select Manually, iDisk files sync only when you explicitly 

initiate the process. To sync manually, either click the Sync button 
( ) by the iDisk icon in the sidebar or select the iDisk icon and 

choose Sync Now from the Action menu ( ) in the toolbar. 

Finally, if you use iDisk syncing and connect to the Internet with 

an AirPort base station, you may be able to increase syncing 
speeds; http://docs.info.apple.com/article.html?artnum=302510 

has details. 

http://docs.info.apple.com/article.html?artnum=302510
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Access an iDisk 

You can connect to your iDisk—or someone else’s—in any of several 

ways. Which you choose depends on your needs, preferences, and the 
type of computer you’re using. Here’s where to find the right info for 

your computer: 

• Via the Web and a Mac (with Safari 2.0.2 or newer, or Firefox 

1.0.4 or newer): Later on this page. 

• Via the Web and Windows (with Firefox 1.0.4 or newer, or 

Internet Explorer 6 or newer): Later on this page. 

• Mac OS X: Read Connect using Mac OS X. 

• Mac OS 9: Read Connect using a WebDAV client. 

• Windows: Find directions for several Windows versions in 

Connect using Windows. 

Connect using a Web browser 

To access an iDisk using a Web browser, follow these steps: 

1. Go to http://www.mac.com/ and log in. 

2. Click the  icon next to the iDisk heading on the sidebar of the 

.Mac home page. A new browser window opens. 

3. If a dialog appears, prompting you for a user name and password, 

enter your .Mac ID (the part before “@mac.com”) in the Username 

field and your password in the Password field. Then click OK. 

Your browser window should now look like Figure 33. You can 

navigate this window just like a Finder window in List view: click 

the triangle by a folder name to reveal its contents, or double-click 

it to show only that folder’s contents in the window. 

4. To upload a file to the current folder, click the Upload button, 

select a file, and click Choose. To download a file, click the  icon 

in the rightmost column for that file; to delete a file, select it and 

click the  icon. 

http://www.mac.com/
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FIGURE 33 

 

 

 As long as you’re using a compatible browser, you can access 
your iDisk from nearly any computer. 

  
 

  
NOTE You can use browser-based access to connect to any iDisk for 

which you know the user name and password, but you can’t access 

another user’s Public folder from a browser. To access a Public fol-

der, follow the steps ahead for the operating system you’re using. 

  
Connect using Mac OS X 

Ordinarily, if you’re using Mac OS X you don’t have to do anything 
at all to connect to your own iDisk—as long as you have an Internet 

connection, Mac OS X automatically connects to your iDisk when you 

access it. You can display the contents of your iDisk by clicking the 

iDisk icon in Finder window sidebars, by choosing Go > iDisk > My 

iDisk, or by pressing Command-Shift-I in the Finder. 
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Connect to another user’s iDisk 

At times, you may wish to retrieve personal files from your iDisk 

while using someone else’s computer, or someone using your 

computer may wish to connect to their own iDisk. To access an iDisk 
other than the one specified in .Mac System Preferences: 

1. Choose Go > iDisk > Other User’s iDisk. 

2. Enter the user’s member name and password and click Connect. 

The other user’s iDisk appears in the sidebar of Finder windows, and 

a window displays its contents. 

Connect to another user’s Public folder 

To access only the Public folder of another user’s iDisk: 

1. Choose Go > iDisk > Other User’s Public Folder. 

2. Enter the member name for the other user and click Connect. If 

the user’s Public folder is password-protected, you’ll be asked to 

provide that password. 

The other user’s iDisk appears in the sidebar, and a window displays 

the contents of its Public folder. 

Once an iDisk is visible in the Finder, you can copy, add, or remove 
files (subject to the limitations of individual folders) using drag-and-

drop or copy-and-paste, just as you would for any other volume. 

Troubleshoot connection problems 

If you cannot connect to your iDisk: 

• Check to see that your Internet connection is active (by viewing a 

Web page in your browser, for example). 

• Make sure you have correctly entered your member name and 

password in the Account tab of .Mac System Preferences. 

• Verify that your .Mac subscription has not expired. 

If you can connect to your iDisk but do not see the iDisk icon in the 

sidebar of Finder windows: 

• Be sure your sidebar is visible. If it isn’t, move your pointer to the 
left edge of a Finder window; the pointer will change to a  shape. 

Then double-click to display the sidebar. 
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• If the sidebar is visible, you’re connected to the Internet, and your 

.Mac preferences are specified correctly, you may have inadvert-

ently removed the iDisk icon from your sidebar. To restore it, 

follow these steps: 

1. Choose Finder > Preferences. 

2. Click the Sidebar icon at the top of the window. 

3. Check the iDisk checkbox (Figure 34). 

FIGURE 34 

 

Check the iDisk check-
box in this window to 
ensure that your iDisk 
appears in the sidebar 
of Finder windows. 

   If your iDisk icon does not appear on the Desktop, and you want it to, 

follow these steps: 

1. In the Finder, choose Finder > Preferences. 

2. Click the General icon at the top of the window. 

3. Check the Connected Servers checkbox. 

Note that this will cause icons for all connected servers to appear on 

the Desktop. 
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NOTE iDISK UTILITY ON MAC OS X 

Apple still distributes a Mac OS X version of the iDisk Utility, but 

they don’t specify who needs it or why. Let me clear that up. The 

iDisk Utility provides the following capabilities: 

• Connect to any iDisk with a member name and password. 

• Connect to any member’s Public folder. 

• Set, change, or remove a password for accessing your Public 

folder. 

• Toggle your Public folder between read-only and read-write 

access. 

• Check the available storage space on your iDisk. 

You can do these things in the .Mac pane of System Preferences 

in Tiger (Mac OS X 10.4) or Panther (10.3) or in the Internet 

pane of System Preferences in Jaguar (10.2). So the iDisk utility 

is necessary only for people using Mac OS X 10.0.x or 10.1.x. 

If you’re one of those (very few) people, it’s time to upgrade! 

  
Connect using Windows 

Using a computer running Windows 98 or higher, you can access 
an iDisk in any of several ways. For users of Windows XP or higher, 

the easiest solution is to download and use iDisk Utility for Windows. 

On older versions of Windows (or if the iDisk Utility does not work 

for any reason), you can manually add an iDisk to your list of avail-

able network places or use a WebDAV client (see Connect using a 

WebDAV client, a few pages ahead.) 

Use iDisk Utility to access an iDisk (your own or someone 

else’s): 

1. Go to http://www.mac.com/1/idiskutility_download.html. Follow 

the instructions on that page to download and install iDisk Utility 

for Windows XP. 

2. To access an iDisk for which you know the password, run iDisk 

Utility, click the Open iDisk icon, enter the member name and 

password, and click Open. To open a user’s Public folder, click 

Open Public Folder icon, enter the user’s member name, and click 

Open. 

A window appears, showing the contents of the selected iDisk. 

http://www.mac.com/1/idiskutility_download.html
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Use Windows XP or higher  

(without iDisk Utility) to access an iDisk: 

1. Choose Start > My Network Places. 

2. On the left side of the window, in the Network Tasks list, click the 

Add a Network Place link to run the Add Network Place wizard. 

3. Advance through the wizard until you reach a screen asking you 

to type the location of the network place. You may need to move 

through a welcome screen, and you may need to indicate that you 

want to choose another network location. 

4. In the field labeled “Type the location of the Network Place,” enter 

http://idisk.mac.com/member-name (replace member-

name with the .Mac member name of the person whose iDisk 

you’re trying to use). Click Next. 

  
NOTE These instructions assume you’re accessing your own iDisk, or 

someone else’s whose password you know. To access a user’s Public 

folder, add /Public to the end of the URL in Step 4. If the folder is 

not password-protected, skip Step 5. 

  
5. When prompted, enter the appropriate .Mac member name and 

password. Click OK. 

6. Enter a name for the network place, such as My iDisk. Click 

Next. 

7. In the final screen of the wizard, you should see confirmation that 

you’ve successfully set up a new network place. Click Finish. 

A window appears, showing the contents of the selected iDisk. In 

addition, the iDisk icon is added to your list of network places, so you 

can reconnect at any time by double-clicking that icon. 

Use Windows 2000 to access an iDisk: 

1. Choose Start > My Computer. 

2. Choose Tools > Map Network Drive. 

3. Click the link labeled “Web folder or FTP site.” The Add Network 
Place Wizard runs. 
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4. In the field labeled “Type the location of the Network Place,” enter: 

http://idisk.mac.com/member-name (replace member-

name with the .Mac member name of the person whose iDisk 

you’re trying to use). Click Next. 

  
NOTE These instructions assume you’re accessing your own iDisk, or 

someone else’s whose password you know. To access to a user’s 

Public folder, add /Public to the end of the URL in Step 4. If the 

folder is not password-protected, skip Step 5. 

  
5. When prompted, enter the appropriate .Mac member name and 

password. Click OK. 

6. Enter a name for the network place, such as “My iDisk.” Click 

Finish. 

A window appears, showing the contents of the selected iDisk. In 

addition, the iDisk icon is added to your list of network places, so you 
can reconnect at any time by double-clicking that icon. 

Use Windows 98, without iDisk Utility, to access an iDisk: 

1. Choose Start > My Computer. 

2. Double-click the Web Folders icon. 

3. Double-click Add Web Folder. 

4. In the field labeled “Type the location to add,” enter: 

http://idisk.mac.com/member-name (replace member-
name with the .Mac member name of the person whose iDisk 

you’re trying to use). Click Next. 

  
NOTE These instructions assume you’re accessing your own iDisk, or 

someone else’s whose password you know. To access to a user’s 

Public folder, add /Public to the URL in Step 4, and skip Step 5. 

  
5. When prompted, enter the appropriate .Mac member name and 

password. Click OK. 

6. Enter a name for the network place, such as “My iDisk.” Click 

Finish. 
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A window appears, showing the contents of the selected iDisk. In 

addition, the iDisk icon is added to your list of network places, so you 

can reconnect at any time by double-clicking that icon. 

Connect using a WebDAV client 

Unbeknownst to most .Mac members, iDisk uses a method of file 

transfer called WebDAV, which stands for Web-based Distributed 

Authoring and Versioning. To oversimplify somewhat, think of Web-

DAV as a two-way version of HTTP, the protocol for communication 

between Web servers and Web browsers. Why should you care? Well, 

one implication of this is that you can use other programs, besides the 
Finder, iDisk Utility, or Windows, to access files on your iDisk. Some 

of these programs provide faster access, some provide more features, 

and some work on platforms where your iDisk would otherwise be 

inaccessible—such as Mac OS 9, Windows 95, and Linux. 

The following is a small sampling of WebDAV clients: 

• Goliath: Versions available for Mac OS 8 & 9 and Mac OS X 

(http://www.webdav.org/goliath/, free). 

• Transmit: Runs on Mac OS X; also supports FTP and SFTP 

(http://www.panic.com/transmit/, $30). 

• DAV Explorer: A Java-based WebDAV client that runs on almost 
any operating system. (http://www.ics.uci.edu/%7Ewebdav/, free) 

• BitKinex: A commercial FTP and WebDAV client for Windows 

(http://www.bitkinex.com/webdavclient.php, $39). 

• cadaver: Command-line WebDAV client that runs on most 

versions of Unix (including Mac OS X) 

(http://www.webdav.org/cadaver/, free). 

• davfs: A Linux file system driver that enables WebDAV volumes 

to be mounted as local drives (http://dav.sourceforge.net/, free). 

To access your iDisk with any of these programs, simply enter 

homepage.mac.com/member-name (replacing member-name with 
your member name) as the location you wish to access and, if the 

program supports multiple protocols, specify WebDAV. 

 

http://dav.sourceforge.net/
http://www.webdav.org/goliath/
http://www.panic.com/transmit/
http://www.ics.uci.edu/%7Ewebdav/
http://www.bitkinex.com/webdavclient.php
http://www.webdav.org/cadaver/
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NOTE Just as HTTP comes in plain and secure (HTTPS) varieties, so 

does WebDAV. However, .Mac does not support WebDAV HTTPS. 

This means that all communication between your computer and 

your iDisk on Apple’s servers (whether using the Mac OS X Finder, 

Windows, or a WebDAV client) is unencrypted. In theory, a hacker 

could intercept these network transmissions and thus obtain the 
files you upload or download. Worse, a hacker could obtain your 

.Mac password (which is sent in the clear), thus gaining access to 

not only your files but your .Mac email. For this reason, you should 

be circumspect about accessing your iDisk using an unencrypted 

wireless network or any other public network or computer. 

  
Understand data transfer limits 

Many Web hosting companies place a limit on the amount of data 

that can be transferred from each member’s site per month. This 
prevents a few extremely busy sites from overwhelming a server—

thus reducing performance for everyone who uses it, and it limits 

the cost of the company’s Internet connection (the higher the capacity 

needed, the more the connection costs).  

Your .Mac account, too, has data transfer limits. Basic .Mac accounts 

have a limit of 100 GB of data transfer per month; by buying more 

storage (for $50 or $100 per year), you can increase that limit to 

either 200 GB or 300 GB per month (see Buy more space, ahead). 

Even the standard limit of 100 GB should provide more than 

adequate data transfer capabilities for most people. But if you get 

close to maxing out your monthly data transfer limit, Apple will send 

you an email message inviting you to buy more storage. If you choose 

not to—or if you’ve already purchased the maximum amount—Apple 

disables access to your Web site(s) and any other data on your iDisk 
until the beginning of the next bimonthly2 monitoring period. 

 

                                            

2 Apple uses the term “bimonthly” to mean twice a month, not every two months. 
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NOTE Apple calculates your data transfer usage in a surprising way. 

Although a standard membership includes 100 GB of data transfer 

per month, what that really means is 50 GB every half month. So 

if you use up 50 GB in the first week of a month, Apple disables 

iDisk access until the 16th (their date for starting the second half of 

any month for monitoring purposes). Then you get another 50 GB 
for the second half of the month. 

  
Determining how much of the monthly data transfer quota you’re 
using can be tricky. For example, if you put a 10 MB file on your 

iDisk, you can’t tell if it has been downloaded once or a thousand 

times. Luckily, Apple now provides an easy (if somewhat obscure) 

way to check your data transfer usage.  

To check your current data transfer statistics, follow these steps: 

1. Go to http://www.mac.com/ and log in. 

2. Click your member name on the navigation bar or the Account 

link on the left side of the window and (if prompted to do so) enter 

your member name and password again. The Account Settings 

page appears. 

3. The last item listed under Storage is “Data Transfer/month.” 

Click the Details link that appears on this line immediately after 

the number of gigabytes (Figure 35). 

 

http://www.mac.com/
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FIGURE 35 

 

 

 

 Click the Details link on the Account Settings page (circled, at top) 
to see your data transfer history—including usage for the current 
half-month (bottom). 

  The Data Transfer History page appears, giving you the infor-

mation you need to determine your current monthly usage: 

• The paragraph at the top of the page tells you how much data 

has been transferred so far during the current half of the month. 

Remember that the bimonthly limit is half of your monthly limit. 

• The table lists a series of dates and amounts used in previous 

months. What this means is that during the month preceding 

a given date, you transferred the amount of data shown in the 
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second column. So the figure for “01/2007” is the amount 

of data transferred in December 2006. 

Most of us will never even come close to exceeding Apple’s limits—for 

that to happen, you must have either an extraordinarily popular site 

or some very large files (or both). To give you an idea of what I mean, 

here are some examples of what you can transfer with the standard 

100 GB monthly limit: 

• 10,000,000 text-only Web pages (10 KB each) 

• 1,000,000 low-res digital photos (100 KB each) 

• 100,000 high-res photos or short podcasts (1 MB each) 

• 10,000 short movies or long podcasts (10 MB each) 

In short, the data transfer limits are entirely reasonable for most 

individuals sharing information with family and friends. If you do 

find yourself exceeding these limits, though—or if you use a great deal 

of bandwidth sharing files, restoring backups, or performing synch-

ronizations—see Buy more space, ahead, to learn about increasing 
your data transfer limit. 

  
NOTE In calculating data transfer usage, Apple counts only outbound 

traffic from your iDisk (which includes Web access, downloading 

files from the iDisk via the Finder or WebDAV, and other kinds of 

remote access). Uploading files to your own Web site doesn’t count, 

but each time someone downloads one of those files, that data 
transfer does count. 

  
Divide space between files and email 

Your .Mac account comes with 10 GB of storage space, but not all that 

space is available for use by your iDisk. Apple allocates a portion of 

the space to storing your Mac.com email; your iDisk gets the rest. By 

default, the 10 GB is divided evenly: 5 GB each for email and iDisk. 

(For each .Mac group you own, Apple subtracts at least 30 MB from 

your iDisk quota.) But you can adjust this setting to meet your needs—
depending on the volume of email you store on the server and the 

space you wish to use for storing and sharing files. 



Page 103 

  
NOTE The 10 GB figure applies only to standard individual accounts. 

If you’re using a free .Mac trial membership, you get 100 MB 

of storage. If you have a .Mac Family Pack, the primary member 

gets 10 GB while each sub-account gets 2.5 GB. 

  
To change the allocation of your storage space, follow these steps: 

1. Go to http://www.mac.com/ and log in. 

2. Click your member name on the navigation bar or the Account link 

on the left side of the window and (if prompted to do so) enter 

your member name and password again. 

3. Click the Storage Settings button to open the Storage Settings page 

(Figure 36). 

FIGURE 36 

 

 

 Use these pop-up menus to divide your .Mac storage space between 
email and iDisk. 

  

http://www.mac.com/
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4. Choose a new setting from the .Mac Mail pop-up menu. If you own 

one or more groups, you can also specify how much space is used 

for iDisk and message storage for each group. .Mac automatically 

assigns the rest of your available space to your iDisk. (The minimum 
you can allot to .Mac Mail, a group iDisk, or a group’s messages, is 

15 MB.) When you’re finished, click Save. 

The change generally takes place within a few minutes. 

Buy more space 

The amount of storage space included with your .Mac account—and 

the amount you can add for an extra fee—has changed several times 

over the years. As of late 2007, Apple offers three levels of service: 

• The standard 10 GB, which includes 100 GB of data transfer per 
month 

• An optional upgrade to 20 GB total storage and 200 GB of data 

transfer per month for $50 extra per year 

• An optional upgrade to 30 GB total storage and 300 GB of data 

transfer per month for $100 extra per year 

These figures will no doubt change again in the future. 

To increase your total storage space from 10 GB to 20 GB or 30 GB, 

you can do any of the following: 

• Click the Buy More button on the iDisk tab of .Mac System 

Preferences or the iDisk Utility. 

• Click one of the numerous “Purchase additional iDisk storage” 

links on the Mac.com Web site. 

• Go to http://www.mac.com/ and log in. Click your member name 

on the navigation bar or the Account link on the left side of the 

window and (if prompted to do so) enter your member name and 

password again. Click the Storage Settings button, and then click 
the Buy More button. 

http://www.mac.com/


Page 105 

You can then choose the level of storage you want to buy and enter 

your credit card info to complete the purchase. A few “fine-print” 

details about increasing your storage space are worth highlighting: 

• If you upgrade your storage capacity partway through your 

subscription (i.e., not on the same day you purchase or renew a 

subscription), Apple charges you a prorated fee. For example, if 

your subscription is due for renewal in 6 months, Apple charges 

you only $25 for the upgrade to 20 GB. 

• By default, your upgraded storage space will renew automatically 

(at the full $50 or $100 rate, naturally) at the same time your .Mac 

subscription does (assuming you’ve set your account to auto-

renew, of course). 

• When you upgrade, Apple divides your .Mac storage space evenly 

between email and iDisk—regardless of how you divided it earlier. 

To divide you space differently, you must change it manually (refer 

to Divide space between files and email, just previously). 

  
TIP MORE STORAGE FOR LESS 

If you find yourself needing more capacity than even an upgraded 

.Mac account includes—or if you find the cost of additional storage 

too expensive—you may wish to consider another strategy. Some 
examples: 

• If you need the extra space primarily for moving files from one 

place to another, consider buying an inexpensive USB flash 

drive. 

• If backup is your main need, you may be able save money by 

using a service such as CrashPlan (http://www.crashplan.com/) 

or Mozy (http://www.mozy.com/). Or, pick up an inexpensive 

hard drive that will store much more than 30 GB for $50. 

• For publishing photos, movies, and other files on the Web, try a 

low-cost Web hosting provider (I list a few in Appendix A: 

Beyond .Mac). 

• If you have a massive archive of email you wish to keep online, 

an alternative email provider may be your best option; you can 

then forward your .Mac email to the new account, if you wish. 

Again, Appendix A: Beyond .Mac refer to for ideas. 

  

http://www.crashplan.com/
http://www.mozy.com/
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BACK UP YOUR FILES 

Since your iDisk is always available as a network volume, and since 

its contents are inherently offsite, it holds an obvious attraction as 

a repository for backups. Apple even provides .Mac users with a free 

utility (imaginatively named Backup) to assist in this process. 

  
TIP When it comes to backups, I wrote the book: in Take Control of Mac 

OS X Backups I walk you through developing and implementing a 

solid backup strategy and includes details about dozens of backup 

programs, including Backup 3 (http://www.takecontrolbooks.com/ 

backup-macosx.html). 

  
Given the recent increases in storage space on .Mac and the reason-

able quality of Apple’s Backup 3, I feel comfortable recommending 

.Mac-based backup solutions for some people—with the following 

qualifications: 

• Even if you max out your iDisk at 30 GB and allocate as little space 

as possible to email, you’ll probably be able to back up only some 

of your files to iDisk. My iTunes library alone, for instance, is larger 

than 30 GB! (You can, however, use Backup with other media.) 

• The more space you use on your iDisk for backups, the less is 

available for other purposes. 

• Backup cannot create bootable duplicates, and your iDisk cannot 

be used as a boot volume. 

• Backup 3 can’t back up data for more than one user at the same 

time. So if your Mac has three user accounts, each user must log 
in and run Backup separately. If you want to back up multiple 

users at the same time, you must use a different backup program. 

• Backups to an iDisk are slow, and backing up a full 30 GB could 

take several days or more, even with a fast Internet connection. 

• If you lose your Internet connection, or if Apple’s servers are 

unavailable for any reason, you can’t retrieve your backed-up files. 

In short, you can (and should) use your iDisk to store backups of 

some of your files, and you can use Backup (or another backup pro-

gram, if you prefer) to automate that process. However, because your 

http://www.takecontrolbooks.com/backup-macosx.html?14@@!pt=0030-INTERNAL
http://www.takecontrolbooks.com/backup-macosx.html?14@@!pt=0030-INTERNAL
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iDisk is relatively small (compared to today’s cavernous hard drives), 

and because Backup cannot create a bootable duplicate of your drive, 

I recommend thinking of iDisk and Backup as only a partial backup 

solution. Still, something is always better than nothing, and I find a 
lot to like about Backup’s ease of use in combination with the offsite 

security of an iDisk. 

  
NOTE I want to emphasize that although iDisk and Backup work well 

together, you can also use either one individually. Backup can store 

backups on recordable CDs or DVDs, external hard drives, or net-

work servers (in addition to your iDisk). And you can back up files 
to your iDisk by copying them manually, or by using any of dozens 

of other backup programs. In this section, I cover only the use of 

Backup 3. To use your iDisk as a destination with other backup 

software, follow the instructions that came with the application. 

  

Install Backup 3 

The easiest way to obtain your copy of Backup 3 is to copy it from 

your iDisk—it’s located in the Software/Apple Software/Backup 
for Mac OS X 10.3.9 or 10.4.2 or later folder. Copy the 

Backup_3.1.1 disk image to your hard disk and then double-click 

it to mount the image. Double-click the installer icon, and follow the 

prompts to install Backup 3. When the installation is complete, you 

can find Backup in your /Applications folder. 

  
NOTE As the iDisk folder name suggests, Backup 3 requires Mac OS X 

10.3.9 or 10.4.2 or later. If you’re using an earlier version of Mac OS 

X 10.3 or 10.4, run Software Update to download and install the 

latest version of Mac OS X. If you’re still using Mac OS X 10.2 or 

earlier, Apple still provides the previous version of Backup (2.0.2), 

but it lacks most of the features I describe here. 

  
When you launch Backup, the first thing it shows you is a list of preset 

backup plans, as shown in Figure 37. (If you used an older version 

of Backup, Backup 3 offers to transfer your previous settings the first 

time you run it. I recommend skipping that option and setting up an 
entirely new backup configuration from scratch.) Instead of rushing 

into a choice now, click Continue to display the main Backup window—

you can still access the preset plans later. 
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FIGURE 37 

 

 

 This Welcome window gives you a quick way to set up some basic 
backup plans—but I recommend skipping it. After you click 
Continue, you get access to even more options. 
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NOTE To use Backup without limitations, you must have a .Mac member 

name and password (corresponding to a paid, non-trial account) 

entered on the Account pane of .Mac System Preferences. If not, 

Backup runs in a “demo” mode, which limits you to 100 MB of data 

per backup. 

  

Understand How Backup Stores Your Files 

Before you actually set up a backup plan, you should understand how 
Backup stores your files, because this could affect the decisions you 

make about which files to back up to which destinations. 

Backup 3 creates what I call additive incremental archives. This 

means that after the first full copy of a given folder or volume, each 
successive backup copies only those files that have been added or 

modified since the last time—but it does not delete old copies of your 

files. (In fact, Backup doesn’t even touch the earlier backups—it stores 

the files copied during each run in an entirely separate archive.) 

Because the backups are incremental, they’re relatively fast after the 

initial backup; Backup doesn’t waste its time (or your disk space) re-

copying files that haven’t changed. Because the backups are additive, 

you can retrieve an older version of a file, even if you accidentally (or 

intentionally) change or delete it just before making a backup.  

Backup 3 also compresses backed-up files into an archive (which is 

actually a disk image along with several supporting files in a special 

folder called a package) in order to further reduce both disk space 

usage and upload times. Backups can span media, too—if you back up 

to CD or DVD, Backup prompts you to insert new discs as necessary, 
and keeps track of which files were stored on which disc. 

  
NOTE When backing up to optical media, Backup first makes a temporary 

copy of your data as a disk image on your hard disk. (This behavior 

should be familiar to anyone who has burned CDs or DVDs under 

Panther or earlier versions of Mac OS X; Apple fixed it in Tiger’s 

version of the Finder.) This means you must have at least as much 
free space on your drive as the size of the disc you will be using! 
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NOTE A glaring omission to Backup’s optical media support is that it 

doesn’t not permit multisession recording. That means once you’ve 

recorded anything on a CD or DVD—even if it’s just a single file—

you can never add anything to that particular disc. The result is that 

you’re guaranteed to use at least one new disc every single time you 

back up, which can result in quite a waste of media. Several other 
backup programs (including Retrospect) can keep writing to a CD 

or DVD until it’s full. 

  
Yet another feather in Backup’s cap is that it stores catalogs of 

backed-up files—what some applications call snapshots. A snapshot 

is a complete list of the files in the folders you’re backing up as they 

appeared at the time of a backup, even though only a few of those files 

may actually have been copied during that particular backup run. 

Snapshots make it easy for you to restore a folder to its state at some 
arbitrary time in the past in a single step. When backup programs 

incrementally add files to an archive but don’t keep track of snap-

shots, file restoration can become a long and tedious exercise of 

digging through an endless list of folders. 

As you can tell, I think Backup does nearly all the right things in 

terms of file storage. However, I do want to mention two points: 

• Backup always uses the archive method to store files. It never 

stores raw files on the destination volume. As a result, you can’t 
use Backup to create an exact copy of a folder or volume on 

another volume. This is why you can never start up your computer 

from a backup that Backup makes—even if you select the entire 

contents of your hard disk and copy it to another hard disk. 

• Backup’s file format discourages manual restoration of files. If 

you look at the files Backup creates, you’ll find a large file with 

the extension .FullBackup, as well as smaller files—one for each 

successive backup after the initial one—with the extension 

.IncrementalBackup. These files are actually special folders called 

packages. To see the contents of one of these files, Control-click 
(or right-click) on it and choose Show Package Contents from the 

resulting contextual menu. In the folder that appears, you’ll see 

a Contents folder. Inside that folder, along with some other items, 

is a second folder called Contents. And inside that second Contents 

folder is a disk image called Backup.dmg. If you were to double-
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click that disk image, you would see your original files—at least, 

those that were copied during that particular backup run—and you 

could copy them to another volume manually. But you can save 

yourself all that effort by using Backup to restore your files. 

The upshot is that Backup is a good tool for storing archives of your 

important files, but not for backing up an entire hard disk—especially 

if you want to be able to start up your computer from the backup. If 

you choose to use Backup for archives, I urge you to consider supple-
menting those archives with a bootable backup—using a utility such 

as Carbon Copy Cloner or SuperDuper. 

http://www.bombich.com/software/ccc.html 

http://www.shirt-pocket.com/SuperDuper/ 

Add a Plan 
Backup uses the term plan to mean a set of files copied to one or 

more locations (optionally, on a recurring schedule). You can create 

as many plans as you need. 

To create a plan, click the  button at the bottom of the main Backup 
window (which is initially empty). The Choose a Plan Template dialog 

(Figure 38) appears, showing preset options similar to those you 

saw in the Welcome window. 

  
WARNING! I recommend against backing up files to your primary hard disk. 

Even if it has plenty of space, you’re storing all your digital eggs 

in one basket. If your hard drive becomes damaged (an all-too-
frequent occurrence), you’ll lose access to both your original files 

and your backups. Storing your files on a separate hard drive (or 

on optical media) is safer. 

   

http://www.shirt-pocket.com/SuperDuper/
http://www.bombich.com/software/ccc.html
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FIGURE 38 

 

 

 Choose one of these preset plan templates as the basis for your 
backup—but really, Custom is the best and most flexible choice. 

  Although the included descriptions are largely self-explanatory, I’d 

like to provide a bit more detail on the main presets: 

• Home Folder: Your home folder (/Users/your-user-name) 
contains almost all your personal files: your email, music, photos, 

preferences, documents, and so on—even the files on your Desk-

top. In most cases, backing up your home folder will cover all your 

important data, but it does not include Mac OS X itself, your appli-

cations, or any folders you may have created manually at the top 

level of your hard disk.  

Your home folder can get quite large (mine happens to be about 

50  GB at the moment, and that’s small compared to some), so you 

need plenty of space to store a copy. That’s why this preset makes a 
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copy on your hard disk (daily), under the assumption that your 

hard drive has plenty of free space. It also makes monthly copies to 

CD or DVD—which will probably mean several DVDs or a stack of 

CDs. 

• Personal Data & Settings: As the description says, this preset 

includes just a small subset of the items in your home folder: your 

Address Book contacts, Stickies notes, iCal calendars, Safari set-

tings (including your bookmarks), and Keychain settings. Because 
this data usually takes up fairly little space, this preset copies the 

listed items to your iDisk. 

  
NOTE If you use .Mac sync to sync items such as your Address Book 

contacts and Safari bookmarks to your iDisk, this preset will make 

another copy of the same data, taking up even more space on your 

iDisk. Not that there’s anything wrong with having an extra copy of 
your data, but if you’re running out of iDisk space, you might want 

to omit these items from your backup and rely on the synchronized 

copy (which may also be accessible on the Web) instead. 

  
• iLife: This preset copies data from all your iLife applications, 

assuming you’ve stored it in the default locations. This data 

includes GarageBand projects, iDVD projects, iMovie projects, 

your iPhoto library, and your iTunes library and playlists (and 

music purchased from the iTunes Store). Because the amount 
of data in these categories may be quite large, this preset uses 

optical media as its destination. 

• Purchased Music: Instead of copying all your iTunes music, 

this preset copies just those tracks you purchased from the iTunes 
Store, along with your iTunes playlists. Again, optical discs are the 

default storage destination. 

• Custom: Create your own backup scenario, which can include 

any of the other options listed here, as well as many other pre-
selected packages, arbitrary files and folders, and even the results 

of Spotlight searches. You can also choose your destination(s) 

and schedule(s). Because this option has the greatest flexibility, 

I recommend choosing Custom. 
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After you make a selection from the list, click Choose Plan. Enter a 

name for your backup plan in the window that appears (Figure 39). 

FIGURE 39 

 

 

 Enter a name for your new backup plan, add items to be backed 
up, and then select the destination and schedule. 

  The Plan window has three tabs (Back Up, History, and Restore). 
On the Back Up tab, which appears initially, you select what items 

you want to back up, where you want to store them, and when you 

want the backup to run.  

Add backup items 

If you selected a preset other than Custom, some items will already 

appear in the Backup Items list. Otherwise, you can add items by 
dragging them into the list from the Finder, or by clicking the  
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button. When you click the button, another dialog appears, showing 

three tabs that lead to a wide variety of options (Figure 40). 

FIGURE 40 

 

 

 QuickPicks are ready-made selections of files in popular categories. 

  Click a tab at the top of the dialog to choose a category of options: 

• QuickPicks: On the QuickPicks tab, you can select one or more 

packages representing certain file types Backup knows about, such 

as documents created with iLife or iWork applications, Microsoft 

Office documents, or personal information (contacts, calendars, 

and so on). 

  
WARNING! Apple’s QuickPicks back up only data located in your home folder. 

So, for example, if you have music from the iTunes Store that you 

keep in a different folder (or on an entirely different volume), or if 

you’ve moved your iPhoto Library to another disk, QuickPicks will 

not make Backup back up those files! You must add them to a 

backup plan manually. 
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TIP Several third parties have created plug-in QuickPicks for other 

kinds of files. For example, Delicious Library offers a QuickPick for 

its files (http://www.delicious-monster.com/blog/2005_09_01_ 

archive.html), and there’s one for a user of the Mellel files. 

(http://www.redlers.com/download/other/MellelQuickPick.dmg.zip).
To find more QuickPicks, search in VersionTracker for QuickPick 
(http://www.versiontracker.com/macosx/). 

  
• Files & Folders: On the Files & Folders tab (Figure 41), you 

can select one or more individual files or folders to be backed up.  

FIGURE 41 

 

 

 Use the Files & Folders tab to select particular files and folders 
to back up. In this example, I selected my home folder (jk) and 
clicked Include This Folder. Then I selected Desktop and clicked 
Do Not Include This Folder. The result is that everything in my home 
folder except my Desktop folder will be backed up. 

  (You can select more than one item by holding down the 

Command key while clicking; you can also drag to select multiple 
contiguous items.) 

http://www.versiontracker.com/macosx/
http://www.delicious-monster.com/blog/2005_09_01_archive.html
http://www.delicious-monster.com/blog/2005_09_01_archive.html
http://www.redlers.com/download/other/MellelQuickPick.dmg.zip
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After selecting one or more items, select the Include This Folder 

(or Include This File) radio button. A checkmark in a green circle 

appears by the item (and all its contents, in the case of a folder). 

If you want to exclude part of a folder you’ve just marked for inclu-
sion, select that item and click the Do Not Include This Folder (or 

Do Not Include This File) radio button. 

• Spotlight: If you want to find files or folders to back up but you 

are not sure where to find them (or you want to make sure they get 
backed up, even if they’re spread out all over your hard drive), go 

to the Spotlight pane (Figure 42). Enter a string in the search field 

and select an area to search (Home, Computer, or Servers), and 

Backup displays matching results, just as in any Spotlight search. 

As on the Files & Folders tab, select an item and click Include This 

Folder (or Include This File) to add it to the list of items to back 
up; click Do Not Include This Folder (or Do Not Include This File) 

to remove it from the list. 

FIGURE 42 

 

 

 The Spotlight tab can help you locate files and folders to back up. 
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WARNING! The Spotlight tab can help you find files and folders, but it does not 

give Backup the capability of dynamically backing up items that 

meet the search criteria each time it runs. (And in case you’re 

thinking of using a smart folder to get around this, if you select a 

smart folder in this list—a file ending in .savedSearch—Backup will 

back up only the search settings, not the smart folder’s contents.) 

  
After you’ve selected file(s) or folder(s) on one of these tabs, click 

Done to add them to your backup list; you can then click the  
button again, if necessary, to add more items. To remove an item 

from the list, select it and click the  button (or press Delete). 

  
WARNING! If you use any method other than Apple’s preset plans or Quick-

Picks to add items to a backup plan, be aware that Backup doesn’t 

track changes you make to the names of those items. So if you 

rename a file or folder you’ve manually added to a backup plan, 
Backup won’t be able to find it. You must manually add it again. 

  
Add destinations and schedules 

Now you have to tell Backup where to put the items you’re backing 
up, and when. To do this, click the  button below the Destination 

and Schedule list. A dialog (Figure 43) appears. 

FIGURE 43 

 

 

 Set the location where your backup files will be stored, and the 
frequency with which backups will occur, in this dialog. 
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First, choose a volume from the Destination pop-up menu. This menu 

lists all currently mounted volumes—which includes network servers, 

other partitions on your main hard disk, and external hard disks—and 

your iDisk. 

  
NOTE Before choosing your iDisk as a destination, make sure you have 

allotted it enough storage space. You can find details in Divide 

Space between files and email. 

   

  
NOTE Apple claims that you can back up only one computer to a given 

iDisk. My tests have shown differently. I set up two Macs with 

identical backup plans, and both backed up their respective files 

to my iDisk without complaint. Even though the plans had the 

same names, Backup correctly kept track of them when it came 

time to restore files. Your mileage may vary, however—it could be 

that under some circumstances (which I have not yet discovered), 
Backup prevents you from storing files from multiple computers 

(or multiple users on the same computer) on the same iDisk. 

  
If applicable, choose a folder on the destination volume from the 
Folder pop-up menu. If the location you want to use does not appear 

in the Folder menu (or if you chose Network from the Destination 

pop-up menu in order to select a server that’s not currently mounted), 

choose Choose Location from the Folder menu and navigate to your 

desired destination. If you want to back up to optical media, choose 

CD or DVD from the menu. 

  
NOTE Unlike some backup applications, Backup will not mount a network 

volume automatically when a backup runs. If you’re backing up to a 

server, make sure it’s mounted on the Desktop before the scheduled 

backup time. 

  
Next, choose when the backup should run. If you want this to be a 

manual backup that runs only when you explicitly initiate it, uncheck 

Automatically Back Up At the Following Times. Otherwise, make your 

selections using the controls at the bottom of the window. If you 
choose Week from the Every pop-up menu, you can then choose a 

(single) day of the week from the On pop-up menu; similarly, if you 

choose Month from the Every menu, you can use the On pop-up menu 
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to choose a (single) day of the month. Enter a time of day for the back-

up to run, and click OK. Your final backup plan appears, with the 

items, destination, and schedule you selected (Figure 44). 

FIGURE 44 

 

 

 This window displays your finished backup plan. 

  Regardless of the time you chose for the backup to run automatically, 

you can start it immediately by clicking Back Up Now. If you want to 

add additional destinations schedules for this set of files and folders, 

do so by clicking the lower  button again. To delete a destination 
and its schedule, select it and click the  button (or press Delete). 

Backup provides limited flexibility in setting schedules—for instance, 

you can choose for a backup to run every Tuesday, but not every 

Tuesday and Thursday. However, you can achieve this effect by add-
ing another item to the Destination and Schedule list of the same 

backup plan; then choose the same destination but a different day. 
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NOTE Try not to schedule more than one backup for the same time 

(or overlapping times). Only one plan can run at a time; if you’ve 

scheduled two or more plans for the same time, the first plan must 

finish before the next begins. 

  
When a backup is scheduled to run, an alert appears (Figure 45). 

Click OK to begin the backup immediately, click Skip to postpone the 

backup until its next scheduled time, or simply ignore the alert and 

the backup will begin on its own in 2 minutes. 

FIGURE 45 

 

 

 This alert appears when a scheduled backup is about to run. To 
postpone the backup, click Skip. 

  Why does this alert appear? A backup could occur at an awkward 

moment—perhaps you don’t have any blank DVDs handy, the drive 

you want to use is unavailable, or your Internet connection is down. 
Also, in some situations Backup can slow down other tasks. For all 

these reasons, the Skip button can be handy. 

  
TIP I suggest backing up to more than one set of media—for example, 

two or more distinct sets of DVDs or two or more external hard 

drives. That way, you have a secondary backup in case one set of 

media is lost or damaged. To do this, simply add more destinations. 

You can (and should) store one copy of your backups offsite—at 

a friend’s home, say—to provide extra protection against theft or 

catastrophic damage to your home. 
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Work with Backup Plans 

Once you’ve completed setting up a plan, it appears in Backup’s main 

window (Figure 46). You can add as many plans as you need, each 
with its own data, destinations, and schedules. 

FIGURE 46 

 

 

 The main Backup window displays the details of the plans you’ve 
configured. 

  In this window—which you’ll see immediately after launching Backup 

after you’ve configured at least one plan—you can also add, modify, and 

run backup plans with just a click or two. The commands for working 

with existing plans are on the pop-up Action menu ( ) at the 
bottom of the window. After selecting a plan, choose one of these 

options: 

• New: Add another plan. (You can also click the  button to 

accomplish the same task.) 

• Rename: Change a plan’s name. (Alternatively, you can select 

a plan in the list and then click its name to make the name field 

editable.) 
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• Edit: Modify a plan’s settings, including backup items, destination, 

and schedule. (You can also double-click a plan to edit it.) 

• Remove: Delete a plan altogether. (You can also select a plan and 

press Delete to remove it.) 

  
NOTE Removing a plan does not delete the backup archives it created. 

If you later want to restore files from a backup plan you’ve deleted, 

double-click the archive package in the Finder; doing so also adds 

it back to this list (but without a schedule). 

  
• Back Up: Run the selected plan now, regardless of when (or if) 

it’s scheduled to run. You can also click the Back Up button to run 
a plan. 

• Restore: Retrieve files from the backup and copy them either 

to their original locations or to another location (see Restore a 

Backup). You can also click Restore to do the same thing. 

Review Your Backup History 
To see which backup plans have run when—and with what results—

select a backup plan in the main Backup window and choose Edit 

from the pop-up Action menu ( ) (or double-click the plan). Click 

the History tab (Figure 47). 
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FIGURE 47 

 

 

 The History pane lists all the activity for this plan, including backups 
and restorations. 

  The History tab lists each activity (backup or restore) Backup 

has performed with this backup plan—whether manually or on 

a schedule—along with its date, time, destination, and the number 

of files backed up or restored. 

If you want to know exactly which files were backed up or restored, 

select an item in the list and click View Details. Backup opens the 

Console application with a window displaying more details than you 

probably care to read. 

To clear the list (which does not affect the backed-up files 

themselves), click Clear History. 
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NOTE RECYCLING BACKUPS 

Each time your backup runs, the archive grows somewhat. The rate 

at which it grows depends on the number and size of files backed 

up and how frequently they change. But if you’re backing up to a 
hard disk, an iDisk, or another network server, you may eventually 

fill up your available storage space. When this happens (or, prefer-

ably, before this happens), you should delete the existing backup 

files and immediately perform a new full backup. (But bear in mind 

that you’ll no longer be able to retrieve older versions of your files.) 

Some software refers to this process as “recycling” backup media. 

Before deleting your backup files, you might consider copying them 

onto CDs, DVDs, or a spare hard drive so that you can later retrieve 

old versions of your files if necessary. If you delete backups without 

first making another copy, you will lose the ability to restore files 
older than today (or the next time you run your backup). 

If you’re backing up to an iDisk, choose Backup > Remove iDisk 

Backups to delete the backup files. Otherwise, delete the files from 

the backup media manually. Then, select a backup plan and choose 
Plan > Full Backup. Repeat for each of your plans.  

  

Restore a Backup 
Having backups is useful only if you can restore files you’ve backed 

up when the need arises—after your drive has died, your computer has 

been stolen, you’ve deleted an important file, or whatever. Backup 3 

makes this process fairly simple. 

  
WARNING! Don’t assume your backups are fine, just because your backup soft-

ware says they are. Perhaps you didn’t select the right files, a disk 

error occurred, or for some other reason the files didn’t get backed 

up the way you thought they would. This is the sort of thing you 

don’t want to discover only after disaster strikes!  

Test your backups regularly by restoring sample files, opening 

those files, and verifying that they are intact. Like testing a smoke 

detector’s battery, checking your backups regularly can help you 

spot problems before it’s too late. 
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To restore a backup, follow these steps: 

1. Quit all applications except Backup, or, at the very least, quit the 
applications whose data you’re about to restore. Otherwise, the 

backup may not work properly. 

2. Select a plan in Backup’s main window and click Restore. The 

Restore pane of the backup plan window (Figure 48) appears. 

FIGURE 48 

 

 

 Use the Restore pane to select files and folders to restore from one 
of this backup’s snapshots. 

  3. The left pane, labeled Previous Backups, has an entry for each time 

this backup plan has run. If you select one of these entries, the next 

column lists the items in your backup, as they appeared at the time 

listed—whether or not they were copied during that particular 

backup run. Check the box next to one or more items to restore 
them to the state in which they existed at the time and date shown. 



Page 127 

4. By default, Backup copies the files back to their original location. 

Although this can be handy (especially for files whose original 

location may not have been obvious), it can also be dangerous—

you could unintentionally overwrite newer, useful data with 
an older copy. To avoid this problem, check the Restore to an 

Alternate Location box. 

5. Click Restore Selection. Then: 

• If you selected Restore to an Alternate Location, Backup will 

prompt you to select a folder where the files should be copied. 

Make your selection and click Choose. 

• Otherwise, a dialog (Figure 49) appears. Select whether you 

want to replace (overwrite) the files currently in the destination 

with the copies from the backup, or restore files and folders 

only if the destination folder currently has no files or folders 

with the same names. Click Restore. 

FIGURE 49 

 

 

 When restoring files to their original location, choose whether or not 
you want to overwrite existing files with the same names. 

  6. If you did not quit all open applications (Step 1), an alert will 

remind you that you really should do so now! After doing so, click 
Continue. 

Backup restores the selected items to the location you requested. 
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CREATE AND PUBLISH A WEB SITE 

Creating a Web page is not rocket science—millions of ordinary 

people have successfully done so with no training or prior experience. 

For a simple Web page, all you must do is mark up a plain text file 

with a few special tags enclosed in angle brackets, upload it to a Web 

server, and wait for the world to beat a path to your virtual door. 

But behind this deceptively simple process are some potential sources 

of confusion that often require at least a modicum of geek mojo to 

overcome, such as: 

• How do I get started learning HTML? (Or, for that matter, do I 

need to learn it at all?) 

• How do I choose a Web hosting provider? 

• How do I get my files onto the server? (And what in the world is 

FTP, anyway?) 

• How do I make my Web pages look spiffy and professional? 

• How can I make photo or video albums—with thumbnails, 

navigational links, and all the other niceties? 

.Mac aims to address all these issues by providing Web access to 

your iDisk’s Sites folder, offering HomePage, an easy-to-use system 

for designing Web pages with no knowledge of HTML, and selling 

iWeb (part of iLife ’06 and later), which can publish Web sites 

directly to your iDisk. In other words, no matter how little you know 
about Web design, you too can have a high-quality Web site in just 

minutes. And if you do know a thing or two about Web design, you 

can leave the training wheels behind and create your own custom 

sites from scratch. 

Broadly speaking, Apple provides three ways to publish a Web site: 

• Use HomePage to create Web pages, optionally incorporating 

photos, movies, and other files on your iDisk. 

• Use iWeb to create Web pages or blogs, which can include media 

from iPhoto, iMovie, GarageBand, or iTunes. 

• Manually create pages and upload them. 
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We’ll look at each of these techniques in turn. Before we do, though, 

I want to make sure you fully understand the distinction between a 

page and a site; this will become increasingly important as you add 

more material. 

A page is a single HTML file. That single file could be anything from 

a blank page to your entire life’s story with hundreds of photos. But 

when you view a page on the Web, you can see the whole thing simply 

by scrolling up or down. In some cases (such as with photo albums), 
a single page can produce pop-up windows that contain additional 

content, such as full-size photos. 

Although a Web page can in theory be as long as you like, most 

people prefer to break up large amounts of content into smaller 
chunks—separate pages—so that pages load faster and the informa-

tion is neatly organized. A site is such a collection of related pages. 

You can include two, or ten, or hundreds of pages in a single site; if 

you do, you’ll most likely include links of some sort so that visitors 

can move from one page to the next easily. Back to the photo album 

example, if you had 50 pictures, you might choose to put ten images 
on each of five pages, with “Previous” and “Next” links on each page. 

Your .Mac account can include any number of sites. If you create a site 

using HomePage, its address begins with http://homepage.mac.com/ 

member-name/; if you create a site using iWeb, its address is of the 
form http://web.mac.com/member-name/. 

Each site has its own home page. This is the page visitors see when 

they go to your site without specifying a filename at the end of the 

URL. A home page generally provides an overview of the site, and 
links to each main page within it. 

Create a Site Using HomePage 
HomePage is .Mac’s Web-based HTML authoring tool. (If you have 

iLife ’06 or later, you’ll probably want to use that instead.) To use 

HomePage, go to http://www.mac.com/, click the HomePage link in 
the navigation bar, and log in with your member name and password. 

You’ll then see the main page of Apple’s HomePage system, which will 

initially look something like Figure 50. 

http://www.mac.com/
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FIGURE 50 

 

 

 To create a Web page using HomePage, begin by selecting a 
category and theme. 

  Create your first page using HomePage themes 

To create a page, you begin by selecting a theme. Apple organizes 

available themes into several categories, some of which have special 

features. Here’s the run-down: 

• Photo Album: To display a series of photographs—including 

thumbnails, full-size photos, and a slideshow option—select one 

of these themes. After adding a folder of photos, you can choose 

which ones to display by toggling their Show checkboxes, or 
rearrange the photos by dragging them to a new location on the 

page. 
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NOTE Before you can use a Photo Album theme, you must already have 

a folder of photos in your iDisk’s Pictures folder or one of its 

subfolders. You must copy these photos there manually. 

  
• File Sharing: If you want to have a page where visitors can 

download one or more files, use one of these themes. The files 

must already be on your iDisk, but they can be in any of these 

folders: Movies, Pictures, Public, Sites, or Music—or in other 

folders you create at the top level of your iDisk. 

• Site Menu: Use one of these themes to create a menu-like page 

that provides links to other pages (either on your own site or else-

where on the Web); a link can also be an email address. Each link 

can include a title, description, and photo if you wish. 

  
TIP If you create several individual pages on your site and later want to 

create a navigational page to tie them together, a Site Menu theme 

is just the ticket. But remember: you have to create the individual 

pages first; you can’t add non-existent pages to a Site Menu. 

  
• iMovie: Each of these themes is designed to display a page with 

a single QuickTime movie. As with the Photo Album themes, you 

must already have a movie somewhere in your iDisk’s Movies 

folder. 

• Writing: If your page will contain primarily text—an article, 

story, newsletter, journal, personal profile, or something of that 

sort—choose a Writing theme. You can add graphics to these, as 

well, but the Writing layouts focus on the text rather than pictures. 

• Resume: Use a theme in this category to turn your résumé into a 

Web page. 

• Baby: For baby announcements (or movies of babies), select one 
of these themes. 

• Education: This category contains school-related themes, such as 

a school newsletter, a homework assignment, an announcement of 

a sporting event, or photos from a graduation. 
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• Invite: To create a Web-based invitation to a party, picnic, or 

other event, select one of these themes. 

• Advanced: This category contains a single entry—not really a 

theme—for adding your own HTML files to a site. But you can put 

a page on your Web site without using this interface; refer to 

Create a Site Using Your Own Tools. 

Once you’ve chosen a starting point for your first Web page, it’s time 

to customize it. 

Customize your page 

When you click on a theme, HomePage displays a form where you can 

add more information. Your options vary from one theme to the next—

you may see a button to select a file, photo, or movie, for example, or 
have one or more text fields to fill in (Figure 51 for an example). 

Generally, however, each page provides at least these options: 

• Title: The topmost box is usually the page’s title, which will 

appear in the browser’s title bar when someone visits the page. 

• Headline: Most pages have a headline, which is a title that 

appears on the page itself, usually in large letters near the top. 

• Counter: To keep track of how many people have visited this 

particular page, check the Show checkbox near the bottom of the 

form, next to the box displaying the number 0. When this option is 

selected, a counter appears on the page, displaying the number of 

times it has been visited. 

• Send Me a Message: Check the Show checkbox by this button 

to display it at the bottom of the page. When a visitor clicks the 

button, a feedback form (sort of an abbreviated version of the 

iCards interface) appears. This provides a way for someone to send 

a message from your Web page without the need to publicize your 
email address (which could lead to spam). 

• Photo album pages also include a pair of Layout radio buttons; 

select 2 Columns or 3 Columns, according to your taste. 
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FIGURE 51 

 

 

 Each page has several fields, such as captions and titles, which you 
can use to customize it. 

  Make your selections and fill in the text fields—and don’t worry, 

you can always change your Web page later. To see what your page 

will look like on the Web (without actually publishing it), click the 

Preview icon at the top of the page. When previewing a page, this icon 

changes to Edit; click it again to make changes. If you want to choose 

a different theme within the same category (keeping all your other 
selections and text), click the Themes icon. 

Publish and announce your page 

When you’re satisfied with your theme and page contents and you 

like the way the page looks in Preview mode, click the Publish icon 

at the top. Your page becomes available on the Web immediately, 

and HomePage displays the URL for your new page. (Click the URL 
to visit the live page yourself.) 

You should probably make a note of your new page’s URL. To send 

friends or family members a note that includes a link to the new page, 

click the Announce Site button. 
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Edit, add, or delete pages 

Your first .Mac Web page, by default, lives at the top level of your 

Sites folder. (Its title will depend on which template you used to create 

it.) HomePage also places a file there called index.html. Its purpose 

is to serve as a jumping-off point for all your pages. So if you go to 

http://homepage.mac.com/member-name/ (or, for that matter, 
http://homepage.mac.com/member-name/index.html) and there is 

just one page in your Web site—regardless of that page’s name—the 

index file will redirect you to that page. (If you have more than one 

page, the top of each page contains links to all the other main pages.) 

  
NOTE The automatic redirection and navigational links apply only to 

pages created by HomePage, not to pages you create and upload 
manually. 

  
After you’ve created your first page, the HomePage page on the 
.Mac Web site also changes; a new area, which I call the site browser, 

appears at the top (Figure 52) that lists your pages.  

FIGURE 52 

 

 

 You can use the site browser at the top of the HomePage page to 
modify individual pages within your site. 

  When you select a page in this list, a thumbnail of the site’s theme 

appears, along with information about its category and modification 
date. If you want to revise a page (choose a different theme, change 
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some captions, rearrange photos, or whatever), click the Edit button; 

you’ll go right back to the view you saw when you first created it. 

To add another page, either select a theme (just as you did when 

creating your first page) or click the Add (or Add Page) button under 

the site browser—and then select a theme. 

  
TIP The page shown in bold is the default page, which appears initially 

when someone visits your site. To change the default page, drag 

another page to the top of the list. 

  
To delete a page, select it and click Delete. You’ll see a warning 

that deleting this page is permanent and cannot be undone. Think 
seriously about this warning, and then click Yes. 

Edit, add, or delete sites 

Although your main .Mac Web site can contain any number of pages, 

you may wish to have multiple sites—perhaps with a different theme 

or subject matter for each. (If you have multiple sites, you can also 

selectively protect the content of particular sites with passwords; see 
Protect a site with a password, ahead.) Each site occupies its own sub-

folder within your Sites folder. 

To create a new site, follow these steps: 

1. Click the Add Site (or Add Another Site) button below the site 

browser. 

2. Enter a name for your new site (which will correspond to the name 
of the folder created in your Sites folder). 

3. If you want to protect the site with a password, check the On box 

and enter a password. (You can return and do this later, if you wish.) 

4. Click Create Site. 

HomePage creates a new, empty site, which will be visible at 

http://homepage.mac.com/member-name/site-name/ once you add 
some content to it. (Repeat this procedure as often as you like to 

create additional sites.) 

After you’ve added a site, it appears in the first column of the site 

browser (refer back to Figure 52 on the previous page), which func-
tions much like the Finder’s column view—sites in the first column, 
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pages and folders on that site in the second column, and so on; click-

ing on a page provides info about that page in the next column. 

Your next step is to add one or more pages to the site. To do this, 

select the site name in the Sites list and then follow the procedure 

described earlier (Edit, add, or delete pages) for adding new pages. 

  
TIP You can move a page from one site to another within the site 

browser using drag-and-drop. 

  
To delete a site, select it and click Delete. As when deleting a page, 

you’ll see a warning that deleting this page is permanent, cannot be 

undone, and deletes all the pages within the site. Think seriously 
about this warning, and then click Yes. 

Protect a site with a password 

I mentioned earlier that when you create a new site from within 

HomePage, you’re presented with the opportunity to protect that site 

with a password. However, you can also add such protection to an 

existing site. To do so, select the site in the site browser and click the 
Protect This Site button. Check the On checkbox, enter a password, 

and then click Apply Changes. 

  
NOTE You may not use the password guest to protect a site. 

  
You can also make a particular site the default site for people who 

visit http://homepage.mac.com/member-name by checking the 

Make This My Start Site box and clicking Apply Changes. (You can 

designate a site as the default without protecting it with a password.) 

  
WARNING! Protecting a site with a password does not automatically protect 

items in your Public folder. If a Web page links to files in your 
Public folder, those files are still accessible to the public unless you 

also protect your Public folder with a password (see Protect your 

Public folder with a password). 

  
When someone attempts to visit a password-protected site, a 

password prompt (like the one in Figure 53) appears. Only by 

entering the correct password can someone gain access to the site. 
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FIGURE 53 

 

 

 When someone visits a page in a password-protected site, this 
prompt appears, requiring a password to enter. 

  To turn off password protection later, or to change the password, 
select the site in the site browser and click the This Site Is Protected 

button. 

  
WARNING! The procedure I describe here for protecting sites with a password 

applies only to HomePage. I cover iWeb just ahead.  

  

Create a Site Using iWeb 

HomePage has been, and continues to be, a great way to create Web 

sites without ever having to mess around with HTML. But if you have 

a copy of iLife ’06 or later, you now have an even better way: iWeb. 
Like HomePage, iWeb makes it easy to create attractive Web sites. 

Unlike HomePage, iWeb runs directly on your Mac—and it gives you 

additional options, such as creating blogs, adding podcasts directly 

from GarageBand, and adding content from iPhoto, iMovie, or iTunes 

with just a click or two. 

You can use iWeb to create a Web site and upload it to any Web 

hosting provider, but in this book I cover an easier approach: 

publishing your site directly to .Mac. 

Besides creating a site in iWeb (see Publish a Web site on .Mac 

and Publish a blog on .Mac, just ahead), you can also start in iPhoto, 

iMovie, or GarageBand and send your content to iWeb. I describe that 

approach as well; see Share Your Media from iLife. 
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SIDEBAR JOE’S GUIDE TO THE iBUZZWORDS 

iLife ’06 is, as we say in the industry, fully buzzword-compliant: it 

contains features that allow you to create all the new kinds of content 

you’ve been hearing about in the news, such as blogs, RSS feeds, 
podcasts, and video podcasts, not to mention an invention of Apple’s 

called photocasts. But if you haven’t kept up with the evolution of 

the English language, some of these terms may be unfamiliar. Here’s 

what they mean: 

• Blog: Short for weblog; a Web site consisting of a journal, news 

reports, or other regularly posted articles, usually with entries 

listed in reverse-chronological order. 

• RSS feed: RSS stands for either “Rich Site Summary,” “RDF Site 
Summary,” or “Really Simple Syndication,” depending on which 

source you consult. An RSS feed is a way of packaging and deliver-

ing information such as blog entries over the Internet so that 

subscribers—who may view the feed using a Web browser such 

as Safari, or a specialized RSS reader—can easily see which 

articles they’ve read and which are new. The majority of blogs 
(including ones you create yourself in iWeb) offer RSS feeds. 

• Podcast: A downloadable audio recording you can put on your 

iPod (or other portable media player). Generally, podcasts are 

delivered along with a blog post, so that you can click to listen in 
a Web browser. If you subscribe to the blog via RSS, the podcast 

downloads automatically when the article containing it appears. 

In other words, it’s very much like sending an email attachment, 

except in this case the blog’s publisher sends the attachment to 

everyone who may be subscribing at any given time. 

• Video podcast: A podcast in the form of a movie, rather than an 

audio file. Also known as a vlog or vodcast. 

• Photocast: A photocast is nothing more than an RSS feed for 
a certain collection of photos. Other people can subscribe to that 

feed using a special URL—but instead of seeing text, they’ll see 

your photos. Add photos to an album you’ve photocasted, and the 

subscribers can instantly see what’s new. In addition, iPhoto itself 

can act as an RSS reader for photocasts. So you can both publish 

and subscribe to collections of pictures without having to use a 
separate application. 
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Publish a Web site on .Mac 

To create a Web site using iWeb, follow these steps: 

1. Open iWeb. The first thing you’ll see is a dialog (Figure 54) listing 

a variety of templates. (If iWeb is already open, click the  button 
at the bottom of the window to display the templates.) 

FIGURE 54 

 

 

 Every page you create in iWeb starts with a template. Choose an 
overall style from the list on the left, then a specific page type. 

  
 

  
iLife ’08 NEW iWEB TEMPLATES 

In iWeb ’08, Apple has provided new and redesigned 

templates, and the scrolling list on the left features smaller 

thumbnails. 

  
2. Select a template theme from the list on the left (optionally 

narrowing the list of options by choosing a category from the pop-

up menu), and then select a page type on the right. Click Choose. 

iWeb opens the template you selected, with placeholder pictures 

and text. 
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3. You may see a floating palette with Media in its title bar; this is 

called the Media Browser (Figure 55). If you don’t see it, choose 

View > Show Media Browser. 

FIGURE 55 

 

The Media Browser gives 
you instant access to your 
iTunes music, iPhoto 
photos, and iMovie 
movies—right from within 
iWeb. 

   
 

  
iLife ’08 UPDATED MEDIA BROWSER 

The Media Browser in iLife ’08 shows new iPhoto categories 

such as Events and Flagged. 
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4. To replace the placeholder photos, locate a photo on the Photos 

tab of the Media Browser and drag it onto the photo you want to 

replace. To add a photo to any other part of the page, select it and 

drag it to the desired location. You can then resize or reposition it 
to taste. 

  
NOTE If you have never added any photos to iPhoto, an alert appears 

when you first display the Photos tab telling you to do so. 

   

  
NOTE You can use the same procedure to add music from your iTunes 

library (on the Audio tab of the Media Browser) or movies from 

iMovie (on the Movies tab). Or, if you have media elsewhere 

on your hard disk, you can simply drag it in from the Finder. 

  
5. To replace the placeholder text, double-click a paragraph and type 

in your own text. To add text in a new location on the page, click 

the Text button at the bottom of the window. You can resize or 

reposition any text box simply by clicking and dragging. 

6. Repeat Steps 4 and 5 until you’re satisfied with the page. 

7. If you want to add more pages to your site, click the  button 

at the bottom of the window. Then repeat Steps 2–6. iWeb 

automatically places a link to every new page in your site in the 
navigational area at the top of each page. 

8. When you’re finished, choose File > Publish to .Mac. 

iWeb uploads the page and its photos to your iDisk, and then displays 

a dialog with the site’s URL and buttons you may use to visit the site 

in your default browser or send an email message announcing the 

site. If you later make changes to the site, choose File >Publish to 

.Mac again; iWeb uploads only new or changed pages. 

  
NOTE Web sites you create in iWeb have URLs that follow this pattern: 

http://web.mac.com/member-name/iWeb/Site/site-name.html 

  
iWeb offers a number of additional options I can’t cover here. To 

learn how to go beyond the basics, consult iWeb’s Help menu. 
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SIDEBAR MASTER OF YOUR DOMAIN 

If you’d like a shorter or more personal URL for your site than one 

beginning with “homepage.mac.com,” you can register a domain of 

your own and have it redirected to your .Mac site. Previously, this 
took a lot of effort and produced unreliable results, but starting in 

August 2007, Apple officially gave .Mac the capability to use other 

domains. 

With this feature activated, .Mac becomes a Web host for your own 
domain. In other words, type www.your-domain-name.com into 

a browser and up pops your .Mac-hosted Web site, created in iWeb 

and stored on your iDisk. Note that you cannot use .Mac to host 

email from another domain name, and that only sites created in 

iWeb ’08 or higher (not in HomePage or another application) work 

with your personal domain. 

To set this up, follow these steps: 

1. Register a domain name (if you haven’t done so already) with 
any of the numerous registrars. If you need advice with this step, 

I recommend reading Take Control of Your Domain Names 

(http://www.takecontrolbooks.com/domain-names.html). 

2. Go to www.mac.com, log in, and click your member name in the 
navigation bar. Reenter your login information if prompted to 

do so, and then click the Personal Domain button. 

3. Click Add Domain. Enter (and confirm) your domain name and 

then click Continue. 

4. Following the instructions provided, visit your registrar’s Web 

site and set up an alias (technically called a CNAME) for “www” 

that points to web.mac.com. 

5. Return to www.mac.com as in Step 2, and click Continue to 

finish setting up your domain name. 

From now on, anyone going to your domain name in a Web 
browser will see your site that’s hosted on .Mac. 

  
Publish a blog on .Mac 

In addition to conventional Web sites, iWeb can create blogs, which 

include an RSS feed (and a button to subscribe) and an Archive page 

listing previous posts. The process for creating a blog is very much 

like that for creating any other Web page. For beginning bloggers, 

http://www.takecontrolbooks.com/domain-names.html?14@@!pt=0030-INTERNAL


Page 143 

iWeb is perhaps the simplest way to get a great-looking blog onto 

the Web quickly. That said, before you take the plunge, you should 

be aware of a few limitations of any blog published on .Mac: 

• .Mac blogs do not support trackbacks (comments about your blog 

post that were originally posted on other sites). 

• Although your blog can include a search box, it cannot display an 
arbitrary list of posts (beyond what appears on the Archive page). 

• If you create your blog with iWeb, you cannot assign your posts 

to categories, include a calendar showing recent blog entry dates, 

or add other custom features to your blog. 

  
iLife ’08 CUSTOM FEATURES 

In iWeb ’08, you can easily add custom features, such as 

YouTube videos and Flickr photos, to your Web site using the 

Insert > HTML Snippet command; you can also add Google 

AdSense blocks and Google Maps using Insert > Google 

AdSense Ad and Insert > Google Map, respectively. 

If you’re still using iLife ’06, you can get many of these 

features with the $13 iWeb Enhancer (http://web.mac.com/ 

cbrantly/iWeb/Software/iWeb%20Enhancer.html) 

   

  
NOTE iWeb version 1.1 (part of iLife ’06) supports reader comments and 

searching of archived posts, but these features work only if you 

publish your blog to .Mac, not if you upload it manually to another 
server. 

The $10 iComment makes it possible to publish your blog to 

another server and still include comments (http://web.mac.com/ 

cbrantly/iWeb/Software/iComment.html). 

  

http://web.mac.com/cbrantly/iWeb/Software/iComment.html
http://web.mac.com/cbrantly/iWeb/Software/iWeb%20Enhancer.html
http://web.mac.com/cbrantly/iWeb/Software/iWeb%20Enhancer.html
http://web.mac.com/cbrantly/iWeb/Software/iComment.html
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Assuming these limitations cause no problems for you, follow these 

steps to create a blog with iWeb: 

1. Open iWeb. A list of templates appears. (If iWeb is already open, 

click the  button at the bottom of the window.) 

2. Select a template theme from the list on the left, and then select 

a page type on the right. For a blog, you must select either a Blog 
template or, if you expect to include audio or video podcasts in 

your blog, a Podcast template. Click Choose. iWeb opens the 

template you selected, with placeholder pictures and text. 

3. Type in a title for your first blog post. Then double-click the 
placeholder text below it and enter the text of your article. 

4. Using the same procedure I described earlier (see Publish a Web 

Site on .Mac), replace the graphics, add more media, or make any 

other desired changes to the page. 

5. If you wish your blog to support user comments, open iWeb’s 

Site Inspector palette (if it’s not visible, choose View > Show 

Inspector). Go to the RSS tab and check the Allow Comments 

checkbox. If you want commenters to be able to upload files 
(such as graphics), also check Allow Attachments. 

  
TIP If you don’t want a photo in your blog entry, delete the placeholder 

photo, then drag the text boxes for the entry’s title, date, and con-

tents to the spot where the photo used to be (and resize if you wish). 

  
6. When you’re finished, choose File > Publish to .Mac. 

iWeb uploads the page and its photos to your iDisk, and then 
shows a dialog with the site’s URL and buttons you can optionally 

use to visit the site in your default browser or send an email message 

announcing the site. To add another entry, select the blog’s Entries 

page in iWeb’s Site Organizer. Click the Add Blog Entry button and 

repeat Steps 3–5. 



Page 145 

  
TIP OTHER .MAC BLOGGING OPTIONS 

In addition to iWeb, several third-party software packages provide 

blogging capabilities on .Mac. Although none of these applications 

comes close to providing the flexibility of the major blogging pack-
ages, such as WordPress or Movable Type, they’re easy to use and 

include some unique and interesting features. 

• Sandvox: This application from Karelia uses a template-based 

system similar to iWeb’s to create Web pages and blogs. It has 
built-in support for comments and trackbacks via the HaloScan 

service (http://www.haloscan.com/). Sandvox can publish sites 

to .Mac or another Web hosting provider. Regular version, $49; 

Pro version, $79 (http://www.sandvox.com/). 

• Blog.Mac: The $30 Blog.Mac supports using your iSight 

camera as a live webcam, and updating a blog to show your 

current iTunes track (http://www.largemouthsoftware.com/ 

blogmac.html). 

• iBlog: This $20 program supports multiple blogs and categories; 

can easily include media from iTunes, iPhoto, and iMovie; and 

functions as a basic RSS reader (http://www.lifli.com/ 

iBlog/). 

• Snippet Mind: This $20 basic, no-frills journal program can 

publish entries to your iDisk as a blog and copy them to an iPod 

(http://zykloid.com/snippetmind/). 

  
Protect an iWeb site with a password 

Ordinarily, sites you create with iWeb are accessible to anyone who 

knows (or can guess) the URL. However, for any given site, you can 

restrict access to those who know a user name and password of your 

choice. To protect a site with a password, follow these steps: 

1. Open iWeb’s Site Inspector palette (if it’s not visible, choose View > 

Show Inspector). 

2. Go to the Password tab and check Make My Published Site Private. 

3. Choose File > Publish to .Mac. 

http://www.lifli.com/iBlog/
http://www.haloscan.com/
http://www.sandvox.com/
http://www.largemouthsoftware.com/blogmac.html
http://www.largemouthsoftware.com/blogmac.html
http://zykloid.com/snippetmind/
http://www.lifli.com/iBlog/


Page 146 

  
WARNING! The procedure I describe here for password-protecting sites applies 

only to iWeb. For HomePage, see Protect a site with a password. 

  

Share Your Media from iLife 

iWeb provides more-powerful and easier-to-use Web publishing 

capabilities than HomePage. It integrates tightly with not only iPhoto 

and iMovie, but also GarageBand—giving you even more ways to 

share media with just a few clicks. Also, iPhoto 6 offers a unique way 
to share photos: photocasting (see Work with photocasts in iPhoto 6), 

plus a way to publish your photos as a screensaver without a separate 

program (see the sidebar Mac Slides, a few pages ahead). 

However, if you prefer the HomePage templates, or want to retain 
the option of editing your pages in a Web browser, you’ll have to go 

through additional steps to upload your media from iPhoto or iMovie 

to your iDisk and then build your site using HomePage. 

  
NOTE Another reason you might choose HomePage over iWeb: 

HomePage permits you to change a photo album’s template after 

you’ve published it. In iWeb, you must re-create the album from 
scratch. 

  
Publish photos from iPhoto 

To create a photo album on your .Mac Web site from within iPhoto, 
follow these steps: 

1. Select one or more photos (or, if you wish, an entire album—but 

note that you can send only 99 photos to iWeb at a time). 

2. Choose Share > Send to iWeb > Photo Page. (If you want the 

photo(s) to appear as part of a blog entry, instead choose Share > 

Send to iWeb > Blog.) iWeb opens. 

3. Select a template and click Choose. iWeb imports your images 

and creates a new page with thumbnails of your photos and a Start 

Slideshow button. 

4. If you wish, add (or change) captions, drag photos to rearrange 
them, and modify other information—such as the page’s title and 

introductory text. 
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5. To create additional pages with more photos, repeat Steps 1–4. 

6. Choose File > Publish to .Mac. 

iWeb uploads the page and its photos to your iDisk, and then shows 

a dialog with the site’s URL and buttons you can optionally use to 

visit the site in your default browser or send an email message 

announcing the site. 

  
NOTE If you want to create a photo album on your .Mac site from iPhoto 

without going through iWeb, follow these steps instead: 

1. Select your photos or a photo album. 

2. Choose File > Export, and click Web Page. 

3. Select the options you want and click Export. 

4. Select the Sites folder on your iDisk as the destination. 

  
Work with photocasts in iPhoto 6 

iPhoto 6 gives you yet another way of sharing your photos using your 

.Mac account—a process Apple calls photocasting. (See the sidebar 

Joe’s Guide to the iBuzzwords, earlier.) 

  
iLife ’08 OUT WITH PHOTOCASTS, IN WITH WEB GALLERIES 

In iPhoto ’08, although you can still subscribe to photocasts 

created with iPhoto 6, you can’t create new ones. (And, to 

continue publishing existing photocasts with iPhoto ’08, you 

must supply your subscribers with a new URL.) Instead, you 

can create Web Galleries, which feature much spiffier graphics 

when viewed on a Web page, and to which other people can 

(with your permission) upload their own photos. Plus, like 

photocasts, Web Galleries include RSS feeds anyone can use 

to subscribe to the photos (via iPhoto or in any RSS reader). 

  
Publish a photocast 

To publish a photocast in iPhoto 6, follow these steps: 

1. Select a photo album. 

2. Choose Share > Photocast. A dialog appears with additional 

options (Figure 56). 
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FIGURE 56 

 

 

 Choose a photo size, automatic update settings, and optional pass-
word protection for your photocast in this dialog. 

  3. Select a size for your photos from the pop-up menu. Remember 

that the larger the size, the longer it will take not only to publish 

the photos, but for subscribers to download them. Medium or 

Large are usually good choices. 

4. Check Automatically Update When Album Changes to update the 

photocast immediately when you make changes to the published 

album. (Updates to the photocast may take several minutes from 

the time you make changes.) If this box is unchecked, you can 

update the photocast manually at any time by clicking the  icon 

next to its name in the Source list. 

5. If you wish to restrict access to the photocast to those who have 

a special user name and password, check Require Name and 

Password and fill in the Name and Password fields. 

6. Click Publish. 

iPhoto uploads the photos and supporting files to your iDisk. When 

it’s finished, it displays a dialog with the photocast’s URL and a but-
ton you can optionally click to send an email message announcing 

the photocast. (If you ever forget the photocast’s URL, select the 
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album and look in the Information pane at the bottom of the Source 

list; if the pane isn’t showing, click the  button in the bottom left 

corner of the window.) An album that has been photocast displays a 

 icon by its name in the Source list. 

  
NOTE iPhoto 6 publishes photocasts only to .Mac, not to other Web sites. 

  
Subscribe to a photocast 

To subscribe to a photocast using iPhoto 6, choose File > Subscribe to 

Photocast (Command-U), enter the photocast’s URL—or, if someone 

has sent you an email message announcing a photocast, simply click 

the link in the message—and click Subscribe. 

By default, iPhoto checks for updates to photocasts once per day. 

To change the frequency, choose iPhoto > Preferences, click the 

Photocasts button in the toolbar, and choose a different frequency 

from the Check for New Photos pop-up menu. Or, to force an immed-

iate update, click the  icon next to the photocast in the Source list. 

  
TIP iPhoto 6 can display the photos from any RSS feed—not just 

a photocast (though not the accompanying text, if any). For 

example, to display the photos from Engadget, a gadget blog, 

choose File > Subscribe and enter 

http://www.engadget.com/rss.xml. 

  
To subscribe to a photocast using another RSS reader, follow the soft-

ware’s instructions for adding a new RSS feed and type or paste in the 

photocast’s URL. 

Cancel photocast publication 

If you decide you no longer want a published photocast to be 

available, you can cancel it by following these steps: 

1. Choose iPhoto > Preferences. 

2. Click the Photocasts button in the toolbar. 

3. Select the photocast you want to cancel. 

4. Click Stop Publishing. A confirmation appears; click Stop 

Publishing again. 

iPhoto removes the published photos from your iDisk. 
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TIP If you create a site in iWeb, you can add a link to a photocast (so 

visitors can subscribe—using iPhoto 6 or another RSS reader—with 

one click). You can also add photos from a photocast (one you’ve 

published or one to which you’ve subscribed in iPhoto 6) to a page. 

To link to a photocast on a Web page in iWeb, follow these steps: 

1. Click the Media button in the toolbar to display the Media 

Browser and click Photos. 

2. Select the photocast in the list and drag it to an empty spot on 

a Web page. 

To put photos from a photocast on a page in iWeb, follow these 
steps: 

1. Click the Media button in the toolbar to display the Media 

Browser and click Photos. 

2. If you’re using a Photo template, select the photocast in the 

list and drag it to the photo grid. If no photo grid is on the page, 

hold down Option and drag the photocast to an empty spot on 

the Web page, and then rearrange the photos as you wish. 

If the photocast is updated, your Web page will not change auto-

matically; you must add the photos again and republish the site. 

   

  
TIP If you’re not satisfied with the photo album themes available in 

iPhoto, you can add a new set of themes—plus the capability to 

create your own templates—with a $20 shareware plug-in for iPhoto 

called BetterHTMLExport. This plug-in also gives you much greater 

control over the resulting pages, though it doesn’t publish files 

to your iDisk—you’ll have to upload the exported files manually 

(http://www.droolingcat.com/software/betterhtmlexport/). 

Another plug-in, called CustomHTMLExport, also enables you to 

create your own themes. It’s not as versatile as BetterHTMLExport, 

but it’s free (http://www.uweb.ucsb.edu/~dstaudigel/ 

CustomHTMLExport.html). 

Be aware, however, that once you’ve published a photo album with 

one of these tools, you may not be able to edit it later using Home-

Page or iWeb—you’ll have to use the same tool you used originally. 

   

http://www.uweb.ucsb.edu/~dstaudigel/CustomHTMLExport.html
http://www.droolingcat.com/software/betterhtmlexport/
http://www.uweb.ucsb.edu/~dstaudigel/CustomHTMLExport.html
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SIDEBAR MAC SLIDES 

Yet another way of sharing your photos is to turn them into a 

screen saver that other .Mac members can display on their Mac 

running Mac OS X 10.2 or later. 

To do this in iPhoto 6 or higher, select some photos, choose Share > 

.Mac Slides, and follow the on-screen instructions. 

If you don’t have iLife ’06 or later, you can use Mac Slides Publisher 

(available on your iDisk in Software/Apple Software). After 

installing it, drag one or more photos from iPhoto or the Finder 

and drop it on the Mac Slides Publisher icon in your Applications 

folder. Mac Slides Publisher should not be already running when 

you do this.)  

The selected photos will be optimized for screen saver use and 

uploaded to your iDisk; when the process ends, you’ll see a dialog 

offering to send an email “to your family and friends” announcing 

your slideshow. The photos are now available for use as a screen 
saver to anyone who knows your .Mac member name. (Note that 

each .Mac account can publish only one set of screen-saver photos 

at a time; if you upload a new set, the previous one is deleted.) 

To set up Mac OS X’s screen saver to use .Mac slides (your own or 
someone else’s), follow these steps: 

1. Go to the Screen Saver tab of Desktop & Screen Saver System 

Preferences. 

2. In the Screen Savers list, scroll down to .Mac; select it. 

3. Click Options. In the dialog that appears, enter someone’s .Mac 

member name in the field provided.  

4. Select any Display Options you wish to use for your screen saver. 

Then click OK. 

The next time your screen saver activates, it displays the slides 

from the selected .Mac account. You can set up screen savers for 

more than one .Mac member, though each member can have only 

one set of slides; to add another .Mac member’s slides, repeat this 

procedure. You can temporarily disable display of a member’s 

slides by unchecking the checkbox by that member’s name; to 
remove a member’s slides from the list permanently, select the 

name and click Delete. 
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Publish movies from iMovie HD 6 

The process for putting movies from iMovie HD 6 (part of iLife ’06) 

on the Web (thus creating a video podcast; see the sidebar Joe’s 

Guide to the iBuzzwords, earlier) is very similar to that for publishing 

photos from iPhoto 6. 

  
iLife ’08 A WHOLE NEW iMOVIE 

iMovie ’08 is a completely different program from iMovie HD 6. 

It now offers a way to publish Web Galleries to your .Mac Web 

site in much the same way as iPhoto ’08 (choose Share > 

.Mac Web Gallery). The process described here for sending 

content to iWeb no longer exists; when working in iWeb ’08, 

you can add iMovie content using the Media Browser. 

  
Follow these steps: 

1. Select one or more video clips (or none, if you want to share the 

entire movie). 

2. Choose Share > iWeb. A dialog appears (Figure 57). 

FIGURE 57 

 

 

 Select options for movie sharing in this dialog. 

  3. Select either Share for Web (smaller movies, lower quality) or 

Share for Video Podcast (larger movies, higher quality). 
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4. If you want to export only the selected clip(s), which will be 

concatenated into a single movie, select the Share Selected Clips 

Only checkbox. 

5. Click Share. iMovie compresses your movie and iWeb opens. 

6. Select a template and click Choose. Your options depend on the 

format you selected: 

• If you selected Share for Web, you can choose any Movie 

template. 

• If you selected Share for Video Podcast, you can select a Blog 

template or a Podcast template. 

iWeb imports your movie and creates a new page. 

7. Enter text to accompany your movie, and if you wish, modify other 

information—such as the page’s title. 

6. Choose File > Publish to .Mac. 

iWeb uploads the page and movie to your iDisk, and then displays a 

dialog with the site’s URL and buttons you can optionally use to visit 

the site in your default browser or send an email message announcing 

the site. 

  
NOTE To create a page with a movie on your .Mac site from iMovie HD 6 

without going through iWeb, follow these steps instead: 

1. Select one or more video clips (or none, if you want to share the 

entire movie). 

2. Choose File > Export, and choose Web (or another compression 

option, if you prefer) from the Compress Movie For pop-up 

menu. 

3. If you want to export only the selected clip(s), which will be con-

catenated into a single movie, select the Share Selected Clips 

Only checkbox. 

4. Click Share. 

5. Select the Movies folder on your iDisk as the destination. 

6. Use HomePage to create a new page with the movie (see Create a 

Site using HomePage). 
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Publish a podcast with GarageBand and iWeb 

Creating a podcast (see the sidebar Joe’s Guide to the iBuzzwords, 

earlier) basically involves recording an audio file, optionally editing 

it (for example, to add music or sound effects, or to remove mistakes), 

uploading it to a server, and putting a special line of HTML code in a 

blog post so that RSS readers can see it and download it. By using the 
combination of GarageBand and iWeb (both components of iLife ’06 

and later), you can do all these tasks without knowing anything about 

the underlying processes. Just click a few buttons, and your recording 

automagically appears on your blog. 

  
TIP I cover only the very basics of creating a podcast with GarageBand 

here. For much greater detail, see Andy Williams Affleck’s Take 
Control of Podcasting on the Mac 

(http://www.takecontrolbooks.com/podcasting-mac.html). 

  
To create a podcast, you’ll need a microphone. Although many Macs 

have built-in microphones, you’ll get better results from an external 

microphone. Some microphones require adapters to connect to your 

Mac. The directions that follow assume that you’ve already successfully 

connected a microphone and configured GarageBand to use it. 

  
iLife ’08 A BIGGER GARAGE 

GarageBand ’08 offers lots of interesting new features, but 

most of them pertain to making music, not podcasts. As a 

result, the procedure for making podcasts is almost identical 

to that used in GarageBand ’06. 

  
To create a simple podcast episode, follow these steps: 

1. Open GarageBand and click the New Podcast Episode button. 

2. Type in a name for your episode, choose a location to store it, and 

click Create. 

3. Select the Male Voice or Female Voice track, as appropriate, and 

click the Record button. When you’re done recording, click the 

Record button again. 

http://www.takecontrolbooks.com/podcasting-mac.html?14@@!pt=0030-INTERNAL
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4. To add music, sound effects, or other audio embellishments, 

drag them from the Loop Browser to the desired location in your 

recording. (If the Loop Browser isn’t visible, choose Control > 

Show Loop Browser [Command-L].) 

5. Choose Share > Send Podcast to iWeb. GarageBand mixes down 

your recording, converts it to the correct format, and opens iWeb. 

6. In iWeb, choose a Blog or Podcast template, and click Choose. 

7. Enter text to accompany your podcast, and if you wish, modify 

other information—such as the page’s title. 

8. Choose File > Publish to .Mac. 

iWeb uploads your podcast, along with the new blog entry, to your 

iDisk, and then displays a dialog with the site’s URL and buttons you 
can optionally use to visit the site in your default browser or send an 

email message announcing the site. 

Create a Site Using Your Own Tools 
If you find both HomePage and iWeb too limiting for your needs, you 

can create Web pages of any size or complexity using other software, 
and then simply copy those pages to the appropriate folder on your 

iDisk to publish them—your Sites folder, if you want to have the pages 

appear in your main .Mac Web site, or a subfolder of the Sites folder 

if you want to have them appear as part of a new site. 

Professional designers often use tools such as Adobe Dreamweaver to 

create HTML pages. Those who prefer to work with raw HTML code 

(including yours truly) may opt for a high-end text editor such as Bare 

Bones Software’s BBEdit (a commercial application) or TextWrangler 

(a free version with fewer HTML-related features). Even a simple 

application such as TextEdit or a command-line program such as pico 
or vi can produce HTML files (since they’re stored as plain text), but 

you won’t benefit from syntax coloring, automatic indentation, and 

other niceties found in dedicated editors. 
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TIP If you specify a character set in the head section of your HTML files 

(or if your authoring tool does), make sure you use UTF-8. Other 

character sets can cause problems with the .Mac Web server. If 

your file uses a different encoding, the .Mac server may attempt 

to convert it for you—with potentially undesirable results. 

  
I’m not about to explain the ins and outs of HTML here; if you want 

to learn how to create Web pages, pick up a book from your local 

library or locate one of the thousands of tutorials on the Web using 
Google. I do, however, want to point out a few important things about 

creating Web pages that will be hosted on your iDisk: 

• To include media files on your site (such as photos), CSS 

(cascading style sheet) files, or other external files that you’ll 
reference in your Web pages, you have two choices for how to store 

them on your iDisk: 

• You can store the files in existing folders at the top level of your 

iDisk—such as Pictures or Movies (or subfolders within these 
folders), in which case you must reference the files using tags 

containing their complete path, with a period before the name 

of the top-level folder; for example, http://homepage.mac.com/ 

member-name/.Pictures/folder-name/photo.jpeg.  

• You can place the files somewhere within your iDisk’s Sites 

folder, in which case you can reference the files with a regular 

relative URL, such as subfolder-name/photo.jpeg. 

• Even if you do your own coding, the .Mac Web site does not 
support server-side programming languages such as perl or PHP. 

You can, however, include JavaScript code within your Web pages 

if you wish, since that code executes on the client computer rather 

than on the server. 

• To make a file the home page for a given site—so that it appears 

when someone enters a URL like http://homepage.mac.com/ 

member-name/site-name/ (without specifying a particular 

document)—give it the name index.html. 
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• Any file you place in the Sites folder or one of its subfolders is 

immediately available on the Web; you needn’t do anything special 

to “turn them on” or inform the .Mac servers of their existence. 

Their URLs will be of the form: 

• http://homepage.mac.com/member-name/file-name (for files 

at the top level of the Sites folder)  

or  

• http://homepage.mac.com/member-name/folder-name/file-

name (for files in a folder called folder-name inside the Sites 

folder)  

However… 

• The only way to protect a site in your Sites folder with a password, 
or to add a .Mac counter or Send Me a Message button to a page 

you’ve created, is to use the HomePage interface. This gets a little 

weird with custom pages, but if you really want to do it, here’s 

how. After you’ve created and uploaded a site, follow these steps: 

1. On the HomePage page, click the Advanced tab (at the bottom). 

2. Click the External HTML icon. 

3. Navigate to a page (any page) in the site you’ve created. (Note 

that files named index.html do not appear in the list; you must 

have at least one other HTML file, with a different name, to 

make this work.) Select it and click Choose. 

4. A preview of the page appears. If you wish, select the Show 

checkbox next to the counter or Send Me a Message button. 

5. Click Publish. The next page displays the URL for the page 

you’ve just specified. (If you added a counter or Send Me a 
Message button, HomePage adds some HTML code to your 

document.) 

6. Click Return to HomePage. You should now see that the page 

you just selected (minus its .html extension) appears in the 
Pages list. Now click the Add Another Site link. 
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7. In the Site Name field, enter the exact name of the folder you 

uploaded—the one containing the file you specified in Step 3. 

8. If you wish to password-protect the site, select the On checkbox 

and enter a password. 

9. Click Create Site. 

The site you uploaded manually now appears in the Sites list at the 

top of the HomePage page; you can now use the regular HomePage 

controls to add, remove, or change the site password if you wish.  

But notice that the page you added in Step 3 also appears in the 

site bearing your .Mac member name, whereas if you select your 

new site in the Sites list, none of its pages appears in the Pages list. 

Just ignore this behavior; this oddity is one of the side effects of 

password-protecting a manually uploaded site. 
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COLLABORATE USING .MAC GROUPS 

One of the least publicized features in .Mac is .Mac Groups. The 

central focus of a .Mac group is a private Web site that’s accessible 

only to group members (those invited, or approved, by the group’s 

owner). This Web site includes: 

• A message board: Group members can post messages that are 

visible to the entire group. Because members can also send mes-

sages to the group via email—and receive copies by email—the 

message board also functions as a private mailing list. 

• Announcements: A section of the group’s home page is devoted 

to announcements that require special attention. 

• A shared calendar: Using iCal, the group’s owner can publish 
a calendar of group activities to the site. Members can then view 

the calendar on the Web or subscribe via iCal. 

• Group Web pages: Group members can create Web pages 

using HomePage or iWeb that are available only to other group 
members—including photo albums and file-sharing pages. 

• Shared iDisk Space: The group has its own iDisk space (an 

adjustable amount taken from the owner’s iDisk quota), which 

members can access using a Web browser, a WebDAV client, or 
the built-in WebDAV capabilities of Mac OS X or Windows. 

• Slideshows: Members can create a slideshow by uploading 

photos to a special folder on the group iDisk. 

• Link sharing: The group’s home page can list links to other sites 

of interest to the group. 

• A searchable member list: Members can include their contact 
information, including personal Web sites, in their profiles; other 

members can then search this information and contact them 

directly. 

In addition, you can customize the group’s home page with photos or 
other images and modify the background color. 
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Why Use a Group? 
Apple’s marketing copy suggests that .Mac Groups are for families 

and groups of friends with common interests, such as a community 
sports team. But .Mac groups are better suited to some groups of 

people than to others. 

One important consideration you should keep in mind is size. The 

maximum number of group members is 999, but in most cases, you’ll 
never approach that figure. The group owner must personally invite 

(or at least approve) every member, and each member is free to create 

pages, post messages, or customize the group’s home page. For this 

reason, a .Mac group works best for relatively small groups—say, 

20 members or fewer (give or take a few). The more people you add, 

the greater your administrative hassles, and the greater the likelihood 
that the site will grow out of control. 

Also, remember that .Mac groups are private. As tempting as it may 

be to use a group as a discussion board for your personal Web site or 

promotion of a community event, such applications are better suited 
to tools that permit anyone to participate. Use groups for situations 

where you personally know and trust the other members. 

Examples of groups for which .Mac groups may be useful include: 

• Committees: If you’re on a committee in your company, religious 

group, or community organization, a .Mac group can be a great 

place to share ideas, keep track of committee meetings, and plan 

events. 

• Recreation and fitness: Do you study yoga or t’ai chi? Take part 

in an aerobics class? Participate in a local geocaching or hiking 

club? If the group is small enough (and wired enough), a .Mac 

group can help facilitate communication and activities. 

• Arts and literature: If you’re part of a musical ensemble, dance 

troupe, book club, or writers’ collective, you can use a .Mac group 

to keep up with the group’s schedule and share information. 

• Ad hoc groups: You don’t have to belong to an organized club 

or group of some kind to use .Mac groups. An informal group of 

friends or family members can set up a group for planning a family 

reunion, discussing new movies or restaurants, or debating the 

latest political news. 
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To give you an example, I meet with about half a dozen close friends 

once a month for dinner and a discussion of our recent dreams. (Read 

more about Dream Groups at http://itotd.com/articles/207/.) We 

had been communicating with each other via email, but members 
frequently deleted messages with important information, or lost track 

of meeting times. I set up a .Mac group for our little dream group, 

which enabled us not only to post group-related messages and keep 

track of our schedule, but also to share links to relevant books, Web 

sites, seminars, and so on. 

  
NOTE GROUP GOTCHAS 

Before you start a group, be aware of some limitations and conse-

quences of .Mac groups: 

• You (or another group member) can invite anyone with an email 

address to join the group. However, in order to respond to the 

invitation and join, each invitee must use a .Mac ID. This does 

not mean each member must be a paid .Mac member! (Add and 

Manage Group Members has details.) But non-.Mac members 

will have to jump through an extra hoop or two to join. 

• Groups use storage space on the group owner’s iDisk for shared 

files (including photos and other media)—with a minimum of 

30 MB (15 MB each for iDisk and messages). And if you want 

to start more than one .Mac group, remember that each group 
requires at least 30 MB of your iDisk space. 

  

Create a Group 
To start your own group, follow these steps: 

1. Go to http://www.mac.com/, click Groups on the navigation bar, 

and log in with your .Mac member name and password. 

2. Click the large Create a Group button, and log in again. (After 

you’ve created your first group, you’ll instead see a button labeled 

Create a New Group.) 

3. Enter the information requested on the Set Up Your Group page 

(Figure 58)—the Group’s name, email address, description, color 

scheme, time zone, and referral setting. 

http://itotd.com/articles/207/
http://www.mac.com/
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FIGURE 58 

 

 

Set up the basic 
details of a new 
group on this 
page. 

   A few setup-related hints: 

• You can change the Group name or Description later, if you 

wish. However, once you choose an email address for a group, 

you can never change it without completely deleting the group 

and starting again from scratch. So choose carefully. 

• The Group time zone is the time zone that will be used for 

marking messages that members post to the group’s home page. 

If your group will have members from multiple time zones, you 

might want to remind them that the times shown for some 

messages will appear slightly out of whack. 
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• The referrals setting is for determining who can invite new 

members to join: any member (Allow) or only the owner 

(Do not allow). You can change this setting later. (Even if 

any member can invite someone else to join, the owner must 
approve each new membership.) 

4. When you’re finished, click Submit. If the email address you 

selected was already taken, the site will prompt you for a different 

one. When your group name has been accepted, you’ll see a page 
like the one shown in Figure 59. Apple also sends you a welcome 

message listing the group’s email address and Web site URL. 

FIGURE 59 

 

 

 After you set up a group, you’ll see the My Groups page. (If you 
have more than one group, they’ll all appear here.) 

  To change any of this group’s settings, click Edit. To create another 

group, click Create a New Group. To view your new group’s home 

page, click the group’s name or the  icon. 

Initially, your group home page will look like Figure 60. You can 

then add content—pictures, messages, calendar items, and, most 

importantly, new members! I recommend setting up at least some 

basic features of the site before adding new members, so that they’ll 
see some useful content when they first arrive. 
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FIGURE 60 

 

A brand-new .Mac 
group home page, 
ready for you to 
add content. Note 
that some links 
shown here are 
visible only to the 
group’s owner, 
not to other 
members. 

   

Add Content to Your Group Home Page 

The first thing you probably want to do is customize your group page 

(beyond selecting the background color, which you’ve already done) 

so that it provides some useful information to new members. Most of 

these tasks are fairly simple. 

Add an image 

A photo or other graphic can appear in the upper left corner to give 

your site some character. To add a photo: 

1. Click the Add an Image link. The sidebar expands to reveal 
instructions and several new buttons. 

2. Click Choose File, navigate to the image on your hard disk, and 

click Choose. 

3. Click Upload to upload the image. 
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The chosen image now appears on your group’s home page. You can 

change that image in the future by clicking the Change link beneath 

the image. 

  
NOTE Only the group’s owner can add or change an image. 

  
Add calendar events 

A small calendar appears in the sidebar of your group’s home page. 
You can add group-related events to this calendar by linking it to an 

iCal calendar on your own computer. To do this: 

1. Open iCal and create a new calendar (File > New Calendar). I 

suggest giving the new calendar a name that refers to the group in 
some way. 

2. Add events to this calendar as you normally would in iCal. 

3. Choose Calendar > Publish. Choose .Mac from the Publish On  

pop-up menu. Be sure to select Publish Titles and Notes, and to 

be sure the calendar stays up to date, also select Publish Changes 

Automatically. Click Publish, and click OK when the confirmation 

alert appears. 

3. On your group home page, click the Change Calendar link. A pop-

up menu appears. (If you don’t see this pop-up menu, click Log 

Out on the navigation bar, then log back in and try again.) 

4. Choose your newly created group calendar from the pop-up menu. 

Then click Apply. 

After you’ve linked your calendar, the minicalendar on your group 

home page displays clickable links for each date on which a calendar 
event occurs (Figure 61). Click any of these linked dates to display 

the group’s calendar in a Web page (just like any other published iCal 

calendar, as discussed in Publish and view calendars, earlier). 

  
NOTE Only the group’s owner can add an iCal calendar. 
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FIGURE 61 

 

This minicalendar has 
clickable links for dates 
with scheduled events. 
Click one of those dates 
to see the full calendar 
for that date. 

   When another member views your group’s home page, the link 

underneath the calendar will read Subscribe. Members can click this 

link to subscribe to the calendar in iCal (or another application that 

supports the webcal URL protocol [webcal://]). 

Add a slideshow 

In addition to Web pages (which can include photos), your group 
page can include a slideshow, which displays a collection of photos 

one at a time, with smooth transitions between them. 

To create a group slideshow: 

1. Click the Add Photos link in the Photos section at the top of the 

group’s home page. The group’s iDisk opens in a browser window. 

2. Click the Upload button in the upper right. A file browser appears. 

3. Select a photo from your hard drive and click Choose. Repeat Steps 

2 and 3 for as many photos as you wish to add to the slideshow. 

4. Close the iDisk browser window and reload the window showing 

the group’s home page. 

Thumbnails of the first two images appear at the top of the group’s 

home page. When you move your mouse pointer over the bottom of 
these images, additional controls appear. To play the slideshow, click 

Play Slideshow. The slideshow opens in a new window. 
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To pause the slideshow, or to manually select the next or previous 

photo, move the mouse pointer to a spot below the photo currently 

being displayed. Next, Previous, and Pause/Play controls appear. 

Add Web pages 

Your private .Mac group site can contain any number of Web pages— 

or entirely separate Web sites, for that matter. Any group member 

can add or edit new pages or sites. You can add Web content using 

a Web browser and .Mac’s HomePage feature or, if you have iLife ’06 

or later, using iWeb. 

Using HomePage 

To add Web content, in the sidebar of your group’s home page, 

click the  icon by the Our Pages heading. The .Mac site takes you to 

HomePage (detailed earlier in Create a Site Using HomePage), which 

now contains an additional icon for your group (Figure 62). 

FIGURE 62 

 

 

 When you are a group owner, a new icon appears in the HomePage 
interface. 

  Select the group icon and then: 

• To create a new (single) Web page, select one of the themes from 

the gallery at the bottom of the page. 

• To create a new site, which can hold numerous pages, click the Add 

Site button. 
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Everything else about adding pages and sites is the same as for 

your personal .Mac Web site (refer to Create a Site Using HomePage, 

earlier). Files you want to use within the Web site—such as pictures 

and movies—should be stored in subfolders within the group’s folder 
on your iDisk; see Use the Group iDisk, ahead, for details. 

  
NOTE You can even create your own custom HTML pages and upload 

them manually to your iDisk. Group pages are stored on your iDisk 

in Groups/your-group-name/Sites, but otherwise follow the 

same structures and rules as for other Web pages stored on your 

iDisk. 

  
Links to the pages you create using HomePage appear in the Our 

Pages section of the sidebar on your group’s home page (Figure 63). 
To edit any of these pages or add new ones, click the  icon. 

FIGURE 63 

 

The Our Pages section 
of the sidebar lists 
pages you’ve created 
within the group’s site. 

   Using iWeb 

You can also publish a Web site or blog from iWeb directly to your 

.Mac group. 

  
iLife ’08 REGROUPING 

iWeb ’08 no longer offers a way to publish Web content 

directly to your .Mac group. Instead, you must publish pages 

to your personal .Mac Web site and link to them from a group 

page. 

  
To do so, follow these steps: 

1. In your Web browser, go to http://www.mac.com/ and log in. 

2. Open iWeb, and create a site in the usual way (I cover this in 

Create a Site Using iWeb). 

http://www.mac.com/
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3. In the Site Organizer (the area on the left side of the iWeb win-

dow), select the site you want to publish to your .Mac group. 

4. Make sure the Inspector palette is visible. (If it isn’t, choose View > 

Show Inspector.) On the Inspector palette, click the leftmost tool-

bar button ( ) to display the Site Inspector pane. Then make sure 

the Site tab is showing; if not, click the Site button. The Inspector 

palette should look like Figure 64. 

FIGURE 64 

 

To publish your site to a 
group, select the Publish 
to a Group checkbox in this 
pane of the Site Inspector 
palette. 

   5. Choose the group to which you want to publish your site from the 

pop-up menu. 

6. Choose File > Publish to .Mac. 

iWeb publishes all your sites to .Mac; any sites for which you checked 

Publish to a Group in Step 4 go onto the group’s site, while the rest go 
onto your personal .Mac Web site. 



Page 170 

  
NOTE According to Apple, if you launch iWeb without first logging into 

your .Mac account, you won’t be able to publish a Web site to a 

group. I was able to do so, but if you have problems, quit iWeb, log 

in (as per Step 1) and then reopen iWeb before proceeding. 

   

  
NOTE If you change the state of the Publish to a Group checkbox and pub-

lish a site, it will move from your personal site to the group’s site, or 

vice-versa. You cannot publish a given site to more than one 

location. 

  
Links to the pages you create using iWeb appear in the Our Pages 

section of the sidebar on your group’s home page (see Figure 64 on 

the previous page). However, you cannot later edit these pages using 

HomePage; to change them, you must return to iWeb and republish 

the pages. 

  
NOTE The group sites and pages you create with HomePage and those you 

create with iWeb both have links in the Our Pages section of the 

sidebar, but they are stored in different places on the iDisk and 

have different URLs: 

• URLs for group sites created with iWeb take the form: 

http://web.mac.com/groups/group-email-address/your-.Mac-

ID/iWeb/site-name/page-name (where group-email-address is 

the part of the address before @groups.mac.com).  

• The files themselves are stored on your iDisk in 

Groups/group-email-address/Web/Sites/your-.Mac-
ID/iWeb. 

  
Add other links 

Your group’s home page has a section, Other Links, devoted to any 

URLs you wish—typically sites that relate to your group’s interests. 

Any group member can add or remove links. To add a link: 

1. Click the Add a Link link! Two new fields appear: Link Name and 

Link URL. 

2. Enter a name for the link and the site’s URL. Then click Add. 
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The link appears in the Other Links section of the page (Figure 65). 

To add a new link, click Edit. When you do this, you can also select 

any of your existing links and click Delete to delete them. (If you 

need to change a link, you must delete it and then re-add it with the 

corrected name or URL.) 

FIGURE 65 

 

Links to other Web 
pages you add appear 
under the Other Links 
heading. 

   

Add and Manage Group Members 

Once you have a group home page set up, the next step is to invite 

new members to join. As the group’s owner, you can also remove 

members if need be. 

Invite a member 

To invite new members to join the group, click the Invite link at the 

bottom of the Members section on the sidebar of your group’s home 

page. (Depending on the preferences you’ve assigned, this capability 

may be available to all group members, or just to the owner). Enter 

as many names and email addresses as you wish; click Add Another 
Row if you want to invite more than four people. To add contacts 

from your .Mac Address Book, click the Address Book link, check the 

boxes for one or more people, and click Select; .Mac fills those names 

and addresses into the Invite New Members list. Type in a personal 

message that will be included in the invitation email. Then click 

Continue, review the message that will be sent, and click Send. 

When a prospective member receives the invitation, he must click the 

link provided; this leads to a .Mac Log In page. If the invitee already 

has a .Mac member name and password, he can enter it now; if not, 

he can click the big orange Get a .Mac ID icon to sign up for a 60-day 
free trial—and then accept the group invitation. 
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NOTE Just to be crystal clear, anyone with a .Mac ID can join a group. 

This includes, according to Apple: 

• Paid .Mac members (both individual and Family Pack members) 

• Holders of Family Pack sub-accounts 

• People with email-only accounts 

• People with free trial memberships 

• People with expired .Mac memberships 

• Windows, Linux, and Mac users 

Mac.com email addresses belong to a user permanently, and 

remain usable for AIM/iChat, Apple Store purchases, the iTunes 
Store, and .Mac Groups—even if the user never paid for the 

membership, or has allowed a paid membership to lapse. 

  
If a member who is not the group owner has invited someone to join 

the group, the group owner must approve the new member. To do 

this, follow these steps: 

1. When a prospective member accepts an invitation, you will receive 
an email; click the link in that message to go to the Manage Group 

Membership Page. 

2. Requests that have not yet been processed appear in the Pending 

Your Approval list. Check the box next to a person’s name and click 
Approve to approve him for membership, or Deny to prevent him 

from joining. 

If you approve the request, the member is activated immediately; 

if you deny the request, the person receives an email telling them 
so. Members can get to the group’s home page by going to 

http://groups.mac.com/group-email-address (where group-email-

address is the part of the address before @groups.mac.com). 

Cancel an invitation 

Invitations are valid for 30 days. If an invitee does not join within 

that period of time and later wishes to do so, you must send a new 
invitation. To cancel the invitation for someone who has been invited 

but not yet joined: 

1. Go to http://www.mac.com/, click the Groups link on the 

navigation bar, and log in. 

http://www.mac.com/
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2. In the Members section of the group home page sidebar, click the 

Manage link. The Manage Group Membership page appears. 

3. Under the Invitations Sent heading, check the box by the name(s) 

of the invitee(s) whose invitation you wish to cancel. 

4. Click Cancel Invitation. An alert appears confirming that you want 

to cancel the invitation. Click OK. 

The invitee can then no longer accept the invitation; if you later wish 

that person to join, you must send a new invitation. 

Delete a member 

To remove a member from your group, follow these steps: 

1. Go to http://www.mac.com/, click the Groups link on the 

navigation bar, and log in. 

2. In the Members section of the group home page sidebar, click the 

Manage link. The Manage Group Membership page appears. 

3. Under the Members heading, check the box by the name(s) of the 

member(s) you wish to delete. 

4. Click Remove. 

The former member receives an email message stating that their 
membership in the group has been cancelled. 

Modify Group Settings 
As a group’s owner, you can, at any time, change numerous settings 

that apply to the group’s home page and overall group activity. To 

modify group settings: 

1. Go to http://www.mac.com/, click the Groups link on the 

navigation bar, and log in. 

2. Click the Edit link beneath the name of any group that displays the 

Owner ( ) icon. The Edit Group page appears. 

3. Most of the settings on this page (which I describe elsewhere in 

this section) should be self-explanatory. A few may not be: 

• Announcement: Your group’s home page can have one 

announcement, which appears near the top of the sidebar. 

Enter an announcement here, or edit the existing one. 

http://www.mac.com/
http://www.mac.com/
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• Manage Storage: Click the Click Here link below “View 

Storage” to modify the group’s storage space (for both iDisk 

and messages). Each group must have at least 15 MB allocated 

to iDisk and another 15 MB allocated to messages; the maxi-
mum depends on the owner’s available iDisk space. 

• Manage Messages: Click the Click Here link below “Manage 

Messages” to delete old messages via the Group Messages page. 

(messages are filed in “monthly” folders that appear on the 
Group Messages page): 

• To delete an entire month’s messages, check the box next to 

the month and then click Delete Selected.  

• To delete only specific messages from a month, click that 

month’s name in the list—which displays all messages from 

that month—and then delete the desired messages.  

• You can also view messages and compose new messages via 

the Group Messages page. 

4. Click Save. 

Your new group settings take effect immediately. 

Edit Your Profile 
.Mac can store a profile for each group member that contains the 

member’s name, contact information (address, phone number, and 
email address); Web site URL; and preferences. Members are not 

required to enter their personal information, and if they do, they 

can choose to hide it from the group. 

To edit your profile, follow these steps: 

1. Go to http://www.mac.com/, click the Groups link on the 

navigation bar, and log in. 

2. Click the name of a group to go to that group’s home page. 

3. At the bottom, click the Group Preferences link and log in again, if 

prompted. The Group Preferences page (Figure 66) appears. 

http://www.mac.com/
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NOTE If you try to send email to the group from any address other than 

your Mac.com address or the address specified in Group 

Preferences, your email message will bounce. 

   

FIGURE 66 

 

 

 Set basic group preferences on this page. 

  4. For each group you belong to, set your email preferences. The 
following options are available: 

• To receive each message posted to the group via email, select 

the radio button labeled I Want to Send and Receive Group 

Messages with this Account (the default), and choose an email 
address from the pop-up menu. The menu lists your Mac.com 

email address, any email aliases you’ve configured for your 

account, and any alternate email addresses you’ve set up (as 

in Step 5). 

• If you prefer not to receive group messages by email, select 

the radio button labeled I Prefer to Check the Group Site for 

Messages (Don’t Send Group Messages to My Email Address). 

If you use this setting, the only way to see group messages is 

to visit the group site. 

5. If you wish to be able to post messages to the group, and receive 

messages from the group, using an address other than your 

Mac.com email address, click Add Another Email Address and 

follow the instructions. You will receive a verification message 

at that address containing a link you must click to confirm the 



Page 176 

address. Following verification, the new address will appear in this 

pop-up menu. All messages sent to the group will then be directed 

to the new address, and you’ll be able to send mail to the group 

using either the address selected in the pop-up menu or your 
Mac.com email address. 

6. To make your profile available to other group members, choose 

a profile name from the pop-up menu under the group’s name 

(“Default Profile” is the only option initially); to hide your profile 
from other members, choose Do Not Show a Profile. 

7. To change the settings of the selected profile, click the Edit link or, 

to create a new profile, click Create a New Profile. The Edit Profile 

page (Figure 67) appears. 

FIGURE 67 

 

Enter 
personal 
information 
you want to 
share with 
other group 
members on 
the Edit 
Profile page. 

   8. Edit the profile description, using these tips if you need extra help: 

• Your .Mac member name doesn’t show as an editable choice, 

because it is not optional, and is always available to other group 
members. 

• For the profile name, enter any short, descriptive label as a 

name for this profile. 

• For the display name, use your first and last name or, if you 

prefer, a pseudonym. 
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• In the “My website” field, type (or paste in) the URL to any site 

that you wish other group members to associate with you. 

Typically, you would use a URL to a personal site. 

9. Click Save on the Edit Profile page, and then click Save again on 

the Group Preferences page. 

Your new settings take effect immediately. 

If you wish to leave a group—and you’re not the group’s owner— 

instead follow Steps 1–3 and then click the Cancel membership link. 

If you are the group’s owner, you must transfer ownership before 

you can remove yourself from the group. I explain the procedure in 
Transfer Group Ownership, ahead. 

Contact Another Member 
Your group’s home page lists each of the group’s members in the 

sidebar under “Members”; if there are too many members to fit in the 

sidebar, you can use the arrows at the bottom of the Members section 
to page through the list, or enter a portion of a member’s name in the 

Search field and press Return. 

If the person’s name (or Mac.com email address) is gray, it means 

that member has chosen to hide her profile from the group. If it’s 
blue, you can send the member an email message by clicking her 

email address (or the  icon), or you can click the member’s name 

(or the  icon next to it) to display the profile information the mem-

ber has entered. You can visit the member’s Web site be clicking its 

URL or the  icon in the profile information. 

Exchange Messages with the Group 
Any group member can send a message that appears on the group’s 

home page and is sent by email to all members who have chosen to 

receive messages that way (the default setting). You can post a mes-

sage in either of two ways. 

Post a message on the Web 

To post a message via the Web site, log in to your .Mac account and 

go to the group’s home page. Then follow these steps: 

1. Click the Compose link (above the Messages list, to the right of the 

word Messages). The Compose page (Figure 68) appears. 
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FIGURE 68 

 

 

Compose a new 
message to the 
group on this Web 
page, which is 
similar to—but not 
quite the same 
as—the one used 
to compose .Mac 
Mail messages. 

   2. On this page, the To field is already filled in with the group’s 

email address. Enter a subject for your message, one or more Cc 

addresses, if desired (separate multiple addresses with commas), 

and the text of your message. 

  
NOTE To see all the messages that have been sent to the group (without 

returning to the group’s home page), you as the group’s owner can 
click All Messages. A window appears where you can view or delete 

any messages sent to the group so far. 

  
3. To attach a file (such as a graphic) to your message, click Attach. 

To check your spelling, click Spell Check. 

4. To send the message, click Send. 

.Mac sends your message to all group members, and posts it on the 

group’s home page. 

Post a message by email 

As a group member, you can also post a message by sending an email 

to the group’s email address (which takes the form group-email-

address@groups.mac.com). 
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NOTE You can post a message to the group only using an address spec-

ified in your profile—either your Mac.com email address or an 

alternate email address (see Edit Your Profile). If someone tries 

to send a message to the group from another address, that message 

will bounce. This feature prevents the group from receiving spam 

(or other unwanted messages) from outsiders. 

  
As when posting messages on the Web, .Mac sends your message to 

all group members and posts it on the group’s home page. 

View and reply to messages 

The group’s home page displays only a two-line excerpt from each 

message; click its title to view the entire message. If your group has 

more messages than fit on the home page, click the View All link to 

see them on a separate page, which also permits searching by From, 

To, Cc, or Subject fields (but not message content). 

To reply to a message when viewing it on the Web, click Reply. To 

reply to a message received by email, simply use your email program’s 

reply function. (But remember that you must send your reply from an 

email address configured in your profile for this .Mac group.)  

Delete messages 

If you want to remove a message from your site, you can do this in 

any of several ways: 

• If you posted the message, you can click its title on your group’s 
home page, and then click Delete on the message page. 

• If you are the group’s owner, you can delete any message. To do 

so, click the View All link above the Messages list. Check the 

checkbox next to one or more messages and click Delete Selected. 

  
NOTE The only people who can delete a message are the person who 

posted it and the group’s owner. 

  
• If you are the group’s owner and you want to delete older messages 

en masse, click Manage Group Messages on the Group Messages 

page. Check the checkbox for one or more months, and then click 

Delete Selected to delete all the messages from those months.  
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Use the Group iDisk 
Each group has associated iDisk storage space allocated to files for 

the group’s use. This space can contain files the members wish to 
share with each other, as well as the Web pages, pictures, movies, 

and other media that appear on the group’s Web sites. 

As a group member, you can access these files from any Web browser 

by clicking the  icon next to the Group iDisk heading on the sidebar 
of the group’s home page. Or, if you mount your iDisk (in the Finder, 

in Windows, or using a WebDAV client), you can access the group’s 

folder inside your iDisk’s Groups folder. (If you have an expired or 

email-only account, which does not include iDisk access, you can 

mount the group iDisk in the Finder by choosing Go > Connect to 

Server and entering http://idisk.mac.com/groups.group-
email-address, where group-email-address is the part of the 

address before @groups.mac.com.) 

Place files you wish to share with other group members directly—

or on a file-sharing Web page—in the group’s Public folder. Place 
pictures or movies that you want to include on group Web pages 

in the Pictures or Movies folders, respectively. 

Transfer Group Ownership 
If at some point you, as the group owner, decide not to renew your 

.Mac membership—or if for some other reason you no longer wish to 
manage a group—you can transfer ownership to someone else. When 

you do so, you recover iDisk storage space used for group files, and 

that space is taken from the other user’s iDisk quota. 

You can transfer ownership only to someone who is already a member 
of the group, who has a full individual or Family Pack membership, 

and whose account is currently active. 

To transfer ownership, follow these steps: 

1. Go to http://www.mac.com/, click the Groups link on the 

navigation bar, and log in. 

2. Click the name of the group you want to transfer in order to go to 
that group’s home page. 

http://www.mac.com/
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3. Click the Group Preferences link at the bottom of the page and log 

in again if prompted to do so. 

4. Under the Group Preferences heading, click the Transfer 

Ownership link next to the group’s name. 

5. Select the radio button for the name of the member to whom you 

want to transfer ownership, and click Send. 

The member you selected receives an email invitation to become 

the group’s new owner. If the other member agrees, you receive 

notification by email. If the other member declines, you also receive 

notification; you can then repeat the process and select another 
person to take over ownership. 

If the other member does not respond—or if you change your mind 

before the invitation is accepted—you can cancel the transfer. To do 

so, follow Steps 1–3 just previously, and then click the Cancel 
Transfer of Ownership link next to the group’s name. 

After you transfer ownership of a group, you remain a group member. 

You can remove yourself later, if you wish (see Edit Your Profile, 

earlier). 

Delete a Group 
If you wish to completely discontinue a group—deleting all its files 

and Web pages and disabling the group’s email address—you can do 

so; Apple calls this canceling a group. When you cancel a group, you 

recover the iDisk storage space used for group files. 

  
WARNING! Canceling a group deletes the contents of that group’s iDisk folder, 

erasing all photos, Web pages, messages, and other content on the 

group site. If any of this information is important to you, make sure 

you have a backup copy before canceling the group. 
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To cancel a group, follow these steps: 

1. Go to http://www.mac.com/, click the Groups link on the 
navigation bar, and log in. 

2. Click the name of the group you want to cancel in order to go to 

that group’s home page. 

3. Click the Edit Group link at the bottom and log in again if 

prompted to do so. 

4. Under the Cancel Group heading at the bottom of the page, click 
the Click Here link. 

5. A confirmation message appears; click Yes to confirm deletion. 

The group is deleted immediately. 

 

http://www.mac.com/
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SAVE MONEY ON YOUR .MAC MEMBERSHIP 

Whether you’re joining .Mac for the first time or renewing your 

annual membership, you can often save a considerable amount 

of money if you know a few tricks. 

Buy a Retail Box (at Below-Retail Cost) 
Buying a membership or renewal directly from Apple costs $100 for 

individual members and $180 for a Family Pack. But I’ve seen prices 

well under $80 and $150, respectively, at other sites. Although you 

may not always be able to find a great deal, it pays to shop around! 

If you purchase a .Mac membership from a source other than Apple, 

you will receive a box containing a CD (which you don’t need) and a 

card with an activation code (which you do need!). You can enter this 

activation code in lieu of a credit card number when activating a new 

account, reactivating an expired account, or renewing or upgrading 

an existing account. Some good places to check for discounted .Mac 
retail boxes are: 

• Amazon.com: http://www.amazon.com/ 

• dealmac: http://www.dealmac.com/ 

• Buy.com: http://www.buy.com/ 

  
NOTE Apple once offered a program that provided a 20 percent discount 

on your .Mac renewal fee for each new paying member you 
referred. Although this program is no longer active, check the .Mac 

home page regularly to see if any other promotional offers exist. 

  

Become an Affiliate 

If you have a Web site frequented by people who may be interested 

in .Mac, you can apply to the .Mac Affiliate Program (administered by 

LinkShare). If you are accepted, you get a special URL you can place 

on your Web site. If someone clicks that link and then buys a .Mac 
membership, Apple pays you $15. If you can turn just seven people 

into paying .Mac members, you’ll be reimbursed for the cost of your 

next renewal. You can learn more about the program at 

http://www.mac.com/1/affiliates/. 

http://www.mac.com/1/affiliates
http://www.amazon.com/
http://www.dealmac.com/
http://www.buy.com/
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APPENDIX A: BEYOND .MAC 

As you have undoubtedly figured out by now, I’m a strong supporter 

of .Mac—I think every Mac user should join. Nevertheless, you may 

find yourself running into data transfer or storage limitations (even 

after purchasing more storage). You may need to run server-side code 

on your Web site, or set up an e-commerce site for your business. Or 
you may be on such a strict budget that even $100 per year for a .Mac 

subscription is out of the question. For these reasons (and others), 

you may wish to supplement or replace your .Mac subscription with 

comparable services from other providers. 

Given the sheer number of alternatives, I can only begin to scratch 

the surface. But I’d like to point out a few ways you can get features 

similar to those offered by .Mac from other sources. I highlight what 

I consider the best options in each category. 

Web Hosting 
If I had a nickel for every Web hosting company out there...I could 

start my own. A quick search on Google should turn up thousands of 

providers, each angling to sell you more features, for less money, than 

its competitors. You may even find a few that run their services on 

Macintoshes, although that doesn’t necessarily make an otherwise 

unremarkable service more attractive. 

I’ve listed a few examples here of Web hosting providers I know of 

that seem, based on their marketing materials, to have services that 

could meet most of the needs of people looking for a .Mac alternative 

or supplement. I make no judgments about these companies, except 
to say that they all offer at least as much Web space and bandwidth 

as the basic .Mac membership, and at the same or lower cost. 

In general, these Web hosting providers also support server-side 

scripts, applications, and databases—typically including programs 
like PHP, Perl, MySQL, and Ruby on Rails, as well as blogging 

platforms that depend on those tools, such as WordPress. Each plan 

also includes Web statistics; one or more email accounts (in some 

cases, thousands of email accounts!) with POP, IMAP, and Web-

based access; and many other features. Plans shown in parentheses  
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meet the criteria I just mentioned and cost less than .Mac; higher-end 

plans are generally available, too, as are (in some cases) less-

expensive, less-powerful options: 

• 1&1 Internet (1&1 Home plan): 

http://order.1and1.com:80/xml/order/Hosting 

• DreamHost (Crazy Domain Insane! plan, two-year prepayment): 
http://www.dreamhost.com/shared/ 

• FatCow Web Hosting (FatCow plan): http://www.fatcow.com/ 

• iPowerWeb (Business Pro plan): http://www.ipowerweb.com/ 

Email 
If your primary need is for an email account, you can choose from 

any number of free or low-cost providers, some of which offer more 

storage space than .Mac. For example: 

• 1&1 Mail: The 1&1 Instant Mail package offers 5 email accounts, 

2 GB of storage, webmail, IMAP or POP access, spam protection, 

and aliases—all for $1 per month (http://www.1and1.com/). 

• FastMail: Accounts with this provider range from a free Guest 

account (with advertising added to messages) to a $40 per year 

Enhanced account with 2 GB of storage space plus a Web site. 

Depending on the plan you choose, you can access your account 

using webmail, IMAP, or POP (http://www.fastmail.fm/). 

• Google Gmail: A free Gmail account has 2 GB+ of storage, with 

access via webmail or POP (no IMAP support—at least not yet) 

(http://gmail.google.com/). 

• Pobox.com: Their Mailstore service, at $50 per year, includes 

webmail, IMAP, and POP access plus spam protection, auto 

replies, forwarding, and aliases. The account comes with 2 GB 

of storage (http://www.pobox.com/). 

  
NOTE I know that you can still get free email accounts from the likes of 

Yahoo! and Hotmail, but my experience has been that you get what 

you pay for with these providers—not to mention lots of spam. 

  

http://www.pobox.com/
http://order.1and1.com:80/xml/order/Hosting
http://www.dreamhost.com/shared/
http://www.fatcow.com/
http://www.ipowerweb.com/
http://www.1and1.com/
http://www.fastmail.fm/
http://gmail.google.com/
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Online Storage 

All the Web hosting companies listed earlier provide online file 

storage space. In some cases you can even access the files using 
WebDAV (meaning that the Mac OS X Finder, Windows, or a stand-

alone FTP/WebDAV client will do the trick). 

However, if you want online storage without Web hosting, you still 

have numerous options. Here are some examples: 

• DavDrive: Basic WebDAV hosting—$10 per month for 1 GB of 

space (http://www.davdrive.com/). 

• IBackup: Offers 5 GB of storage for $10 per month or $100 per 

year, with more space available at (significantly) higher cost. 

Access via FTP or WebDAV (http://www.ibackup.com/). 

• Strongspace: Gives you 5 GiB (gibibytes, each of which is 1.07 
GB) of space for $15 per month, with secure access via SFTP or 

HTTPS (but not WebDAV). More-expensive plans provide as much 

as 100 GiB of storage (http://www.strongspace.com/). 

• xMailHardDrive: This free service deserves an honorable 
mention. It enables you to use your free Google Gmail storage 

space for ordinary files (in addition to email). Just one problem: 

their desktop software is currently available for Windows only, 

so Mac users must upload and download files via a Web browser 

(http://www.xmailharddrive.com/beta). 

• gDisk: Similar in concept to xMailHardDrive, gDisk lets you store 

files on your Gmail account. But gDisk has a functional Mac OS X 

client—and it’s free (http://gdisk.sourceforge.net/). 

Online Backups 
If you want to back up your files online, you could use one of the 

online storage services listed just previously, but you may find that 

they don’t offer enough storage space, or that they’re missing some 

feature you need (such as encryption or automated backup software).  

Of the many companies offering online backups at a reasonable price, 

here are three I particularly recommend for Mac users: 

• CrashPlan: Back up your computer to CrashPlan’s servers, to 

another computer you own, or to a friend’s computer anywhere on 

http://gdisk.sourceforge.net/
http://www.davdrive.com/
http://www.ibackup.com/
http://www.strongspace.com/
http://www.xmailharddrive.com/beta


Page 187 

the Internet. Software costs $20 or $60, depending on the version; 

online storage starts at $5 per month for 50 GB 

(http://www.crashplan.com/). 

• Mozy: Store an unlimited amount of data online for only $5 per 

month (http://www.mozy.com). 

• Steekup: Chose any of five different pricing plans, offering as 
much as 100 GB of storage (which costs $100 per year) 

(http://www.steekup.com/). 

Photo Sharing 
Exporting your iPhoto albums to your iDisk (or another Web site) 

is one way to get your photos online. Another way is to use a photo-
sharing service, with which you can store all your photos online (even 

if you have many gigabytes worth of data), organize them in albums, 

share them with friends and family, and even order prints. Several 

such sites exist, but my favorites (because they play well with Mac 

OS X in general and iPhoto in particular) are SmugMug and the 

Kodak EasyShare Gallery. Here’s a list of phot0-sharing services: 

• Flickr: Basic accounts, which limit monthly uploads to 20 MB 

of bandwidth usage and store only scaled-down images, are free. 

Flickr Pro Accounts cost $25 per year and include a 2 GB monthly 

upload limit and unlimited storage of full-resolution images 
(http://www.flickr.com/). 

  
TIP If you use Flickr, you’ll want to install the Flickr Export Plugin for 

iPhoto, available from http://connectedflow.com/flickrexport. 

  
• Fotki: Free accounts give you 30 MB of space initially, and add 

10 MB every 30 days. Premium accounts, which cost $50 per year, 

provide unlimited storage and a number of advanced features 

(http://www.fotki.com/). 

• SmugMug: You pay $30 per year for unlimited photo storage. 

You can download free software that uploads selected albums 

from iPhoto directly to their site. It’s not quite as easy as publishing 

directly from iPhoto, but you’ll never run out of storage space— 

and as a bonus, you get an offsite backup of all your images 
(http://www.smugmug.com/). 

http://connectedflow.com/flickrexport
http://www.crashplan.com/
http://www.mozy.com
http://www.steekup.com/
http://www.flickr.com/
http://www.fotki.com/
http://www.smugmug.com/
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• The Kodak EasyShare Gallery: This option is similar in con-

cept to SmugMug, though more corporate in its look and feel. You 

can store an unlimited number of photos free, but there’s a catch: 

you must make at least one purchase per year (which could be 
prints, film processing, photo calendars, or other products) 

(http://www.kodakgallery.com/). 

• Snapfish: Like the Kodak EasyShare Gallery, Snapfish provides 

free, unlimited storage as long as you make at least one purchase 
annually (http://www.snapfish.com/). 

Except for Fotki, all these services offer Mac-compatible, photo-

upload software; Fotki Premium members can upload photos via FTP. 

Web Site Creation 
If your main need is to build simple but nice-looking Web pages 

or blogs, but you’re disinclined to learn HTML or to buy iLife, 

consider the nearest competitor to iWeb—Sandvox from Karelia 

(Regular version, $49; Pro version, $79). Sandvox gives you more 

control over the appearance of your pages; the Pro version even 
lets you work with the raw HTML if you wish 

(http://www.sandvox.com/). 

Alternatively, sign up for a free account at FreeSiteDesigner.com. 

This site provides a template-based, fill-in-the-blanks approach to 
Web site creation in the same vein as .Mac’s HomePage feature 

(http://www.freesitedesigner.com/). 

Address Book, Calendar, and Synchronization 
For online access to contacts and calendar data—and the capability to 

sync that information between Macs—your options are more limited. 

• Plaxo: Sign up for their free basic service to store your calendar 

and contact information online and access it via the Web. You can 

also enable your contacts to update their own records when their 

information changes. Then, using their free Plaxo Toolbar soft-
ware, you can synchronize your Address Book data automatically 

with your Plaxo account (http://www.plaxo.com/). 

• iSynCal: This $25 application synchronizes iCal calendars 

between two Macs directly (without going through an intermediate 
server, as .Mac does) (http://ww2.unime.it/flr/isyncal/en/). 

http://ww2.unime.it/flr/isyncal/en/
http://www.kodakgallery.com/
http://www.snapfish.com/
http://www.sandvox.com/
http://www.freesitedesigner.com/
http://www.plaxo.com/
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APPENDIX B: ACCOUNT CONVERSION METHODS 

To convert a .Mac account from one type to another, find your 

existing account type in the table below and follow the instructions. 

 
Table 1: Account Conversion Methods 

To convert from this: To this: Do this: 

Trial or expired .Mac 

membership, expired 

iTools account, email-

only account, or Family 

Pack sub-account 

Full .Mac 

membership 

or Family 

Pack primary 

account 

1. Go to http://www.mac.com/ and log in with 

your existing member name and password. 

2. Click your member name on the navigation 

bar and log in again. 

3. Click Join Now and follow the instructions. 

Trial or expired .Mac 

membership, or 

expired iTools account 

Email-only 

account 

Have a .Mac member purchase an additional 

email-only account. That member must then: 

1. Go to http://www.mac.com/ and log in. 

2. Click their member name on the navigation 

bar and log in again. 

3. Click the Manage Accounts button. 

4. Enter the member name and password for 

your (trial or expired) membership. 

5. Choose Email-Only Account from the pop-

up menu. 

6. Click Convert, and then click Continue. 

Family Pack sub-

account 

Email-only 

account 

Have the .Mac member who is the Family 

Pack’s primary account holder do this: 

1. Go to http://www.mac.com/ and log in. 

2. Purchase a new email-only account (see 

Add Email-Only Accounts). 

3. Return to the .Mac home page, click their 

member name on the navigation bar, and 

log in again. 

4. Click the Manage Accounts button. 

5. Enter the member name and password for 

your sub-account. 

6. Choose Email-Only Account from the pop-

up menu. 

7. Click Convert, and then click Continue. 

http://www.mac.com/
http://www.mac.com/
http://www.mac.com/
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To convert from this: To this: Do this: 

Full .Mac membership Family Pack 

primary 

account 

1. Go to http://www.mac.com/ and log in. 

2. Click your member name on the navigation 

bar and log in again. 

3. On the Account Settings page, click the Buy 

More button. 

4. Choose Upgrade from the pop-up menu 

under Family Pack, and then click Continue. 

5. Follow the instructions to enter your billing 

information. 

Trial or expired .Mac 

membership, expired 

iTools account, or 

email-only account  

Family Pack 

sub-account 

Have the .Mac member who is the Family 

Pack’s primary account holder do this: 

1. Go to http://www.mac.com/ and log in. 

2. Click their member name on the navigation 

bar and log in again. 

3. Click the Manage Accounts button. 

4. Enter the member name and password for 

your (trial or expired) membership. 

5. Choose Family Pack Sub-account from the 

pop-up menu. 

6. Click Convert, and then click Continue. 

    

  
TIP If you purchase a retail boxed copy of .Mac (individual or Family 

Pack), the box will contain an activation code that you can use to 
create, upgrade, or renew your account. To enter this code, go to 

http://www.mac.com/activate and follow the instructions. 

  
 

http://www.mac.com/activate
http://www.mac.com/
http://www.mac.com/
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